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Chapter

1

Introduction

WELCOME TO THE REALFLIGHT 9.5 RC FLIGHT SIMULATOR

ealFlight 9.5 RC Flight Simulator is without question, the most advanced RC aircraft

simulation available. It is so technologically advanced and so realistic, you'll find it

hard to believe that it’s only a simulation. The culmination of over twenty three years
of development and design, RealFlight 9.5 offers advancements that will serve to fine-tune
the flying skills of even the most seasoned RC veteran. If you're an entry-level RC-er,
RealFlight 9.5 is the ideal way to learn to fly, practice maneuvers, feel the effects of design
modifications, or just have an incredible amount of fun. Thanks to the incorporation of
groundbreaking Spektrum AS3X ® and SAFE® stabilization technology, found in many of the
additional Horizon Hobby aircraft, a better flying experience is available for a wider range of
RC pilots.

RealFlight 9.5 includes over 160 models that look and fly like the real thing, plus a multitude
of flying sites (each with their own unique “feel” and distinctive characteristics). In addition,
RealFlight 9.5 offers its users the most powerful, flexible aircraft and flying site editors ever
unveiled to the modeling community; allowing modelers to experiment with a virtually
unlimited number of parameters. RealFlight 9.5 enables you to change the look and feel of a
flying site with nothing more than a few keystrokes, a click of the mouse and a little
imagination. The integrated AccuModel™ aircraft editor makes modifying aircraft just as
easy.

RealFlight 9.5 also offers a wide array of tools to help you understand how to use the
program and how to improve your RC piloting skills. This extensive manual explains every
feature and option; as well as how to use them. We offer a number of training aids and
assistance including (but not limited to): our Heli Hover Trainer, Airplane Hover Trainer, Heli
Autorotation Trainer and Heli Orientation Trainer. Horizon has also included updated flight
training lessons to assist new airplane pilots in the enjoyment of the hobby! These helpful
training aids provide on-the-fly learning opportunities, and we encourage you to take full
advantage of them. No other RC simulator goes further to enrich your RC experience.

RealFlight 9.5 RC Flight Simulator 4



The following section briefly outlines some of the exciting features in RealFlight 9.5.
Subsequent chapters will describe all RealFlight features in complete detail. We strongly
suggest that you peruse this manual in its entirety, as it explains every feature and option, as
well as how to use them.

Finally, we’d like to express our gratitude to you for purchasing RealFlight. We think you will
be enormously pleased with RealFlight 9.5. Have fun flying!

Please note that while this manual has been written from the perspective of the RealFlight
9.5 iteration of the software. If, however, you are using a previous version of the simulation,
most of the features and functions are still applicable as are the steps/procedures to access
accordingly.

RealFlight 9.5 Feature Highlights

This section briefly outlines some of the features included in the RealFlight 9.5 RC Flight
Simulator with the Spektrum® InterLink DX Controller.
USB Spektrum InterLink DX Controller-

New to the RealFlight 9.5 software is the recently developed Spektrum InterLink DX
Controller. The multi-patented InterLink DX controller has been optimized for use within the
simulation and incorporates a significant number of enhancements and improvements over
previous RealFlight systems and control methodologies.

The InterLink DX Controller is a revolutionary device that offers you the following:
e Ahigh-quality USB controller for RealFlight 9.5; backwards compatible to RealFlight 8

software releases, should you choose to do so.

e Abuilt-in interface for (optionally) using your own RC transmitter to control
RealFlight.

e QuickSelect™ Buttons—take control of RealFlight's menus and options from the
InterLink DX without touching the keyboard or mouse.

e The InterLink DX Controller is fully /ot swappable—you can connect and disconnect the
InterLink DX or your own transmitter without rebooting your computer (or even
shutting down RealFlight).

e 15 Channels- including two slider controls, 2 two-position switches, 5 three-position
switches, 1 knob and 1 ‘Panic’ button.

e High-speed response to control inputs.

e Digitally precise inputs with digital trims for unmatched control precision.
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o Akeyboard-free push button reset of the simulation.
e Instantly rewind your current flight and start over from any point.

e The ability to hand launch aircraft.

Horizon Hobby AS3X and SAFE Technology-

New to the RealFlight 8 Horizon Hobby Edition, RealFlight 9.5 continues to expand the selections
and offerings that include exclusive groundbreaking technology from Spektrum. Incorporating
SAFE Select and AS3X in a multitude of models within this iteration ensures not only success for
entry-level modelers but also a better flying experience for a wider range of pilots regardless of
skill sets.

AS3X enhances the flight performance of models stabilizing the aircraft in whatever attitude the
pilot commands. Countering external forces such as wind, torque, tip-stall, etc. our AS3X
technology uses a combination of flight sensors to ensure a pleasant flying experience.

SAFE Select is a complementary technology to the AS3X flight performance. With the flip of a
switch, SAFE Select is active and limits the pitch and roll angles keeping the aircraft airborne and
eliminating any fears.

USB interface-

RealFlight 9.5 is also backwards compatible for users that have purchased previously offered
RealFlight interface options. These items offered a simple method to use your own
transmitter without a lot of fuss. Like the InterLink DX, these interfaces are plug-and-play for
quick installation. If you own one, the wired interface allows you to connect most popular
radios through the trainer ports that are PPM compatible. Alternatively, there was also a
wireless interface available. This wireless interface works perfectly with SLT transmitters, like
Tactic radios, or any radio utilizing the AnyLink adapter.

Spektrum users will appreciate the currently offered Spektrum WS2000 wireless simulator
dongle (Horizon SKU SPMWS2000), allowing modelers to control the action with a Spektrum
DSM2 or DSMX-compatible transmitter. We will fully delve into the advantages and options
with the WS2000 wireless simulator dongle elsewhere in this manual. If you’d like to use
your Spektrum, or Spektrum-compatible transmitter with RealFlight, please refer to the
applicable section of the manual for information on how to do so.

Menu-Driven Interface-

RealFlight 9.5 utilizes a drop-down menu-driven interface system. Created for ease of use
and maximum flexibility, the menu system provides an interface familiar to even a casual
computer user.
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Additional Features-

e Virtual Reality — RealFlight 9.5 is compatible with the Oculus Rift and HTC Vive,
popular VR Goggles.

e RealPhysics™ 3D- One of the most ambitious models of flight in the world,
RealPhysics 3D is unmatched in its ability to re-create the lifelike characteristics of
model flying. RealFlight 9.5’s physics engine has been tried and approved by Horizon
Hobby’s own world-class competition pilots like Ali Machinchy, David Payne, James
Haley, Dustin Buescher as well as many others. Furthermore, aircraft in RealFlight
behave with real-world predictability because they are carefully modeled using
advanced methods and extensive real-world data. If it happens at the field or in the
air, it’s re-created with exacting detail in RealFlight!

e Challenges- These game-like events provide a fun way to test and develop your skills.
Each has multiple levels. Difficulties increase as you move from one level to the next.
Successfully earning a medal in each challenge unlocks new content.

e Ghost Runs- Compete against your best time in the Challenges with ghosted images
of your flights, pushing you to complete each level faster.

¢ Float Fly- RealFlight offers a number of flying sites with water along with a variety of
float fly aircraft. In fact, RealFlight 9.5 even includes E-Flite’s Habu STS 70mm EDF- an
incredible foray into EDF flight! Practice takeoffs and landings with this electric
ducted fan without fear of crashing your R/C model.

¢ Instant Rewind- Test your pattern flying over and over again with the Rewind
feature. Hold the Reset button and watch your flight rewind. Let go of the button at
the point you wish to re-start your flight. Use the data lever on the controller to seek
forward or backwards through your flight.

e InterLink DX QuickSelect™- With RealFlight’s InterLink DX controller, you’re able to
make quick changes such as, selecting a different aircraft or airport without touching
the keyboard or mouse. First introduced in RealFlight 9.5, the scroll selection wheel
which makes it even easier- and faster- to make your in-sim selections.

e Quick Load- Know the name of the aircraft or flying site you wish to use? Open the
Quick Load gadget to quickly search and load the aircraft.

e Quick Edit- If you ever wish to make minor refinements to the aircraft, but don’t wish
to dive into the complexity of the full aircraft editor, the Quick Edit is the solution for
you!

e Training Videos-Access the built in video player to training and feature videos. For
RealFlight 9.5 we’ve even expanded the Flight Training tutorials to ensure success for
new modelers.
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e Real Rendering™- Taking advantage of cutting edge 3D graphics technology,
RealFlight not only flies realistically; it also looks true to life.

e Variable Pitch Prop- Take 3D flight to 4D with the variable pitch prop. Select the
FlatOut™ Extra 300S with V-Pitch and try amazing maneuvers you didn’t think were
possible with an airplane—like flying backwards.

e Grappling Hook-Select the Skycrane heli to hook, grapple and drop objects.

e Hovering Training Aids- Learn to torque roll or hover a heli with RealFlight’s Heli and
Airplane Hover Trainer. For more excitement, try the Heli Orientation Trainer. Both
are great training aids for anyone new to radio control.

e Overhead View- This on-screen gadget helps you find and line up to the runway for
easier landings. Or use it to help find your friends during multiplayer sessions.

e Sky Grid and Trails- Practice your precision maneuvers with these graphical aids. Sky
Grid will display a pattern in the sky for reference. Enable Trails and you will see
where your aircraft has flown; allowing you to perfect your maneuvers.

e Night Flying- Just because the sun is down, doesn’t mean that you can’t fly. The same
is true with RealFlight night flying. Pick a nighttime airport and watch as your aircraft
lights up the sky.

e PhotoFields™- RealFlight also includes ultra-realistic PhotoField airports. Using
incredible high resolution digital images, RealFlight PhotoField airports are as real as
it gets. In fact, RealFlight 9.5 even includes Eli Field, home to the Monticello Model
Masters, Horizon Hobby’s annual RC Fest event and where many of the Horizon
Hobby’s models are test flown and approved. New to RealFlight in this release is the
ability to fly at the AMA (Academy of Model Aeronautics) headquarters in Muncie,
Indiana. Further, the Import feature allows you to use your own panoramic photos
to create new flying sites.

e “Full Coverage” collision detection- Instead of using sensors at only a few points
along the aircraft, “Full Coverage” blankets the entire aircraft with detection points
ensuring that every part of an aircraft will not only register a strike but, will react
authentically. Contact can result in damage ranging from minor handling problems to
spectacular crashes complete with realistic sound effects.

e TruFlo Wind Dynamics™- RealFlight introduces modelers to RC's most realistic wind
model. All the components of TruFlo Wind Dynamics work together to create the
single most accurate wind field in any simulation. Wind impacts every facet of your
flight, just as it would at the local field.

e AccuModel™ Aircraft Editor- RealFlight’s aircraft editor is the most powerful and
most flexible editor ever introduced in an RC simulator. AccuModel allows you to
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change virtually every aspect of your model with ease. It places over 1,500 airfoils at
your disposal, a multitude of propellers, and much, much more! AccuModel brings
up a wire-frame model for easy reference and highlights the editing area. Make a
change and it’s immediately reflected on-screen, ready for review and revision.

¢ Flying Sites with over 5,000 square miles to explore- RealFlight’s TrueLife Terrain™
goes beyond the limitations of traditional simulator flight. Created and mapped from
satellite imagery, RealFlight 9.5’s landscape looks as “right” and richly varied as the
view from your front door. Digital elevation data brings it all into accurate
perspective.

e Aliving, breathing environment- Everything in RealFlight 9.5’s 3D world is as realistic
as possible; complete with depth and details that transcend the traditional
“billboard” look of other simulators. You’ll see leaves and branches that dance in a
passing breeze and clouds that roll by with the prevailing winds.

e FlexiField™ flying site editor- The FlexiField™ editor takes you beyond 2D scenes into
a 3D environment rich in new objects and editing options. Customize an existing field
with new foliage, different objects, or both. Create a new field with nothing more
than a mouse, imagination and a few simple keystrokes.

e InterLink DX Controller- Modeled after Spektrum transmitters, RealFlight’s Spektrum
InterLink DX controller functions as a controller, or an interface. This new unit is
capable of resetting and rewinding the aircraft, or hand-launching a sailplane.
Additionally, the InterLink DX is the key to navigating the QuickSelect menus — select
alternative aircraft, flying sites and more, all from the controller.

e VirtualRevolution™ sound technology- Doppler-correct stereo sounds heighten the
realistic effect with true sound recordings of 2-stroke, 4-stroke, turbine, electric,
ducted fan and gasoline engines. As the aircraft crosses the field, the engine sound
follows, just like its RC counterpart.

e RotoSonics™ technology- Recreating distinctive engine/blade sounds with startling
accuracy. The sounds are so lifelike, you’ll swear you are at the field!

e AFR (Advanced Flight Recorder)- This feature allows the pilot to not only view
prerecorded maneuvers, but also to record maneuvers of his/her own as well.
RealFlight even allows you to record your own audio for personalized flight
instruction. This feature also allows you to pause, speed up, slow down, and loop the
performance. The pilot has the option to activate the digitized transmitter display, so
that he/she can view the radio input while flying.

e NavGuides™- Using the NavGuides, you can display a variety of heads-up on-screen
information. Options range from altitude and airspeed to aircraft heading and engine
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RPM. This feature improves your ability to “see” what is going on in your virtual
world.

e Viewport- You can open up a picture-in-picture display and treat it as an
independent “window on the world”. You can individually adjust each of the
viewport’s vantage points, zoom level, and direction of view.

e Multiplayer- You can fly with many other RealFlight 9.5 owners. Participate in online
competitions, or just enjoy the thrill of flying around with one another. This feature
can also be used to learn new maneuvers from pilots across the street or around the
world.

e Combat Events- Compete in Streamer Cut, Paintball, Rocket and Machine Gun
combat. Or combine racing and combat in an exciting match of DeadRinger™. Plugin
a headset and microphone to your computer and chat live during these contests.

e Animated control surfaces and retracts- Control surfaces, retracts, propellers, and
rotor blades move for added realism.

e Aircraft exhaust/smoke- You can control the color, density, “hang time”, and other
parameters related to airplane and helicopter smoke and exhaust.

e Streamers- Add streamers to any aircraft, to any location, in any color. Watch as they
corkscrew behind the airplane during a roll, or react accordingly to the wind and the
propwash.

e Flight Failures- RealFlight can simulate many common flight failures (radio
interference, stuck servos, engine failures, etc.). Use this feature to prepare for
emergencies at the field.

¢ Fully editable aircraft paint/decal schemes- Create customized trim schemes for
your aircraft. (To design your own paint scheme, you must use a third-party program
that edits TGA files.)

e Launcher- RealFlight’s Launcher allows for easy one-click access to program
upgrades, the RealFlight 9.5 manual, and technical support. [Only applicable to DVD
and Tower Hobbies Digital versions only.]

e Extensive Help materials- RealFlight features extensive online tool tips and diagrams,
a detailed manual, and technical support to enhance your enjoyment of the program.
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How to read this manual

RealFlight 9.5 is a menu-driven program, which allows you to make quick changes without
having to reload the simulator each time. This manual will break out each main menu to its
own chapter. This allows you to quickly find information on features and functions by the
related menus.

Along with this manual, a large RealFlight community is available online to help and discuss
any topics with each RealFlight fan. This online support, in the form of a forum, can be found
at:

https://www.knifeedge.com/forums/
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Chapter

2

Before You Begin

TO GET THE MOST OUT OF REALFLIGHT 9.5, IT HELPS TO FIRST UNDERSTAND
HOW TO GET THE MOST OUT OF YOUR COMPUTER.

ealFlight 9.5 is designed to work on a large variety of computer hardware. Similar to a

car, if you want to go faster, you need a bigger engine. The same holds true with

RealFlight. You'll be able to enjoy the simulator on most modern computers, but
having the most up to date hardware for your computer will greatly increase your
enjoyment.

System Requirements

You will find the suggested system requirements for the RealFlight 9.5 RC Flight Simulator
listed below. The minimum recommended system requirements are the bare minimum PC
configuration for installing RealFlight 9.5. Meeting the minimum requirements will allow you
to enjoy RealFlight 9.5. However, in order to take complete advantage of the many features
and functions offered by RealFlight 9.5, you should have a computer that meets or exceeds
the specifications as specified in the optimum system requirements.

Minimum Recommended System-

- Some graphical features may be disabled
- Aerodynamic Calculations will still be high-quality

Windows* 7, Windows* 8 or Windows* 10
*Administrator Access Required

Intel Pentium 1.0GHz or equivalent
512 MB RAM

10 GB Hard Drive Space

DVD Drive [DVD version only]

Broadband Connection [Steam or Digital Version, and multiplayer]
3D Accelerated Video with:
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- 32 MB Dedicated Video Memory
- Full DirectX 9 compliant (Shader Model 2.0 or better)
Available USB 2.0 port

Optimal System-

- For best graphical performance

Dual Core 2.4GHz CPU

2 GBRAM

3D Accelerated Video with:

- 512 MB dedicated video memory

Multiplayer Requirements-

Broadband connection
Computer microphone for voice chat

Virtual Reality Headset-

Please refer to the system requirements necessary to support your device.

Video and Sound Cards

In order to achieve optimum performance and the best flying experience in RealFlight, there
are two important components of your computer that deserve special attention: the video
and sound cards.

RealFlight 9.5 has undergone countless hours of compatibility testing and evaluation. As
such, this software will adequately function with a variety of video cards—ranging from
yesterday’s favorites to tomorrow’s hits.

While RealFlight works well on a wide variety of hardware configurations, it offers many
features and functions that are designed to take particular advantage of the latest video
technology. If you have an older computer, or a newer computer with a lower-end video
card, you may want to consider purchasing a new video card to take advantage of these
features and functions. This moderately priced upgrade can vastly enhance your enjoyment
of RealFlight. Aside from increasing your satisfaction with RealFlight 9.5, a new video card will
also work with many other games or simulators, improving their performance as well.

While not as important as the video card, upgrading your sound card may also improve your
satisfaction with RealFlight. This is especially true if your computer uses an on-board sound
card (a sound card affixed to the motherboard).
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Getting the Most out of RealFlight

We think you’ll agree that RealFlight offers the finest set of instructions and practice tools of
any RC simulator suited for both beginners and experienced pilots. Horizon Hobby and Knife
Edge Software are committed to the continual improvement of our products. When using
the software, you should keep two things in mind:

First, similar to other pursuits, what you get out of RealFlight depends upon what you put
into it. Mastering radio control requires a great deal of patience and practice. If you crash an
aircraft in the simulation, take it very seriously. Crashing an actual RC aircraft can cost you a
lot of time and money. Try to identify what you did incorrectly, and use the experience to
avoid making the same mistake again.

Secondly, while the simulator is quite realistic and will assist you in learning many of the skills
necessary to become a proficient pilot, there is no substitute for actual flying time at the
field. A simulation can be a wonderful practice tool. However, no simulator, no matter how
realistic, can completely replace a qualified, experienced, human flight instructor. If you are
new to RC, you should never attempt to fly a real aircraft without the supervision of a
qualified instructor; no matter how accomplished you are on the simulator.
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Chapter

3

Getting Started

A BRIEF OVERVIEW AND ASSISTANCE TO START YOU ON YOUR RC
ADVENTURE.

his chapter covers the installation procedure for RealFlight 9.5, it describes the basics
of running the program, and introduces you to some of RealFlight’s frequently used
features.

The first section, Installing RealFlight 9.5, offers a step-by-step approach to the installation
procedure for both the program software and the controller.

The second, Using your own RC Radiio, offers the instructions you need if you intend to use
your own RC transmitter to control RealFlight 9.5. If you only wish to fly with the InterLink DX
controller, you may choose to skip this section.

Finally, the third section, Exploring RealFlight 9.5, offers a brief tour of the RealFlight 9.5
program. You'll learn how to perform some basic functions, such as selecting the aircraft you
wish to fly, performing simple edits to the flying field, enabling helpful gadgets, and
manipulating viewports.

This chapter only touches briefly on some of RealFlight 9.5’s features. We strongly suggest
that you also read the subsequent chapters, which describe the various features in
comprehensive detail.

Installing RealFlight 9.5 RC Flight Simulator

Regardless of whether you plan to use the InterLink controller by itself, or your own
Spektrum radio through the built-in transmitter interface, follow the instructions on Program
Installation in this section.

Program Installation (DVD)-

RealFlight 9.5 features a very simple, installation process. After the disc installation has been
completed there are further steps that must be followed prior to running the program for
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the first time. This section will explain how to install the RealFlight 9.5 software and
hardware. Upon completion of this section, you should be able to fly the aircraft on your PC.

The InterLink DX controller’s built-in transmitter interface also allows you to use your own
Spektrum, or other, RC transmitter to control RealFlight 9.5 should you opt to do so. To
activate the interface adapter, you will first need to follow the instructions in the section
below. This section explains how to use the transmitter interface option in the InterLink DX
controller. Further, it might be necessary to purchase the optional transmitter interface
cords- RFL1015- in order to utilize a Spektrum, or other such RC transmitter via the interface.

Program Installation (Digital Download)-

If you have purchased the digital download iteration of the RealFlight 9.5 software, you will
receive a serial number for the software via email. Additionally, you will receive a link to the
site for which you are to navigate to download the software accordingly.

The download is 3.1GB and may require a period of time in which to download. This time
will vary depending upon the internet connection speed, etc.

Follow the onscreen instructions for information on the program installation.

Program Installation (Steam®)-

RealFlight is available on Steam, too. Accessing via Steam requires the Steam client. If you
do not have Steam installed:

1. Inyourinternet browser, visit: store.steampowered.com/about/

2. Click the Install Steam button.

3. Install Steam using the downloaded file.

4. Run Steam when prompted.

5. Log into your Steam account. If you do not have one, click Create a New Account...

Installing RealFlight 9.5 (assuming that key is purchased via Local Retailer, Tower
Hobbies or Horizon Hobby)

Verify that the Steam client is running and that you are logged into your account.

1. Select the Games menu item.

2. Select Activate a Product on Steam.

3. When prompted, enter your RealFlight 9.5 key into the Product Code field, exactly as it
appears. You will receive confirmation that the RealFlight 9.5 program is successfully
activated.
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4. Click Finish.

5. Steam will prompt you to install the software. Confirm your installation options, and
click Next.

6. The installation dialog will close, and the RealFlight 9.5 download will begin. Progress
displays at the bottom of the Steam client.

Update Drivers-

As mentioned above, before you begin installation, we strongly suggest that you
update the drivers for both the sound and video cards on your PC. A driveris a
software program that your computer uses to control hardware devices. Each card
has its own respective driver. Most problems with installing and using RealFlight, as
well as many other programs that use Microsoft DirectX, arise from using outdated
video and/or sound card drivers.

If you are not sure how to update your drivers, it is suggested that you visit the
support site associated with the manufacturer of the video and sound cards on your
PC for information on how to do so.

Connect the InterLink DX Controller or interface-

The InterLink DX controller, and the Spektrum Wireless Simulator Dongle use the USB
(Universal Serial Bus) port, so there is little to do in the way of setup. The Spektrum
Wireless Simulator Dongle will be covered in a separate section of this manual. If this
is the methodology that you have selected for use in controlling the simulation,
please refer to this section accordingly.
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ﬁ It is imperative that you plug in your controller or interface into the computer first,
before installing the RealFlight software!

1. With the software installation procedure complete, firmly plug into an
available USB port on the PC. You do not have to shut the PC down to plug
the controller in.

2. Shortly after plugging in, a dialog box should appear on the screen indicating
that Windows has located a new device and will then automatically install the
necessary drivers.

Please note: It is possible that Windows will need to install the appropriate files for
the InterLink DX or interface to function properly.
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Changing the throttle stick ratchet-

The InterLink DX incorporates a smooth throttle operation by default. This is the
preferred methodology for many pilots. If, however, you wish to refine the controller
to incorporate a ratcheted throttle, the Spektrum InterLink DX makes it easy to do so.

The InterLink DX has all the physical transmitter adjustments located around the
gimbal face of each gimbal. This arrangement allows for quick and easy adjustments
without taking the back cover off or removing any plugs to access adjustment screws.

Additional information pertaining to the Spektrum InterLink DX may be found in
Appendix A of this manual.

Vertical

Available adeStmentSZ Tension — Horizontal Tension

e Change the Throttle Ratchet

e Change the Throttle Tension

Horizontal Tension

Vertical

e Adjust Stick Tension Tension

Ratcheted Throttle- Smooth Throttle Adjustment-

RATCHET:

e Locate the throttle strap adjustment screws on both gimbals. The ratchet screw
engages a serrated section of the gimbal, while the tension screw engages a
strap for smooth tension on the gimbal.

e To engage the throttle tension ratchet, turn the ratchet screw clockwise until
the ratchet engages.

e Todisengage the throttle ratchet, turn the screw counter-clockwise until the
gimbal moves freely.

SMOOTH TENSION:
e To engage the throttle tension, turn the respective screw clockwise until the
tension engages.
e Todisengage the throttle tension, turn the screw counter-clockwise until
the gimbal moves freely.

Adjust Stick Tension-

Using a Phillips screwdriver, turn the screws clockwise a small amount to tighten the
stick tension and counter-clockwise to loosen the stick tension.

Note: We strongly suggest testing the stick tension while turning these screws to ensure
that stick tension is not too loose or too tight. Tightening a screw too much can damage
the spring. Loosening the screw too much could cause a spring to fall off, possibly
resulting in a short-circuit in the transmitter.
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Control Stick Length Adjustment-

e Using a 2mm Allen wrench, turn the

screw in the stick counter-clockwise )
to loosen it. / m
e Make the stick length shorter by uy iy 7

turning the stick clockwise, or longer
by turning it counter-clockwise.

e After refining the stick to the desired
length, tighten the screw in the stick clockwise.

Mode Change Slider-

The Spektrum InterLink DX Controller has a unique, patent-pending, slider located on
the rear of the controller that allows for simple mode changes. This slider may also be
used to change to the ‘quadcopter’ mode whereby the mode snaps both sticks to their

centered position.
Safety Plug

The safety plug is installed in the transmitter to
ensure the mode switch cannot be accidentally
moved when in the normal throttle mode (non-
centered) positions.

To remove the plug:

e Grasp the plug by the raised rib and pull straight out. Note: A small flat-bladed
screw driver may be used to gently pry the plug out if necessary.

e Once the mode has been changed, reinstall the safety plug accordingly.

o Simply open the protective slider door and move the slider to the desired
position. All changes happen automatically inside the transmitter.

Changing the Stick Configuration

e With the safety plug removed, ensure that C } [ D

both gimbal sticks are centered. M2 4 Mode 1,3

o Gently push the slider mechanism to the
desired mode configuration as shown in ‘ < ﬁ\
the images to the right. \ . : )
Mode 2, 4 Mode 1,3

e Once the mode has been changed,
reinstall the safety plug.

e Note: it will be necessary to edit the controller’s operational mode, mapping the
InterLink DX’s profile within the simulation. Information on how to do so is
found in the Select Controller section on page 57

Quadcopter Quadcopter

Installing the Software*-

[*DVD and Digital versions only; NOT Steam iteration]
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After you have completed installation of the new video and sound card drivers, you
are now ready to install the RealFlight 9.5 RC Flight Simulator program.

If you do not own a DVD drive, the software is available as a digital
download: https://realflight.com/dIrf9.

1. Before installing the program, make sure to close any
applications that you are running. This includes virus
scanning software and other similar background
applications.

2. [DVD version only] Insert the first RealFlight disc, labeled
Disc 1, into the appropriate DVD drive.

3. [DVD version only] If Auto-Play is active, setup will begin automatically when
the DVD drive is closed. Simply click the Install button when prompted. If
Auto-Play is not active, click Start on the task bar. Next, click Run. In the
dialog box that appears, type ‘d:\setup’ (assuming that ‘d’ is your DVD drive)
and click OK.

RealFlight 9.5 will install in:

j C:\Program Files (x86)\RealFlight

Follow the on-screen instructions to complete the setup
procedure. Please make sure to insert the RealFlight Disc 2, when
prompted to do so. Upon completion of the installation, click OK.
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Starting RealFlight 9.5*-
[*DVD and Digital versions only; NOT Steam iteration]

1. Double-click the RealFlight 9.5 Launcher located on your desktop.

2. Type the RealFlight 9.5 software serial number in the appropriate location.
This is the serial number that includes the ‘R9’. Please be sure to enter the
serial number exactly as it appears, and in the proper on-screen fields. Failure
to enter the serial number correctly will not allow you to proceed to the next
step. Once the serial numbers have been entered properly, you will see that
the OK button will now become active and allow you to continue.

Serial Number

.5

Enter your RealFlight serial number:

Find your serial number on the back
of the DVD case.
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3. Click OK. RealFlight will attempt to activate your software. The activation
process must proceed in order to run RealFlight. If the computer is not
currently connected to the internet, this activation process will fail to connect
to the activation server and the following window will appear.

Product Activation X

.5

RealFlight was unable to activate. You must activate it manually before it will run.

| Please contact RealFlight Technical Support and provide the Activation
Information listed below to proceed.

WEBSITES ACTIVATION INFORMATION

Activation RealFlight serial number:

’ Technical Support Activation key:
|

'Copy to dipboard

Enter the activation code provided by tech support and click Activate: ‘

If you do not have internet access on the computer which RealFlight 9.5 is
installed, follow the on-screen prompts. Write down the serial number and
activation code that appear and log on to www.realflight.com/RF9activation
on a different computer to activate RealFlight 9.5. Alternatively, you may
contact Software Support via email or phone.

4. Once activated, the RealFlight 9.5
Launcher will appear. If the software has
been updated since the creation of this
DVD, most likely as Horizon Hobby is
always working diligently to enhance the
enjoyment of this program, the update
information will appear below the Run

RealFlight 9.5 RC Flight Simulator




RealFlight button. Click the Update to 9.XX.XXX to access the latest build.
After the updated files have been received, click Run RealFlight. RealFlight
9.5 will start with the default aircraft and default flying site.

Starting RealFlight 9.5*-

[*Steam version only]

1. Runthe Steam client, select RealFlight 9.5 in your library, and click the Play
button. Select the launch option that best fits your needs. (If you elected to
create desktop and/or Start menu shortcuts when installing, those will use
the most recent launch option selected in the client.)

2. RealFlight 9.5 will attempt to activate your software. The activation process
must proceed in order to run RealFlight 9.5. If the computer is not currently
connected to the internet, this activation process will fail to connect to the
activation server and the following window will appear.

Product Activation X

.5

| RealFlight was unable to activate. You must activate it manually before it will run.

| Please contact RealFlight Technical Support and provide the Activation
Information listed below to proceed.

WEBSITES ACTIVATION INFORMATION

Activation RealFlight serial number:

’ Technical Support Activation key:
|

Enter the activation code provided by tech support and click Activate: ‘

If you do not have internet access on the computer which RealFlight 9.5 is
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installed, follow the on-screen prompts. Write down the serial number and
activation code that appear and log on to www.realflight.com/RF9activation
on a different computer to activate RealFlight 9.5. Alternatively, you may
contact Software Support via email or phone.

3. After activating successfully, RealFlight 9.5 will start with the default aircraft
and default flying site; the E-flite Habu STS 70mm EDF (4S) and Eli Field.

Using Your Own RC Radio

The RealFlight interface requires you to fly in the simulator using your own RC transmitter.

Alternatively, if you purchased the RealFlight 9.5 .5InterLink DX controller, it offers several
different modes of operation. By itself, it serves as a realistic ‘stand alone’ controller or
joystick. Alternatively, it has a built-in interface that lets you use your own RC transmitter,
such as a Spektrum transmitter, to control RealFlight 9.5.

Follow these instructions if you intend to use your own RC transmitter to control RealFlight
9.5. If you do not want to use your own transmitter, you may skip this section.

Connecting Your Transmitter to the InterLink DX-

You can use your RC transmitter to control RealFlight 9.5 by connecting it to the InterLink DX
controller, ‘buddy box’ style (see diagrams). If you do not already own them, we offer
adapter cords to enable you to connect many popular brands (including Spektrum) to the
RealFlight simulation. These optional cords are offered as RFL1015 and may be found at
your local retailer, or online hobby shop.

Locate the cable input port on the rear of the InterLink DX Controller. Plug one end of the
interface connector cable into this port. Next, plug the other end of the adapter cable into
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the buddy box port (a.k.a. trainer jack) of your transmitter. The procedure for doing so
depends on your transmitter:

e If your transmitter’s buddy box port directly accepts the 1/8” stereo plug, insert this end
directly into the radio. This works for many Spektrum® radios.

e Ifyourtransmitter’s buddy box port requires the micro (square) connector, use the
square adapter cord included with the optional interface adapter cord package.

Connecting your Transmitter to the RealFlight wired interface-

Some RealFlight users might have the previously available RealFlight wired interface offering.
RealFlight 9.5 is backwards compatible and will function adequately with this interface if so
desired. The information that follows will facilitate the use of this interface. Again, it may be
necessary to purchase the optional transmitter interface adapter cords to do so.

The USB end of the interface should already be plugged into the computer. Plug the other
end of the interface cable into the buddy box port (a.k.a. trainer jack) of your transmitter.
The procedure for doing so depends on your transmitter:

e If your transmitter’s buddy box port directly accepts the 1/8” stereo plug, insert this end
directly into the radio. This works for many Spektrum® radios.

e [fyourtransmitter’s buddy box port requires the micro (square) connector, use the
square adapter cord included with the interface adapter package.

After you have connected your transmitter, you will need to perform a brief setup procedure
before utilizing it with the simulation.

1. If applicable, make sure that the transmitter is in FM or PPM mode rather than PCM
mode. Refer to the manual for your transmitter if you are unsure how to do this.
Note: with many of today’s 2.4GHz spread spectrum radios this step is unnecessary
and may be skipped accordingly.

2. If the transmitter did not power up when the interface cord was plugged into it, turn
the power switch on at this time.

3. Next, click the Simulation menu and then highlight the Select Controller... menu
item. Choose the correct Profile from the drop down option, or create a new one to
match your radio. For more detail information about this dialog, see page 56.
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Binding your SLT Transmitter to the RealFlight wireless interface-

As noted above, we have previously offered a wireless transmitter interface compatible with
equipment that offered the SLT protocol. This was created to allow the use of Tactic®
branded transmitters in the simulation.

If you own this piece of equipment and will be using a Tactic-branded transmitter, the
wireless interface should already be plugged into the computer. With your Tactic®
transmitter turned on, following these steps to bind your radio to the RealFlight 9.5 RC Flight
Simulator.

1. From the Simulation menu, click the Select Controller... menu item. The following
window will appear:

Select; Controller

SPEKTRUM RECEIVER (Active)
Profile
i %S and YYS 2000 Calibrate

InterLink DX
Profile

Interlink D Calibrate

Refresh

2. With your Tactic SLT radio turned on, click the Bind button.

3. When the red light on the wireless interface turns solid, your radio is bound to
RealFlight. You should not need to go through this process again, unless you choose
to use a different radio.

It is possible that you may still need to edit the radio profile to work with the channel
mapping of your radio. Please see Select Controller... on page 56 for more information.

Exploring RealFlight 9.5

Now that you have completed the installation of the RealFlight program, it’s time to begin
exploring the program. The following sections will take you on a quick tour of RealFlight 9.5’s
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most popular features, such as selecting an aircraft, choosing alternate flying locations,
customizing the flying sites, and using the training aids instruction. Along the way, we will
show you where to go for help and how to obtain additional information.

Even if you are familiar with previous versions of the RealFlight software, you should read
this section thoroughly. Some features described here are either new, or have been
completely revised for RealFlight 9.5.

Start the Program*-

[*DVD and Digital versions only; Not Steam iteration]

1. Close all open applications. This includes virus scanning software and other similar
programs.

2. Double-click the RealFlight 9.5 Launcher located on your desktop.

3. To start the simulation, click the Run RealFlight button. As mentioned previously, if
there is an update available, this update will appear beneath the Run RealFlight
button. We strongly encourage you to update the software each time an update is
available.

The program will start by displaying a Welcome Screen. The Welcome Screen allows you to
select amongst a multitude of options which include, but are not limited to, choosing an
aircraft, flying site or a scenario (a pre-selected combination of aircraft and flying site),
receive a lesson, and/or earn challenge medals as desired. Additionally, at the bottom is a
large button to allow you to jump directly into RealFlight and start flying immediately.

Select a Flying Site
‘

~
= S
Watch a Training Video

h %
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From the Welcome Screen, you can also access a number of helpful videos. The videos will
walk you through some of the more popular features of RealFlight. For true beginners of RC,
the training videos are a great place to start, teaching you the basic controls for flight.

If you'd like, you can disable the Welcome Screen by unchecking the box labeled Show this
dialog on startup. You may access the Welcome Screen at any time through the Help menu.

The Main RealFlight Display-

RealFlight is a menu-driven program. As seen in the picture below, a menu bar appears
across the top of the RealFlight screen. Those menus contain additional sub-menu items and
pull-down lists for the related options of the respective menu. These menus allow access to
the command and control functions for the RealFlight 9.5 simulation.

Navigating the Menus-

To access the various menu items, simply highlight and click the mouse on the menu
that you would like to view. For example, clicking on the Aircraft menu activates the
sub-menu items for that menu.

Aircraft  Envi halleng: Multiplay Recordings Training View Help

® SAFE: Intermediate

This manual includes a separate chapter for each menu title. Later chapters describe
in detail all of the menu items, sub-menus and options.

Please note: It is also possible to access many of the features and functions of
RealFlight 9.5 using hotkeys. Pressing the ‘H’ key on the keyboard activates the
Keyboard Commands dialog, which summarizes the available hotkeys.
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Aircraft Selection-

When you start RealFlight 9.5 for the first time, you will be piloting E-Flite’s incredibly Habu
STS EDF (4S) electric ducted fan jet. This is the default aircraft for RealFlight 9.5.

To select a different aircraft, click the Aircraft menu title in the main menu bar. Next, click
the Select Aircraft... menu item found in the drop-down menu. This activates the Select
Aircraft dialog (as shown below), which displays a list of available aircraft. To make it even
easier than ever to select the most popular aircraft, we've placed the popular selections in
the main RealFlight 9.5 folder. At the default, there is also a RealFlight Legacy aircraft folder.
While there are many modelers that like these aircraft, these are selections that may no
longer be offered for sale (such as the Great Planes P-6E Hawk), or aircraft that have been
included in a number of previous iterations of the software. Additionally, if you have created
a custom model, or imported another RealFlight user’s model into the simulation, it will
appear in a Custom Aircraft folder accordingly.

# RealFlight
Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help
Edit E-flite Habu STS 70mm EDF (45 with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme >
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position P
Clear Aircraft Position Ctrl+P

Reset Position Space

Kill Engine

1. E-flite Twin Otter 1.2m

2, Russian Thunder

3. Ultimate Biplane

4. Synergy 766

5. Hangar 9 Ultra Stick 30cc (InterLink DX)
6. Blade 230 S V2

7. E-flite F-15 Eagle 64mm EDF

8. E-flite Timber X 1.2m Flight Modes oX

® SAFE: Beginner
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Select Aircraft X

2 E-flite Apprentice 5 15e ~
2 E-flite Apprentice STS 1.5m

2 E-flite Apprentice STS 1.5m (with LAS and GPS)
2 E-flite Apprentice STS 1.5m (with LAS)

2 E-flite Carbon-Z Cessna 150 2.1m (45)

2 E-flite Carbon-Z Cessna 150 2.1m (65)

2 E-flite Cirrus SR22T 1.5m

2 E-flite Delta Ray One

2 E-flite EC-1500 Twin 1.5m

2 E-flite EC-1500 Twin 1.5m (large aileron)

2 E-flite Extra 300 3D 1.3m

2 E-flite Extra 300 3D 1.3m [InterLink D]

e E-flite F-15 Eagle 64mm EDF

2 E-flite F-16 Thunderbirds 70mm EDF

2 E-flite F-27 Evolution

2 E-flite Habu STS 70mm EDF (35 with LAS)

2 E-flite Habu STS 70mm EDF (35)

2 E-flite Habu STS 70mm EDF (45 with LAS)

2 E-flite Habu STS 70mm EDF [45)

2 E-flite Havoc Xe 80mm EDF

2 E-flite Havoc Xe 80mm EDF (InterLink D)

. E-flite Mini Convergence VTOL (advanced)

2 E-flite Mini Convergence VTOL (simple]

2 E-flite Night Timber X 1.2m

e E-flite P-51D Mustang 1.5m

s E-flite Timber 1.5m The original Timber(R) captured the thrill of incredible Short Takeoff and Landing (STOL) capabiltiesina A

e Ti design featuring sporty flight performance and ultra-friendly handling. From low-time to very experienced
¢ Eite Timber 1.5m Float Plane pilots, nearly everyone enjoys flying the Timber - but some wish it had even more aerobatic capability. The

Description  Specifications

= E-flile T?mber X1.2m E-flite(R) Timber X 1.2m combines the STOL capabilities of the original model with a new wing design

e E-flite Timber X 1.2m (3D) featuring oversized ailerons and flaps, plus an enlarged rudder and elevator and a more powerful 35 and

2 E-flite Timber X 1.2m (3D] (InterLink D) 45 compatible power system, to also deliver 3D performance you'd expect from an all-out aerobat! It's also

s E-flite Timber % 1.2m lwith slats] v eauiooed with Horizon Hobby and Soektrum exclusive AS3XIR1 (Artificial Stabilization - 3-aXisl and X
Grouping  Product v Color Scheme | E-flite Timber % 1.2m Standard Cancel

Each aircraft available is listed along the left-hand side within the selected folder. The icon
next to each name differs depending on whether the model is an airplane, helicopter, or a
drone. To select an aircraft from the list, click on the desired aircraft. The selected model will
now appear in the ReadySelect™ preview box. Additionally, the aircraft’s description and
information data will appear in the aircraft information pane, which appears just below the
ReadySelect preview window.

When you are satisfied with your selection, click OK to return to the simulator using the
newly selected aircraft.

Complete information pertaining to the Select Aircraft... menu item is available in Chapter 6
of this manual, The Aircraft Menu.

Alternatively, you may use the InterLink DX controller to change aircraft selections. Simply
press the Scroll Wheel/Select button located on the front of the InterLink DX controller. This
will bring forth the QuickSelect tabs on the left side of the computer screen and the aircraft
selection tab, represented as an airplane icon, should be the highlighted tab. If not, rotate
the Scroll Wheel until the aircraft selection tab is highlighted. Press the Scroll Wheel/Select
button once again to bring up the QuickSelect Aircraft Selection dialog box. Roll the Scroll
Wheel left or right to view the available aircraft. To select an aircraft, simply highlight the
name and press the Scroll Wheel/Select button once again. You will return to the simulation
using the newly selected aircraft. Further instructions can be found on page 131.
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If you wish to exit the Aircraft Selection screen without making any changes, simply press the
Reset button on the left side of the InterLink DX controller.

Aircraft Most Recently Used List (MRU)-

If you have selected any different aircraft previously, you will note that these aircraft appear
on a list in the Aircraft menu; as shown below. This list is at the very bottom of the menu.
This list is commonly referred to as a Most Recently Used, or MRU list. It is limited to the
eight most recently used aircraft. If you wish to fly one of the aircraft from this list, simply
click on the name of the aircraft in the MRU list.

#= RealFlight

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (4S with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position P
Clear Aircraft Position Ctrl+P

Reset Position Space
Kill Engine K>

1. E-flite Twin Otter 1.2m

2, Russian Thunder

3. Ultimate Biplane

4, Synergy 766

5. Hangar 9 Ultra Stick 30cc (InterLink DX)
6. Blade 230 S V2

7. E-flite F-15 Eagle 64mm EDF

8. E-flite Timber X 1.2m Hight Modes OX

® SAFE: Beginner
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Airport Selection-

Changing flying sites uses a process similar to selecting an aircraft. To select a new flying
location, click the Environment menu title. Next, click the Select Airport... menu item found
in the drop-down menu. This opens the Select Airport dialog. All the airports in RealFlight 9.5
are initially grouped by their respective location or scene: Archipelago, Flatlands,
PhotoFields, or Sierra Nevada.

#= RealFlight

Simulation  Aircraft  Envi

Edit Eli Field
Create New Airport...

Sun

Thermals

Wind

Reset to Default

1. Sod Farm
2, Santa Clara County Model Aircraft Skypark
3. Evergreen Airport

4. Air Race Desert

5. Lake Douglas

6. Grass Flatlands

7. AMA Flying Site 3
8. Alpine Meadow

Fight Modes X
® SAFE: Beginner

L_:] Custom Airports
= [_J RealFlight 2.5

a Archipelago

& Flatiands

= & PhotoFields
Alpine Meadow
AMA Flying Site 3
Carl Henson Field
Eli Field
Evergreen Airport
Gold Country Aeromodeler Park
Grass Flatlands

X
X
X
X
X
3: Grass Flatlands (Night)
X
X
X
X
(X

el

Lake Douglas
LIARS Field

Santa Clara County Model Aircraft Skypark Home of the Monticello Model Masters, or M3 for short, Eli Field is ~
Sod Farm located on the outskirts of Monticello, Hlincis and is named after the
\Waco Field father of Horizon Hobby’s founders Rick and Larry Stephens. Ithas

" served as the host field for Horizon Hobby's RC Fest as well as
3 ierra Nevada countless other national and international events. Italso serves as
the test site for many of Horizon'’s RC offerings and home field for
world-class pilots such as Dustin Buescher, Ali Machinchy, James
Haley and David Payne amonast others. v

Grouping |Product, Scene ~ OK | | Cancel
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Some scenes are preceded by a [+] (plus) and an icon. The [+] (plus) indicates that another
expansion level (selection) is available to you. To access the complete list of airports for a
particular scene, either click the [+] (plus) or double-click on the name of the desired scene.
For example, clicking the [+] (plus) next to the PhotoFields folder reveals all of the
PhotoFields flying sites available to you.

To select an airport from the list, click on the desired airport. The selected airport will now
appear in the preview box. Additionally, an airport description will appear in the information
pane, which appears just below the preview window. When you are satisfied with your
selection, click OK to return to the simulator using the new airport selection.

Navigating the Airport Selection menu using the QuickSelect feature is almost identical to the
process mentioned previously for selecting aircraft. Only this time, you will select the Airport
Selection menu, which is represented by a runway icon. With the QuickSelect tabs visible on
the computer screen, roll the Scroll Wheel/Select to highlight the runway icon. Press the
Scroll Wheel/Select button to bring forth the available flying sites. Using the same method,
as described previously for aircraft, select the new airport and press the Scroll Wheel/Select
button to return to the simulation using this new flying site.

Airport Most Recently Used List (MRU)-

If you have previously selected an alternative flying location, it will appear on a list in the
Environment menu. This list is at the very bottom of the menu and is commonly referred to
as a Most Recently Used, or MRU list. It is limited to the eight most recently selected
locations. If you wish to fly at one of these locations, simply click on the respective location in
the MRU list to load it into the simulation.

a RealFlight

Aircraft  Envi Challeng Gadgets Multiplayer Recordings Training View Help
Select Airport...
Edit Eli Field
Create New Airport...

Sun

Thermals

Wind

Reset to Default

1. Sod Farm

2. Santa Clara County Model Aircraft Skypark
3. Evergreen Airport
4. Air Race Desert

5. Lake Douglas

6. Grass Flatlands

7. AMA Flying Site 3
8. Alpine Meadow

Flight Modes (7.4
® SAFE: Beginner
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QuickSelect Tabs-

If you have the InterLink DX controller, RealFlight 9.5 offers a revolutionary method for
accessing many features and functions quickly and easily without ever touching the keyboard
or mouse. There are seven main areas of access available through the QuickSelect tabs. They
are: Scenario Selection, Aircraft Selection, Flying Site Selection, NavGuides, On-Screen Radio,
Binocular view, and Viewport.

To access any of the QuickSelect tabs, press the Scroll Wheel/Select button on the InterLink
DX controller. This will bring forth the available options on the left side of the computer
screen. Roll the Scroll Wheel/Select left or right to cycle through the QuickSelect tabs. The
highlighted tab is the item that is active. To access the active tab, press the Scroll
Wheel/Select button.

You can also access the QuickSelect tabs with the mouse by moving the mouse cursor over
to the left side of the screen. The QuickSelect tabs will appear and you may click on the
desired icon.

#* RealFlight

Aircraft E lleng Gadgets Multiplayer Recordings Training View Help

Hight Modes X
® SAFE: Beginner

For additional information on how to use the QuickSelect tabs, please refer to the
information contained in the section entitled QuickSelect- on page 49.

Some Common Tasks-

e The easiest method of resetting your aircraft to its original takeoff position is to press the
reset button located on the front of the InterLink DX controller. Alternatively, you can
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reset the aircraft by pressing the space bar on the keyboard, or by selecting the Reset
Position menu item, which is located in the Aircraft menu.

e Ifyour aircraft is equipped with smoke, Switch A located on the rear left corner of your
InterLink DX controller will generally be utilized to activate this feature.

e Tozoom in on an aircraft, press the [+] (plus) key on the number pad of the keyboard.
Alternatively, you may use menu commands to zoom in. To do so, click on the View
menu and then click on the Zoom In menu item. Each time the [+] (plus) key or the Zoom
In menu item are pressed or selected, the view will increase incrementally.

e Tozoom out of the current view, press the [-] (minus) key on the number pad of the
keyboard. Alternatively, you may use menu commands to zoom out. To do so, click on
the View menu and then click on the Zoom Out menu item. Every time you press [-]
(minus) key or select and press the Zoom Out menu item, the view will decrease
incrementally.

e Toreset the view to the default zoom level, press the Backspace on the keyboard.

Please Note: The Zoom keys are not always functional for all camera modes. Press Z or C on
the keyboard to cycle through the different zoom and camera modes, respectively.
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Creating a Viewport-

RealFlight allows you to create an additional picture-in-picture viewport. Once you create a
new viewport, you may resize or reposition it by dragging the mouse. You can also adjust all
of the viewport’s properties independently of the main window. The viewport may be
utilized for a variety of applications, such as changing the viewing perspective of your
simulation.

To create a new viewport, click the Gadgets menu title followed by the Viewport menu item.
Alternatively, you may also press the ‘4’ key on the keyboard to create an additional
viewport.

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Vizyoore

Flight Modes 0 X
® SAFE: Beginner

To change the vantage point within the active viewport, press the ‘C’ key on the keyboard.
This toggles through the various camera modes, one of which is the cockpit or pilot’s
perspective. Others include: chase view and a fixed viewpoint, or what you would see if you
were standing at the side of the runway.

Please note: Depending upon the flying site selected, some of these viewing options may not
be applicable.

Also, some aircraft include onboard cameras for additional viewing perspectives. The View
chapter of this manual contains a thorough explanation of the viewport and camera options.
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Using Gadgets-

The RealFlight software includes several gadgets that may be displayed in the main window
when running the software. A gadget is an on-screen display that provides helpful
information, or allows you to access to a variety of RealFlight features and functions.

For example, the NavGuides gadget displays continuously updated information relating to
your aircraft’s altitude, airspeed, directional heading, and other flight parameters. To display
the NavGuides gadget, click the Gadgets menu title followed by the NavGuides gadget
located in the drop-down menu. You may also access the NavGuides by pressing the
numerical ‘1’ key on your keyboard. Alternatively, you may activate the NavGuides through
the QuickSelect tabs. To do so, press the Scroll Wheel/Select button on the InterLink DX
controller. Next, roll the Scroll Wheel/Select to highlight the NavGuides icon. Finally, press
the Scroll Wheel/Select button to activate the NavGuides.

When you select NavGuides, you should see the NavGuides gadget appear on your screen:

NavGuides O X

Alrspeed 0 MFH
&5 0

v Remaining 31137 mah
Graphics FramesiSec: 12:
REM a055 RPM
wind 0 MFPH

As discussed previously, you can customize the gadgets for personal preference. For
complete information on how to do so, please refer to the chapter pertaining to the Gadgets
menu options.
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Challenges-

RealFlight offers a large number of challenges to help you test, refine and hone your flying
skills. As you improve your skills and score well in the challenges, more levels become
available, each progressing higher in difficulty.

Filter: =~ All Airplane Heli Drone

Air Race

Improve your precision flying skills by passing through
an array of gates

Balloon Burst

Fop all the balloons!

FPV Drone Racing

Pilot an FPV Racing Drone through an introductory

seres of courses

Grapple

Lift and move objects with your heli

Do well in these challenges, and you may be rewarded for your efforts with new content,
including new aircraft to fly.
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Airport Editing-

RealFlight offers the most powerful, flexible flying site editor ever produced on an RC
simulation. RealFlight’s FlexiField editor allows you to completely customize virtually every
aspect of your flying sites.

#* RealFlight
File Edit View Options Window

W Tent-OSEngne A
-l Tent -Kinexsis - Blue
-4l Tent - Spektrum - Blas

-“W# The Gnome

W4 Tent-FMS - Green

W 12 foot table

W@ 12 foot table .
-4l Tent -Force RC - Wh ) &gl Blade Flag -Blade A

W Tent - Blade - White g o g Blade Flag - Blade

-l 12 foot table e = 2 Blade Flag - E-fiite
‘Jvl ) Lights . ) . t P WM Olade Clam © fibm
{3 Fencing . S >

il -~ohai

v
>

Add

Properties

Parameter

Custom Name

Relative Position (m)

Object Name

Object Location

ZBoost

Fada it Gtart Nictanca fm)
>

Name of the object. Folders
whose names are preceded by
an underscore character are
hidden from view outside of the
editor unless made visible by the

Challenne sustem 2 multinlaver

You can add, remove, change the orientation of, or resize virtually every aspect of your flying
site. You can alter the position and orientation of the ground objects (such as runways) that
‘snap’ to the terrain—you can even have a runway running up a hill! It’s even possible to
control lighting, terrain, clouds, fog/haze, and much more. FlexiField provides you with
almost unlimited freedom to create the flying environment you want. Moreover, when
you’ve created an airport, you can share it with other RealFlight users.

To learn more about the FlexiField flying site editor, please refer to the section titled Edit
Current Airport... on page 162.
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Aircraft Editor-

RealFlight also includes a powerful aircraft editor, allowing you full control over every aspect
and parameters for an aircraft.

M Aircraft Editor - E-flite Habu STS 70mm EDF (4S with LAS)

File Edit Component Options View

Vehicle |Physics | Electronics Radio Visuals

v A Airframe Parameter Value a
Iy Standard Parameters ~
> 'i" Fuselage il
Location in Parent (m) x=0, y=.246, z=.010
Number Cells in Series 4
Number Cells in Parallel 1
Cell Type LiPoly 3200 mah
Dimensions (mm) x=50, y=170, z=40
Advanced Parameters -
i s Speed Controller Resistance (Ohm) .0030 G

The Aircraft Editor allows you to make both simple and complex modifications to any
aircraft. You could simply change the diameter of the wheel on the landing gear, or add new
wings, streamers, or paintball guns. The possibilities are endless, and you can expect your
modifications to accurately affect the behavior of your edited aircraft.

To learn more about the Aircraft Editor, refer to section Edit Current Aircraft on page 134.

To make simple refinements to the selected aircraft, we suggest utilizing RealFlight 9.5’s
Quick Edit feature. To do so, simply press ‘Ctrl + Q" on the keyboard. Make the desired
changes, and then click Save.

For more information about the Quick Edit feature, see page 149.
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Multiplayer Contests-

RealFlight 9.5 offers multiplayer combat events. With an internet connection, you can
challenge your neighbor next door, friends from the local RC club, or anyone, anywhere in
the world.

~* RealFlight O X

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Pilot Profile...

Join...

Hosting...

Disconnect

Host Options
Scoreboard...

Server Details...

Game Help...
Game Gadgets
Select Target Previous

Simulation Sounds et

Voice Chat Clear

jeexttnat Auto-targeting Mode

Enter MultiMode

Multiplayer contests include: Fun Fly, Deadringer, Combat, Streamer Cut, Paintball, and
Rocket Wars on a variety of different aircraft. Up to 32 people can participate in a multiplayer
session. Please note that the fluidity of the multiplayer events hinges upon the connection
(latency, speed, etc.) of the player with the slowest internet capabilities. If all participants
have a stable, fast connection the event will be much more enjoyable and exciting. RealFlight
also offers a way to automate contests into events, so the host can spend more time
enjoying RealFlight.

To quickly join a public multiplayer session, click the Multiplayer menu followed by the Join...
menu item. On the dialog window that appears, select a multiplayer session from the list and
click Connect.

For more information about multiplayer and combat events, check out Chapter 10 on the
Multiplayer Menu.
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Keyboard Commands

Many options throughout RealFlight may be activated quickly by a simple press of a key on
the keyboard. Below is a list of functions and their related keys. You may also access this list
in the simulator by pressing ‘H’ on the keyboard.

Virtual Channels-

Channel 5 Y
Channel 6 u
Channel 7 I

Channel 8 o
Channel 9 J

Gadget Commands -

NavGuide Gadget 1

Radio Gadget 2
Binocular Gadget 3
Viewport Gadget 4
Variometer Gadget 5
Multiplayer Gadget 6
Overhead Gadget 7

Timer Gadget 8
Heads-Up Display 9

Flight Modes Gadget 0
Console Gadget ~

Chat Gadget Enter
View Commands -

Reset Aircraft Space
Zoom Reset Backspace
Zoom In +

Zoom Out -

Quick Look at Windsock Up Arrow
Quick Look at Ground Down Arrow
Fixed Camera F1

Nose Camera F2

Chase Camera F3
Onboard Cameras F4-F10
Set Viewport Camera Ctrl + F1-F10
Change Camera Mode C
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Follow Camera

Pivot Camera

Orbit Camera

Select Pit Position

Select Previous Pit Position
Select Default Pit Position
Change Zoom Mode
Change Movement Mode

Movement Commands —
Move Forward

Move Backwards

Move Left

Move Right

Move Slow

Move Fast

Move Very Fast

Environment Commands —
Increase Wind Direction
Decrease Wind Direction
Increase Wind Speed
Decrease Wind Speed
Increase Turbulence

Decrease Turbulence

Increase Sun Azimuth
Decrease Sun Azimuth
Increase Sun Inclination
Decrease Sun Inclination

Miscellaneous Commands —
Take Screenshot

Toggle Microphone On/Off
Kill Engine

Start/Stop Recording

Look at Next Aircraft

Look at Previous Aircraft
Look at My Aircraft
Remember Aircraft Position
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Shift + C
E
Ctrl+E
X

Shift + X
Ctrl + X
Z

Q

o>wvg

Ctrl
Shift
Shift + Ctrl

Home

End

Page Up
Page Down
Insert

Delete

Shift + Home

Shift + End

Shift + Page Up
Shift + Page Down

Shift+T
Ctrl+T
o}




Clear Position Ctrl+P

Flight Failures F

Quick Load Gadget Ctrl +F
Quick Edit Gadget Ctrl+Q
Mute/Unmute Audio M

Toggle Full Screen Mode Alt + Enter

View Keyboard Commands H
Copy Messages to Clipboard  Ctrl+C
Steam Overlay Shift + Tab

Game Commands —

Target Previous Aircraft [
Target Next Aircraft ]
Clear Target \
Toggle Padlock View /

Where to Go From Here

The examples in this chapter only scratch the surface of RealFlight 9.5’s unparalleled
capabilities. We encourage you to explore RealFlight using some of the methods below.

e Browse through the menus. Many of the menus are self-explanatory, providing you with
a more thorough look at the software. If you’re adventuresome, dive right in and start
making modifications to an aircraft or a flying site! It’s a great way to learn more about
what makes the RealFlight 9.5 RC Flight Simulator tick!

e Ifyou'd like to learn more about a particular menu or item, look it up in the table of
contents.

e If you would like RealFlight 9.5 to perform a certain function but cannot locate the
appropriate command, check the index.

e Use the Help option in RealFlight’s Help menu.

e Talk to other RealFlight users at www .knifeedge.com/forums.
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Chapter

4

Controlling RealFlight 9.5

FLY WITH THE INTERLINK DX, YOUR SPEKTRUM DSM2/DSMX TRANSMITTER,
OR WITH YOUR OWN RADIO.

he RC transmitter is a key component in all types of RC flying. This uniqgue method of

control is part of what separates RC from every other type of aviation. Consequently, a

realistically simulated transmitter is an important key to an authentic simulation of the
RC experience.

With this in mind, we at Horizon Hobby are proud to offer many choices to control the
RealFlight 9.5 RC Flight Simulator software. Our revolutionary USB InterLink DX (U.S. Patent
#6,842,804 and #7,010,628) controller, is the most popular option. The InterLink DX
controller was designed from the ground up to meet the needs of the RC purist. We believe
that no other RC simulator control method goes further to enrich your RC simulator
experience.
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Wireless Simulator Dongle

The Spektrum WS2000 Wireless Simulator Dongle (SPMWS2000) is another popular option,
enabling you to control RealFlight aircraft with your Spektrum DSM2 or DSMX-compatible
transmitter.

The previously offered RealFlight SLT wireless interface option is also functional with
RealFlight 9.5. This allows you to fly using your own SLT transmitter, or a transmitter
equipped with an AnyLink/AnyLink2 adapter.

Additionally, the previously offered, RealFlight wired interface option allows you to utilize
RealFlight 9.5 by connecting to your transmitter’s trainer port.

R

REALFLIGHT"® R/C Flight Sim

Transmitter Interface
@ RESET / REWIND
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Features of the InterLink DX Controller-

e USB compatibility and convenience. The InterLink DX offers the “plug and play”
convenience, “hot pluggable” installation and removal, as well as the high-speed digital
performance made possible by Universal Serial Bus (USB) technology.

e High quality “mockup” 15 —channel transmitter. Use the InterLink DX controller by itself
as a pseudo RC transmitter, with the controls you expect in a standard RC radio. The
mockup transmitter features two 2-position switches, five 3-position switches, a rotary
knob, two sliders, a push-button, and knurled control sticks with adjustable length,
tension and ratchet availability.

e Built-in transmitter interface. If you so choose, you can use your own FM or FM-
compatible RC transmitter to control RealFlight, using the InterLink DX controller’s built-
in interface. You can even switch back and forth between the pseudo controller and your
own transmitter! Interface adapter cords are available separately that are for use with
most Spektrum, Tactic, JR and Futaba transmitters.

e QuickSelect menu controls. With the InterLink DX, you’re able to make a variety of
common adjustments to the simulator (such as selecting a different aircraft or airport)
without having to touch the keyboard and mouse.

e Easy setup and use. Simply plug it in and go!

e Simulate sophisticated computer radios. The InterLink DX, used in conjunction with the
RealFlight software, allows you to simulate the programmability (mixing, exponential,
etc.) of sophisticated computer radios.

Features of the Spektrum WS2000 Wireless Simulator Dongle-

e USB compatibility and convenience. The dongle offers the “plug and play” convenience.

e No wires to tether you to the computer. Complete freedom to sit back and enjoy the
RealFlight experience with your Spektrum DSM2 or DSMX-compatible transmitter.

e Gain confidence in the programming of your applicable Spektrum transmitter.

e Become acquainted with not only the location of the respective switches, buttons, etc.
found on your Spektrum transmitter but also the ‘feel’ of the transmitter in your hands.

Features of the RealFlight wireless SLT interface-

e USB compatibility and convenience. The interface offers the “plug and play”
convenience.
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e No wires to tether you to the computer. Complete freedom to sit back and enjoy the
RealFlight experience.

e Compatible with Tactic’s SLT protocol. Any radio that transmits using the SLT protocol will
work perfectly with the wireless interface. Radios without SLT can utilize an AnyLink or
AnyLink2 adapter.

Features of the RealFlight wired interface-

e USB compatibility and convenience. The interface offers the “plug and play”
convenience, “hot pluggable” installation and removal, as well as the high-speed digital
performance made possible by Universal Serial Bus (USB) technology.

e Use your own FM or FM-compatible RC transmitter to control RealFlight. Interface
adapter cords are included for most Spektrum, Tactic, JR and Futaba transmitters.

e Reset/Rewind — We brought the best function of the previous InterLink to the RealFlight
interface with the Reset/Rewind button. With the interface near hand, there is no need
to reach for the keyboard.

Start Flying!

When you start RealFlight for the first time, the software will automatically detect the
InterLink DX controller. When you close the Welcome Screen, simply add throttle and start
flying right away. Note: In order to obtain the best flying experience possible, we strongly
suggest that you calibrate the InterLink DX controller accordingly. Information on how to do
so may be found on page 60 of this manual.

If you are flying with your own radio with the RealFlight interface, or through the InterLink
DX, please refer to the Select Controller section on page 56.

QuickSelect-

The InterLink DX also offers QuickSelect buttons located on the controller. These buttons
allow you to make simple changes to the simulator without having to put the controller
down and reach for the keyboard or mouse. This makes it convenient to change the current
aircraft and airport, or display popular on-screen gadgets.

To access the QuickSelect tabs, press the Scroll Wheel/Select to display a number of tabs
along the left side of the simulator. Roll the scroll wheel to rotate through these options.
Pressing the Scroll Wheel/Select once again will select the highlighted tab. Pressing the
Cancel button on the InterLink DX will exit out of the tabs and hide them.
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Select Scenario

Select Aircraft

Select Airport

NavGuides Gadget

Radio Gadget

Binocular View

Viewport
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When using the QuickSelect buttons in the Select Aircraft or Select Airport dialog screen,
press the Scroll Wheel/Select to select the highlighted item. Pressing Cancel on the InterLink
DX will move you up a level, so you can quickly change folders. To exit out of these dialog
screens without making any changes, simply press the Reset button.

Look for the icon to the left throughout this manual for suggestions
on when to use the QuickSelect buttons.

- l N J[ er LI n k _,'. s— Select/Scroll

Simulator Controller
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Chapter

S5

The Simulation Menu

ALLOWS ACCESS TO A VARIETY OF SIMULATION-RELATED FEATURES,
FUNCTIONS AND OPTIONS.

he Simulation menu gives you access to many simulator related features, such as
adjusting physics parameters, changing simulator settings, or importing and exporting
RealFlight files.

Clicking the Simulation menu will open the drop-down menu as illustrated in the following
screen shot.

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Scenario...

Manage Scenarios...

Select Controller...

Physics...

Graphics...

Flight Failures >
Setup Failures >
Import >
Export >

Manage User Files...

Mute/Unmute Audio M
Settings...

Capture Screenshot Tab
+~  Show Title Bar

Exit

Flight Modes 0 X
® SAFE: Beginner
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Select Scenario...

Often times you’ll find yourself wanting to fly a particular aircraft at just the right flying
site under the perfect conditions. For example, you may wish to fly a glider along a cliff
with the winds just right for soaring. RealFlight offers many of these scenarios pre-
configured to save you time.

#* RealFlight

Simulation Aircraft Environment Chall

Select Scenario

saibbRaitaia b b Full Scale Aerobatics

XN Flight School HD <~ Russian Thunder

E-flite Habu Fun FI
End of Days

Eye in the Sk
Float Flying

Flying Wing

FPY Racing

Full Scale Aerobatics
Golden Age Redu

avride
LEEIERD

spective. Don't forge

Junkyard Grappling
Monster Ferformance
Night Flying - Airplane
Night Flying - Heli
Pattern Practice

Scale Mustang

Color Schemes

Choosing the Select Scenario... menu item from the Simulation menu will display a
dialog window with many scenario options listed for your convenience. For slope
soaring along the cliff, you might select Cliffside Soaring to fly the Mistral 3m at the
Sierra Nevada Cliff airport.
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Change scenarios by using the InterLink DX. Press the Scroll
Wheel/Select, then, with the scenario tab highlighted, press the
Scroll Wheel/Select once again. This will bring up the Select
Scenario QuickSelect dialog window. Roll the scroll wheel to scroll
through the scenarios accordingly, use the Scroll Wheel/Select to
choose a new scenario, or press Reset to resume flying without
making any changes.

Manage Scenarios...

If you wish to create and edit Scenarios to your own tastes, choose Manage Scenarios
from the Simulation menu. Doing so will display the following dialog:

Manage Scenarios X

Aero Tow -~
Aerobatics - Advanced

Aerobatics - Beginner

Amphibious Adventure

Bayou Beaver

Beqinner Airplane Training Create
Beginner Helicopter Training
Blimp

Bowling Edit
Carnival

Catapult Launch

Cliffside Soaring

Coaxial Heli

Construction Site Shenanigans
Day at the Races

Desert Osprey

Dynamic Soaring

E-flite Habu Fun Fly

End of Days Delete
Eye in the Sky

Float Flying

Flying Wing

FPY Racing

Full Scale Aerobatics
Golden Age Redux v Exit

Copy

Rename

The list on the left displays all the scenarios currently accessible to you. On the right are
all the actions that are available to you. They include:

e Create — This button allows you to create a brand new scenario.

e Edit — This allows you to make changes to the selected scenario from the list.

e Copy - If you wish to make a new scenario with the same parameters, select it
from the list and then click copy. This is a quick way to make a new scenario that
you like but would like to make only minor changes, instead of creating a new
one.
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e Rename — Use this to rename a selected scenario. This option is only available to
scenarios that you create. You cannot rename stock scenarios.

o Delete — As the name implies, choose this to delete a scenario. Like rename, this
is not available if a stock scenario is selected.

When you click Create or Edit, the following dialog window will appear:

Untitled Scenario X

Required Info

Airport: | Eli Field

Aircraft: | E-flite Habu STS 70mm EDF (45)

Color Scheme: E-flite Habu STS 70rmm EDF Standard

Description

Advanced Options == Save Save As,.. Exit

This window allows you to select and change all parameters associated to a scenario.
They include:

e Airport — Press the ... button to choose an airport.

e Aircraft — Press the ... button to choose an aircraft for this scenario.

e Color Scheme — If the aircraft you selected is available in multiple trim schemes,
you may select the default for this scenario from the drop down list.

e Description — As the name implies, this field allows you to type up a short
message that describes the scenario.

By clicking the Advanced Options, two more parameters will be available to you if you
choose a 3D airport (not PhotoField). They include:
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e Starting Position — Some 3D airports have multiple locations from which you can
start your flight. Choose the location you wish to be the default for the scenario
from this drop down list.

e Camera Type — When flying at 3D airports, you have the option to change your
camera location. You may change the default for your scenario from this drop
down list.

Finally, click Save, to save your changes to the current scenario. If you are editing a stock
scenario, this option is unavailable. Clicking Save As allows you to save under a different
name. If you wish to quit or return to the Manage Scenarios window without saving any
changes, simply click the Exit button.

Select Controller...

RealFlight 9.5 is offered in several different iterations, allowing you to control the aircraftin a
variety of ways. This includes, but is not limited to the InterLink DX or Software Only,
versions. It is also compatible with previous control methodologies such as those mentioned
previously. To assist you, RealFlight includes features to help walk you through setting up
your choice of controller.

#= RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Scenario...

Manage Scenarios...

Physics...

Graphics...

Flight Failures >
Setup Failures >
Import >
Export >

Manage User Files...

Mute/Unmute Audio M
Settings...
Capture Screenshot Tab

+~  Show Title Bar

Exit

Flight Modes OX
® SAFE: Beginner
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After clicking Select Controller..., a new window appears with all the controllers available to you.
For many users, you will only see one controller listed. If you happen to have a real transmitter
plugged into the InterLink DX, for example, your screen may look something like the following:

Select Controller

SPEKTRUM RECEIVER
Profile

Y5 1000 Danale Calibrate

InterLink DX (Active)
Profile

[rterlimk Cx Calibrate

Refresh

The controller that is currently in use for flight will have an orange bar next to it as well as
“(Active)” next to the name. A few options are available to you from this window:

e Profile — RealFlight allows you to save profiles for the different radios you might want
to fly with. Choose the profile that best matches your controller from this drop-down
list.

e Edit —Clicking Edit on the Active controller will open a new screen that gives you
access to modify and adjust the controller’s channels and other parameters. See
below for more information.

e Bind —If you are using the RealFlight SLT wireless interface, you will see that a Bind
button is available. To bind your radio to the wireless interface, make sure the radio
is switched On, then click the Bind button. Note: This is not applicable to the
WS1000 or WS2000 wireless simulator dongle offerings.

e (Calibrate — To ensure that your controller is properly calibrated to fly aircraft in
RealFlight, click Calibrate on the Active controller. Additional information about the
calibration process is found below.

e Refresh—If, at any time, you plugged in a radio and turned it On while this screen is
visible, click Refresh to update the list. Doing so should include your new controller
method in the controller listings.
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To switch the Active controller, simply click on an available controller listed. You will see the
orange selection bar switch to the new controller as well as “(Active)” appear next to the
name.

There are hundreds of radios that are compatible with RealFlight, but not all of them
function exactly the same. Some may have a different channel order, or possibly the channel
input is reversed. To assist you with making, changing and saving these settings, RealFlight
offers controller Profiles.

Edit-

If you wish to use a radio that is not listed in the Profile drop down list, select
something similar, then click Edit. The following screen will appear:

Edit: Profile: InterLink DX

Controller Setup

Channel 1 - Aileron roportion Right Stick X Axis

Channel 2 - Elevator roportion Right Stick Y Axis

Channel 3 - Throttle roportion Left Stick Y Axis

Channel 4 - Rudder roportion Left Stick X Axis

el -state Switch C - Pos. 2 Switch C - Pos. 0

Channel € - Flaps state Switch D - Pos. 2 Switch D - Pos. 0

Channel 7 - Smoke roportion Swilch A

Channe! 8 - Mode state Swilch B - Pos. 2 Switch B - Pos. 0

X Enable Software Radio Mixes

X| Enable Software Radio Dual Rates and Expo

Save Save As...

The four columns visible include:

e Function —This is the list of channels that RealFlight uses for its aircraft. These
cannot be modified. Below each function is a bar. These bars show the
current value for each input channel. For example, if you move the throttle
stick on your controller, the associated bar will move.
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e Reverse — Check this box to reverse the output direction of a channel. For
example, if you advance the throttle stick but the throttle bar decreases,
clicking the Reverse box should mimic this input accurately.

e Type- This indicates the switch, button, etc. that is associated with a given
channel. There are three options- proportional, toggle and tri-state.
Proportional, as the name suggests, indicates that a given channel is
proportionally controlled in the movement. Similarly, Channel 8, in an
aircraft equipped with SAFE/AS3X, offers a tri-state functionality- switching
amongst SAFE/AS3X offerings accordingly.

e Value —The bars that appear in this column show the current value for each
input channel. For example, if you move the throttle stick on your controller,
the associated bar will move.

e Input Channel —This is the channel on your radio that is assigned to the
Function column.

Using the information from these columns, you can edit the channel lineup to match
your radio. For example, if your radio outputs the throttle on channel 1, you will
follow these steps to correctly assign it to RealFlight’s throttle:

1. Find “3 Throttle” from the Function column.

2. Click the corresponding Input button.

3. Move the throttle stick to connect your radio’s Input to the Function.
Repeat for all other channels you wish to reassign.
Enable Software Radio Mixes-

By default, RealFlight will handle all channel mixing in each aircraft. This is the
simplest method to fly in RealFlight. In this mode, you should not have any mixing
programmed into your radio, otherwise channels will be mixed twice; once by your
radio and then by RealFlight. If you wish to use the mixing programmed in your radio,
uncheck the box Enable Software Radio Mixes.

Enable Software Radio Dual Rates and Expo-

Some radios allow you to program the expos and dual rates on your transmitter. If
you prefer this method, make sure Enable Software Radio Dual Rates and Expo is
unchecked.
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If you are flying with the InterLink DX, or with a radio that does not offer this
functionality, your will want to enable this feature. Then, make sure you assign a
channel to “5 Ele./Dual Rates” in the channel assighments above. RealFlight will then
handle all rates and expos for you.

Save and Save As-

After making changes to your controller profile, you will want to save all
modifications. Note that you cannot make changes to stock profiles that are included
with RealFlight. If you made changes to a stock profile, the Save button will be
disabled. Click the Save As button to save the profile under a different name.

Calibrate-

Clicking the Calibrate button on the Active controller allows you to adjust and fine-tune the
controller input for the simulation, so that you will achieve the desired responses. Once
clicked, the following screen appears:

Controller Calibration

-»' -«
Center all controls (including the throttle stick).

7T

As directed, place all sticks to their center positions. Click Next when finished.

RealFlight 9.5 RC Flight Simulator




Controller Calibration

Move both sticks up, down, left, and right to their extents.
Exercise all switches and knobs as well.

Make sure you move each control to both extremes.
Right Stick X Axis

Right Stick Y Axis

Left Stick Y Axis

Left Stick X Axis .
Knob
Left Slider ChS Ch6 Ch7 Ch8 Cho

Right Slider

Cancel X Finish

It is imperative to move all of the sticks, knobs, sliders and switches through their complete
range of motion several times. This is the key to a properly calibrated controller- and thus,
precision flight. When completed, click Finish. You will now be returned to the Select
Controller screen with a calibrated controller.

Virtual Channels-

Many aircraft that are included with RealFlight, as well as user created aircraft, require 5, 6, 7
or even 8 channels to completely operate them effectively. Some radios have fewer
channels. If you are flying with a radio that has fewer channels than the currently selected
aircraft requires, you can use the keyboard.

Channel 5 Key: Y

Pressing Y will act like a two-position switch. Press the key to flip the switch to its
opposite position.

Channel 6 Key: U

Pressing U will activate the knob to one extreme or the other, while holding the key
down will slowly rotate the knob.

Channel 7 Key: |

Pressing | will act like a two-position switch. Press the key to flip the switch to its
opposite position.
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Channel 8 Key: O

Pressing O will act like a three-position switch. A quick press of the key will flip the
switch to one extreme or the other, while holding the key down will place the switch
to its center position.

Channel 9 Key:J

Pressing J will act like a two-position switch. Press the key to flip the switch to its
opposite position.

It might help to display the Radio Gadget to view these channels in action and to assist you in
learning how they function.

Physics...

One of the great benefits of RealFlight is the ability to adjust features and settings that you
would not be able to do at a real flying field. The Physics setting is one of these great
features. It allows you to adjust how realistic the flight physics are in the simulator on a
global scale, meaning that all of the simulator’s characteristics reflect this modification. The
options that are available are as follows:

Physics

e ulty Custam

Intermediate

Beginner Realistic
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Beginner-

This setting is perfect for the first time pilot. It reduces the speed of the physics to
allow a beginner time to react and learn how an aircraft is controlled. At this level,
you cannot run out of fuel, and crashes are more forgiving.

Intermediate-

Crashes are not as forgiving, and aircraft will run out of fuel just as they would at the
field.

Realistic-

By default, RealFlight 9.5 is set to Realistic. As the name implies, this setting
accurately reflects the flight performance of their real-world RC counterparts. The
flight physics level for Realistic is very similar to Intermediate. However, you will
notice that the severity of the stalls has also increased; forcing the pilot to react
faster to stalls and other similar flight characteristics.

Custom-

Custom will be selected if you made changes to the default settings for physics
speed, flight model, autopilot assist or fuel consumption. If you wish to adjust the
physics parameters to fit your skill level, click the Custom Tab at the top of the
Physics gadget. The following options are available.
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Physics

Difficulty custom

PHYSICS SPEED

FLIGHT MODEL

E A

AUTOPILOT ASSIST
NONE

UNLIMITED FUEL

e Physics Speed — Expressed as a percentage, this value controls the time scale
of the simulation. Reducing the value allows you to create a slow-motion
effect. This is useful when learning new skills or practicing difficult
maneuvers; slowing the aircraft’s reaction time.

e Flight Model — This setting can range from “Easy” to “Realistic”. At an Easy
setting, the aircraft are easier to fly than in real life. This is especially true at
slow speeds. If set to Realistic, RealFlight 9.5 simulates real life aerodynamics
in every way, including abrupt loss of lift during an aerodynamic stall. Setting
the Flight Model to something in between will provide a compromise.

e Autopilot Assist — This setting improves overall stability of the aircraft. Much
like the Active Flight Stabilization found on Hobbico’s NexSTAR, the Autopilot
Assist will attempt basic wing leveling when you release the control sticks. For
helis, the Autopilot Assist manages the collective to resist crashes. The
strength of the assistance is inversely proportional to the aircraft’s height
above the terrain, meaning that it will let you mess up a bit but will try to
keep you from actually colliding with the ground.

e Unlimited Fuel — This option determines whether or not your aircraft will run
out of fuel. If selected, the engine will run indefinitely — assuming, of course,
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that you do not crash. If disabled, the aircraft will indeed run out of fuel. The
length of time required to do so is based upon a number of factors including
the engine utilized and throttle management, just as it would be at the flying
field.
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Graphics...

Not all computers are created equal. You might find that RealFlight will perform better if you
reduce the graphics quality of the simulator. Alternatively, if you have a high-end computer,
you might enjoy the visualizations better by increasing the graphics quality.

Graphics Quality: Settings

Use the slider to adjust the quality of RealFlight's visual presentation.

> Settings . from the main menu and select Graphics to custc

MEDIUM HIGHEST
_'

Cancel Apply

A RealFlight must restart for these changes to take effect

At the bottom of the Graphics Quality Settings dialog, you will notice a slider. Moving this
from Low to Highest will alter the screen shot displayed above the slider, depicting the
current selection. If you find RealFlight is not performing at its peak, try reducing these
settings.

The slider will be set at Custom if you decide to alter individual graphics parameters in the
Settings dialog. See Settings on page 85 for more information.
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Flight Failures

RealFlight offers the ability to simulate common failures for your aircraft. Flight Failures aid in
teaching you how to remain calm and react appropriately when an actual failure occurs
during flight. RealFlight 9.5 allows you to determine the types of flight failures that you will
face, as well as how often these failures will occur.
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Adjust the Rate of Occurrence-

To reduce the frequency of flight failures, click on the Simulation menu followed by
the Flight Failures menu item, and then the Frequency menu item. This brings up a
sub-menu as shown in the screen below. Once the sub-menu is visible, simply mouse
click on one of the options in the pull-down menu.

Aircraft  E

Recordings Training View Help

Select Scenario...
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Select Controller...

Physics...

Graphics...
Flight Failures > Frequency
Setup Failures > Enable > Often
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Export >
Manage User Files...

CauseFlight Failure  F Rl
v  Never

Mute/Unmute Audio M

Settings...

Capture Screenshot Tab
~  Show Title Bar

Exit

Flight Modes X
® SAFE: Beginner

If you do not wish to experience any flight failures, click the Never option in the drop-
down menu or, if you wish to gain a great deal of experience at handling
emergencies, click the Always option.
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Selecting the Type of Flight Failures-

RealFlight allows you to determine the type of flight failures that you will experience
within the simulation. To do so, click the Simulation menu followed by the Flight
Failures menu item. Next, select Enable to bring forth the list of available flight
failures. If an item has a check mark next to it, then that flight failure is enabled. To
toggle the flight failure, click on it with the mouse.
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The options for Flight Failures consist of:

e All-The simulation will utilize all applicable flight failures. This means that the
engine might die, the aircraft could experience a structural failure, and so on.

e Kill Engine - The engine will fail or quit in flight, which means that you will
have to perform a deadstick landing or autorotation.

e Kill Tail Rotor (heli only) — This failure will cause the tail rotor of the heli to
stop functioning during flight.

e Radio Interference (FM) - The receiver will experience intermittent radio
interference during which the servos will behave erratically.

e Radio Lockout (PCM) - The receiver will experience intermittent radio
dropouts during which the aircraft will fail to respond to control inputs.
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e Radio Range - The receiver will experience interference proportional to the
distance between the pilot and the aircraft. If the aircraft is close to the pilot’s
position, the range problems will be minimal, increasing as the aircraft gets
farther away.

e Servo Stuck - A servo will become fixed, or stuck, in a certain position.

e Structural Integrity — This failure determines how strong the aircraft is and if
parts could break off during flight.

e None- No flight failures are activated.
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Notify -

This setting allows you to determine if, or when, RealFlight notifies you as to the
flight failure experienced.
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~  Show Title Bar

Exit
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To adjust the settings of this feature, click on the value as indicated in the column to
the right of the Notify indicator. Your options are:

e After Flight - RealFlight will advise you as to the flight failure experienced
upon the completion of the flight.

e Before Flight - RealFlight will inform you which flight failure you are about to
experience before the flight begins.

e Never - RealFlight 9.5 will never advise you as to the flight failure that you
have experienced, or are about to experience. A little mystery is a good thing.

e On Failure - RealFlight will inform you of the flight failure just as it occurs.
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ﬂ Cause Flight Failure-
This feature causes a flight failure to occur on command. To access this menu item,
click on the Simulation menu, and then click on the Cause Flight Failure menu item.

Alternatively, pressing the ‘F’ key on the keyboard will also initiate a flight failure.
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Setup Failures

Setup Failures are basic difficulties that, generally speaking, should be detected before you
ever leave the ground. However, they are often overlooked and occur as a result of a hurried
modeler. RealFlight 9.5 allows you to familiarize yourself with, and determine the types of,
setup failures that you will face, as well as how often these failures will occur.

Adjust the Rate of Occurrence-

To reduce the frequency of flight failures, click on the Simulation menu followed by
the Setup Failures menu item, and then the Frequency menu item. This brings up a
sub-menu as shown in the screen below. Once the sub-menu is visible, simply mouse
click on one of the options in the pull-down menu.

If you do not wish to experience any setup failures, click the Never option in the
drop-down menu or, if you wish to gain a great deal of experience at handling
emergencies, click the Always option.
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Selecting the Type of Flight Failures-

RealFlight allows you to determine the type of setup failures that you will experience
within the simulation. To do so, click the Simulation menu followed by the Setup
Failures menu item. Next, select Enable to bring forth the list of available setup
failures. If an item has a check mark next to it, then that failure is enabled. To toggle
the flight failure, click on it with the mouse.
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The options for Flight Failures consist of:

e All-Selecting this option will engage all of the setup failures on the list meaning
that you could experience all of these possibilities accordingly.

e Swapped Channel - This failure simulates the effect of inadvertently swapping
two channels. For example, you may find that your rudder controls the throttle,
and vice versa.

e Reversed Channel - One of the channels, selected at random, will operate in a
reversed direction.

e Reversed Servo - The travel direction of one of your servos is reversed.
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e Servo Trim - A servo alters the trim settings, modifying the flight control position.
For example, the elevator servo trim might be slightly off causing the airplane to
ascend or descend when it should be flying level.

e Servo Slop - Servo slop may be the result of improper geometry of the linkages or
the looseness of the servo gears.

e Servo Hysteresis - The time or gap between a servo input from the pilot and the
movement of the servo on the aircraft.
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Notify -

This setting allows you to determine if, or when, RealFlight notifies you as to the
setup failure experienced.
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To adjust the settings of this feature, click on the value as indicated in the column to
the right of the Notify When indicator. Your options are:

e Never - RealFlight will never advise you as to the flight failure that you have
experienced, or are about to experience. A little mystery is a good thing.

e On Reset - RealFlight will inform you of the failure when you reset the flight
(hitting the spacebar or Reset button on the controller).
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m Cause Setup Failure-

This feature causes a setup failure to occur on command. To access this menu item,
click on the Simulation menu, and then click on the Cause Setup Failure menu item.
Alternatively, you may also simultaneously press the Control and Spacebar keys
accordingly.
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Import

The Import menu item allows you to import content created by other users. There are
several types of files that are associated with RealFlight. Each of these file types will be
covered in the section that follows.
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KEX-

Knife Edge Software has created a plug-in, or software module, that functions with
popular 3D modeling tools to create subject matter for the RealFlight software.

The KEX importer is used to bring the model from the plug-in into the simulation
itself.

For more information, see: www.knifeedge.com/KEmax/

Motor Sound Profile-

RealFlight allows you to import your own unique sounds for motors that might not
already exist in the simulator. By recording the sound of the motor at different RPMs
and importing these recordings into RealFlight, the simulator is able to blend these
sound files throughout the entire operating range of the motor.

Raw Panoramic Image-

This file type refers to the panoramic image that helps generate the PhotoField flying
sites. This option allows you to create a PhotoField using a panoramic image that you
may have downloaded or created yourself. It works best with large images
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(8000x4000 or larger) that are equirectangular, spanning 360 degrees horizontal by
180 degrees vertical. Click on the Raw Panoramic Image... selection to import an
image into the simulation. Browse to the location of the image you would like to
import. The image may be in any of the bitmap (.bmp), targa (.tga) or a JPEG (.jpg) file
formats.

Once you have located the desired image, double-click the image. Select this image
and click Open. The conversion process can take several minutes for large images.
When the process is complete, RealFlight 9.5 will automatically create a new
PhotoField airport that uses your newly imported image.

To edit the new PhotoField airport (for image alignment, object placement, etc.),
access the Airport Editor by clicking the Environment menu, followed by the Create
New Airport... menu item. To see the image from the pilot’s perspective, refer to the
Pilot Spawn window. Doing so will make it easier to place objects and adjust the
image correctly as this will be the location for which most flights will be viewed
accordingly. If necessary, adjust the image using the Panoramic Image Y Alignment,
Panoramic Image X Alignment and/or the Panoramic Image Facing options located in
the Properties window.

RealFlight Archive (RFX, G3X)-

RFX is the file extension that is used for all files exported from RealFlight G4 or later
versions. This menu option allows you to import an RFX file. You will use this for all
files that you have downloaded. There is nothing special you need to know about the
file beforehand; the RFX importer handles all types of content, including: planes,
aircraft, color schemes, airports, PhotoFields, and recordings.

This menu item also allows you to import the G3X files that were used in the
RealFlight G3 and G3.5 software iterations.

After choosing the Import menu item, followed by the RealFlight Archive (RFX, G3X),
you will be presented with an Open file dialog. Use this dialog to find the file that you
want to import. Double-click the file or click the file and click Open. The import
process will start immediately and once it’s finished you will see a message
confirming its success.
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Export

The Export menu item allows you to share user-created content. It is provided in the
Simulation menu as a shortcut to using the Manage User Files dialog.
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RealFlight users may share the following items: Color Scheme, Aircraft Variant, Entire
Aircraft, Airport and Panoramic Images. If one or more of these options on the list is grayed
out, it is because the currently loaded color scheme, aircraft, or airport is part of the
simulation by default and not available for export. That is, only custom content creations
may be exported accordingly.

Once any of these items are exported, you can then share them with friends or the rest of
the RealFlight community. The best choice is to upload the files to the RealFlight swap site
found at:

http://swappages.knifeedge.com/

Color Scheme-

This option allows you to share the current aircraft color scheme (a.k.a. trim scheme)
with other RealFlight users.
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To export a Color Scheme, select the Export menu item followed by the Color
Scheme option. A save dialog will appear so that you can choose where you would
like to save the exported color scheme and determine the filename. After saving, a
message will appear on-screen advising you whether or not the export was
successful. This message will also list the location and name of the file that was
exported.

Aircraft Variant-

This option enables you to export an aircraft that has undergone structural
modifications such as lengthened wing span, more prop thrust, different airfoils, etc.
It is important to note in addition to any wire frame modifications, the Aircraft
Variant file option also includes any modifications to the aircraft powerplant,
batteries, etc.

To export an aircraft variant, select the Export menu item, followed by the Aircraft
Variant option. A save dialog will appear so that you can choose where you would
like to save the exported aircraft variant and determine the filename. A verification
message will appear on-screen advising you whether or not the export was
successful. This message will also list the location and name of the file that was
exported.

Entire Aircraft-

This option enables you to export the entire contents of an aircraft such as trim
scheme, structural changes, etc.

To do so, select the Export menu item followed by the Entire Aircraft option. A save
dialog will appear so that you can choose where you would like to save the exported
aircraft and determine the filename. A verification message will appear on-screen
advising you whether or not the export was successful. This message will also list the
location and name of the file that was exported.

Airport-

This option enables you to export a modified airport. Note that any custom
panoramic image you may be using with this airport will not be exported. To export
an airport with a custom panoramic image, use the “Airport (include Panoramic
Image)” option.

To export an airport, select the Export menu item followed by the Airport option. A
save dialog will appear so that you can choose where you would like to save the
exported airport and determine the filename. After saving, a verification message will
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appear on-screen advising you whether or not the export was successful. This
message will also list the location and name of the file that was exported.

Airport (include Panoramic Image)-

This option enables you to export an airport along with its custom panoramic image.
To do so, select the Export menu item followed by the Airport (include Panoramic
Image) option. A save dialog will appear which allows you to choose where you want
to export the airport and what you want to name the file. A verification message will
appear on-screen advising you whether or not the export was successful. This
message will also list the location and name of the file that was exported.

Manage User Files

The Manage User Files menu item allows you to modify the new user content that you have
added to the simulation. You will find that the Manage User Files menu item is a handy tool;
it maintains all such files in one, easy to find location.
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The Manage User Files dialog allows you to copy, rename, delete, or export any
custom resource that exists in the simulation. It is important to note that the various
Manage User Files buttons will be inactive until a modification to one of the files
exists. That is, this menu item is only utilized to modify user-created items. It will not
allow you to modify any of the default airports or vehicles included in the RealFlight
9.5 software.

Copy-

This option duplicates the information and data pertaining to the currently selected
item. For example, if you wish to duplicate a flying site located in the User Files, click
the Copy button. Once you have copied the file, enter a name for the new item.

Rename-

This option is utilized to rename an existing user-created item.

To do so, highlight the desired item (flying site, etc.) and click Rename. Enter the
desired name for the item in the dialog provided. The item will now appear in its
respective list of offerings with the new name. Please note that this new name
replaces the previously existing named item. That is, only the newly named item will
appear on the list.

Delete-

This option is utilized to delete an item entirely. All files associated with the item will
be removed from your computer.

It’s important to note that users are only allowed to delete items which they, or
other users, have created. You cannot delete default items that are included in the
software.

To delete a user-created item, select the item in the User File menu and click Delete.
If you wish to delete this item, click OK in the verification dialog. Please note: once
deleted, this resource will no longer be available in the simulation.

Export-

This button is used to export the custom content to a file that can be shared with
others. If you have created interesting or unusual content, we encourage you to
share your designs with other RealFlight users. The more content that is shared, the
more enjoyment everyone will experience.
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To export a user-created item, select the respective item in the User File menus and
click Export. A verification dialog will appear on-screen advising you whether or not

the export was successful, and the location and name of the file that was exported.

You may then publish the exported file to a web site, move it to another computer,

or email it for others to enjoy.

Close-

This button, as the name suggests, is used to close the Manage User Files dialog box
after all desired refinements have been completed.
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m Mute/Unmute Audio

At times, you may want to fly without any sound. Choose this menu item to mute the audio.

Select it again to activate the sounds. Alternatively, pressing the ‘M’ key on the keyboard will
also toggle between the mute/unmute audio selections.
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Settings

The Settings option is an integral part of the RealFlight 9.5 software. This menu item allows
you to adjust a multitude of features and functions within the simulation.
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To access this menu item, click on the Simulation menu followed by the Settings... menu
item. The Settings dialog will appear, showing the available options.

Settings

Settings Parameter Value
[#- Audio

Camera

-- Challenges

[H- Console

- Controller

[H- Graphics

-- Heads-Up Display

- Language

- Multiplayer

- Physics
Rewind
Safety Alerts

- Virtual Reality
Wind

| OK I Cancel
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Audio-

The Audio settings allow you to adjust the volume levels for the aircraft and various options
in the simulation. For each type of sound that is adjustable, there are two parameters that
can be changed. First is the Volume, which is a percentage of the Overall Volume. The second
is whether the sound should be enabled or muted. Double-click on the Audio name, or click
on the [+] (plus) to expand the list and show the Audio options.

Settings

- [

- Camera

- Challenges
[+ Consaole

- Controller

[+ Graphics

- Heads-p Display
- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts
- Virtual Reality
- Wind

Parameter Value

QOverall Volume (%) 100
Sound Enabled Mo

Cancel

Overall Volume (%)-

This parameter, found when the Audio setting is selected, controls the volume for all
sounds in RealFlight.

Sound Enabled-

This will mute or unmute all sounds in RealFlight. Alternatively, you may select the
Mute/Unmute Audio menu item from the Simulation menu, or simply press M on
the keyboard to toggle this setting on or off.
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Application Sounds-

The Application Sounds section controls the effects and voiceover sounds in the
simulation.

Settings Parameter Value
= Audio

[ Application Sounds Effects Volume (%) 85

‘. Simulation Sounds Effects Enabled Yes
. Camera Voiceover Volume (%) 85
- Challenges Voiceover Sounds Enabled Yes

- Console

- Controller

- Graphics

- Heads-Up Display
- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts
- irtual Reality
- Wind

fra)
(5=}

fra)
(5=}

Cancel

e Effects Volume (%) - This setting adjusts the master volume level for sounds,
except all voiceovers.

e Effects Enabled - Choosing No for this option will mute all sounds for the
simulator except for the voiceovers.

e Voiceover Volume (%) — This setting adjusts the volume level for the voice chat
during multiplayer sessions.

e Voiceover Sounds Enabled - Choosing No for this option will mute all sounds for
the voiceovers, etc. in the simulator.
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Simulation Sounds-

The Simulation Sounds section controls the various options related to the
miscellaneous sounds in the simulation. RealFlight allows you to make modifications
to the various sounds based upon your preferences.

S:ath'ngs_ Parameter Value
= Ayd:ppliaﬁon Sounds Aircraft Volume (%6) &5
imulation Sounds Aircraft Sounds Enabled  Yes

- Camera Airport Volume (%) a5
.. Challenges Airport Sounds Enabled  Yes

- Console Callision Velume (36) 85
- Controller Collision Sounds Enabled Yes

[+- Graphics Engine Volume (%) a5
- Heads-Up Display Engine Sounds Enabled  Yes
- Language Servo Volume (%) 35
- Multiplayer Servo Sounds Enabled  Yes
-~ Physics Walk Volume (%) 85
- Rewind Walk Sounds Enabled  Yes
-~ Safety Alerts Wind Volume (%) 85
- Virtual Reality Wind Sounds Enabled  Yes
- Wind

Cancel

For each type of sound that is adjustable, there are two parameters that can be
changed. First is the Volume, which is a percentage of the overall volume. The second
is whether the sound should be enabled or muted.

The different sound types are:
e Aircraft — aircraft-related sounds, such as servos.
e Airport —the ambient sounds around the airport.
e Collision —the crashing sounds associated with collisions.
e Engine —the motor and engine sounds.
e Servo — controls the sounds of all the servo motors.
e Walk —the walking sound when moving the camera position.

e Wind —the sound produced by the wind.
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Camera-

The camera options are designed to enhance the field of view when utilizing the Keep
Ground in View zoom mode. For additional information on this option, please refer to the
View menu chapter of this manual.

Sn:attings_ Parameter Value
H Afi:pplicaﬁon Sounds Minimum Field of View {deg) 30
‘.. Simulation Sounds Padlock View Mo
Camera Lag {%:) a0
- Challenges Invert Mouse Mo
[+- Console Chase Camera Distance {m) 6.1
- Contraller
(- Graphics
- Heads-Up Display
- Language
- Multiplayer
- Physics
- Rewind
- Safety Alerts
- Vfirtual Reality
- Wind

Cancel

Minimum Field of View (deg)-

This setting determines the absolute minimum field of view when utilizing the Keep
Ground in View zoom option.

To adjust the minimum field of view, click the existing value. Next, enter the desired
value either directly from the keyboard or via the mouse wheel.

Padlock View-

With Padlock View enabled, the cockpit camera position will swivel and follow the
targeted aircraft during multiplayer combat events. It is not applicable outside of the
multiplayer combat events.

Camera Lag (%)-

This controls how quickly the camera reacts to the aircraft’'s movements. If the lag is
set to zero, the camera always looks directly at the aircraft. At all other values, the
camera will have a spring-like reaction to the aircraft during flight.
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At very high values, the camera hardly ever looks directly at the aircraft, and often
the aircraft will fly off the screen as the camera tries to catch up. At lower values, the
effect is very subtle and yet still softens the camera movement enough so that minor
changes in the aircraft’s speed/position are more noticeable.

Please note: these settings apply to the “Fixed View” camera mode only. They are
not applicable to the cockpit, chase, or onboard views.

Invert Mouse-

Setting this parameter to Yes will invert the vertical, or up/down movement of the
mouse when you are in walk mode.

Chase Camera Distance (ft)-

This parameter allows you to adjust the distance which the Chase Camera will follow
the aircraft from behind. Adjusting this value may assist you in Challenges like
Balloon Burst.

Challenges-

The Challenges dialog determines whether or not to show ‘ghost’ runs during challenges. By
default, RealFlight will indeed show the ghosted images of the best times within a Challenge. If
you don’t wish to see this image onscreen, simply select ‘No’ from the drop-down menu.

Settings Parameter Value
[ Audio

- Camera

- Console

- Controller

[#- Graphics

- Heads-Up Display
- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts
- Virtual Reality
- Wind

Show Ghost Runs Yes

fral
(5=}

IMPORTANT: This setting will not take effect until the ghost runs featureis &
unlocked. Complete ten different challenge levels to unlock it.

A ghost run is a recording of your best run for a particular challenge level.
Each level can have one ghost run. When this setting is enabled, starting a
level plays back its ghost (if one exists).

RealFlight automatically creates a ghost run whenever you set a new best

tima  Thiz sattinn anlu Fantrale alavhede
Conce
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Console-

The Console option has a number of sub-categories that allow you to perform modifications
to the messages that appear on-screen while running the simulator. It also offers two
parameters that affect all of the sub-categories.

Settings X

Settings Parameter Value
(- Audio

- Camera

- Challenges
£33
- Contraller

[+- Graphics

- Heads-Up Display
- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

- Wind

Show AtMost 5
Clear On Reset No

Cancel

Show At Most-

This numerical value indicates the maximum number of messages that will appear on
your screen at any given time. When the maximum number is surpassed, an older
message will be removed and the most recent message will take its place on-screen.
RealFlight defaults to five as the maximum number. Our testing indicates that this
number of messages will not detract users from their flight. It is possible to increase
this number to 100, although the screen becomes very busy.

Clear on Reset-

This setting controls whether all of the on-screen messages are cleared when the
aircraft resets. This prevents the screen from becoming cluttered with messages and
information.

Using either the mouse or the up/down arrow keys on the keyboard, select Yes
(messages automatically clear) or No (messages remain on-screen after a reset) from
the pull-down listings. If using the up/down arrow keys, press Enter to finalize your
selection.
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Double-clicking on the Console name or clicking on the [+] (plus) will bring forth the
following options:

e [nstructions

¢ Noatifications

e Warnings

e Errors

e Chat Messages (Sent)

e Chat messages (Received)
e Commands

Each of the System Messages screens is independently adjustable and may be
tailored to suit your personal preferences. For information on how to do so, please
read the following section.
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Instructions-

This option determines the settings for the system Instructions messages. To select
the Instructions options, click on the Instructions name.

Settings Parameter Value
[+ Audio .
Font Size 22
- Camera
- Challenges Fareground Coler r=255 g=255 b=255
[ Console Background Calor

Background Alpha (%) 75

Motifications Message Duration (sec) 10

Warnings Enabled Yes

Errors

Chat Messages (Sent)

i--Chat Messages (Received)
‘.. Commands

- Controller

[+- Graphics

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

- Wind

Cancel

Font Size-

This option allows you to adjust the font size for the messages pertaining to
the instructions. Please note: this only affects the Instructions. It does not
affect any other system messages.

To access the Font Size options, click on the value shown in the respective
column. The desired values may be input directly from the keyboard or
modified using the mouse wheel. The default value of the font size is 22. The
simulation allows a minimum font size of 8 and a maximum size of 80.
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Foreground Color-

This option allows the user to adjust the color of the foreground for the
Instructions messages.

To access the color palette options for the foreground color, click on the
current value, then click the more options button that appears to the right
(the gray button with the ellipsis). This will reveal a screen that appears as
follows:

Color

Basic colors:

X

EEENTT

177 FHAEEENE
1T HEEENT
177 TTHEEER

Define Custom Colors ==

Cancel

To select a color, click the desired color on the palette. If you wish to make a
custom color, click the Define Custom Colors button and create the color or
colors to suit your tastes. Click OK to finalize the selection. The selected color
will be reflected immediately in the value column.

Background Color-

This setting allows you to adjust the color of the background for the
Instructions messages.

To access the options pertaining to the background color, click on the current
displayed color.

To access the color palette for the background color, click on the current
displayed color, then click the more options button that appears to the right
(the gray button with the ellipsis). To select a color, click the desired color on
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the palette. If you wish to make a custom color, click the Define Custom
Colors button and create the color or colors to suit your tastes. Click OK to
finalize the selection. The selected color will be reflected immediately in the
value column.

Background Alpha (%)-

This option adjusts the transparency of the text background for the message.

The desired values may be input directly from the keyboard or modified using
the mouse wheel. The higher the value, the more transparent the text
background will become.

Message Duration (sec)-

This option adjusts the length of time that a message remains on-screen
before it disappears.

You may input desired values directly from the keyboard or modify them
using the mouse wheel. The higher the value, the longer the message
remains on-screen. The default setting is 10 seconds, however, the value
may be refined to allow the message to disappear immediately after it is
displayed. Additionally, the setting may be adjusted to 600 seconds (10
minutes), if so desired.

Enabled-

This option determines whether Instructions messages are displayed or not.

To determine whether this is enabled, click on the respective value indicator.
Using either the up/down arrow keys on the keyboard, or the mouse, select
either Yes (Instructions messages are enabled) or No (Instructions messages
are disabled) from the pull-down listings. If using the up/down arrow keys,
press Enter to finalize your selection.
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Notifications-

This option determines the settings for the system Notifications messages.

Settings Parameter value
[ Audio .
Font Size 22
- Camera .
- Challenges Foreground Color
[+ Console Background Calor

... Instructions Background Alpha (%) 75

Jotifications Message Duration {sec) 10
Warnings Enabled Yes

hat Messages (Sent)

i Chat Messages (Received)
.. Commands

- Contraller

- Graphics

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Vfirtual Reality

- Wind

frml
1

cance

These options function in the same manner as the options for the Instructions
messages, except that they only affect the Notification messages.
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Warnings-

This option determines the settings for the system Warning messages.

Settings Parameter value
[ Audio .
Font Size 22
- Camera .
- Challenges Foreground Color
- Background Calor
i Background Alpha (%) 75

Message Duration (sec) 10
Enabled Yes

|
(1)

hat Messages (Sent)

i Chat Messages (Received)
.. Commands

- Contraller

- Graphics

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Wirtual Reality

- Wind

frml
1

cance

These options function in the same manner as the options for the Instructions
messages, except that they only affect Warning messages.
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Errors-

This option allows you to modify the behavior of the system error messages.

Settings Parameter Value
(- Audio .
. Camera Font Size 22
- Challenges Foreground Color
= Console Background Calor
- Instructions Background Alpha (%) 75

i.. Notifications Message Duration {sec) 10
Warnings Enabled Yes

hat Messages (Sent)

i--Chat Messages (Received)
. Commands

- Controller

- Graphics

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

- Wind

fral
(5=}

Cancel

These options function in the same manner as the options for the Instructions
messages, except that they only affect Error messages.
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Chat Messages (Sent)-

This option allows you to modify the appearance of text that you type for chat
messages during multiplayer sessions.

Settings Parameter Value
[+ Audio )
- Camera Font Size 22
- Challenges Foreground Color r=0 g=255b=255
- Console Background Color
- Instructions Background Alpha {%) 75

Message Duration (sec) 10
Enabled Yes

Chat Messages (Sent)

i--Chat Messages (Received)
b Commands

- Controller

[ Graphics

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- \firtual Reality

- Wind

Cancel

These options function in the same manner as the options for the Instructions
messages, except that they only affect Chat Messages (Sent) messages sent during
multiplayer sessions/events.
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Chat Messages (Received)-

This option allows you to modify the appearance of text you receive from other
players during multiplayer sessions.

Settings

Parameter value
[+ Audio )
- Camera Font Size 22
= Console Background Calor
- Instructions Background Alpha (%) 75
Message Duration (sec) 10
Enabled Yes
Flay Sound Yes

- Controller

[+- Graphics

- Heads-Up Display
- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- \firtual Reality

- Wind

Cancel

These options function in the same way as the options for the Instructions messages,
except that they only affect Chat Messages (Received) messages.

There is one additional parameter available for this option called Play Sound. This
allows you to set whether or not a sound is heard when an incoming chat message
arrives.

To determine whether this is enabled, click on the respective value indictor. Using
either the up/down arrows on the keyboard, or the mouse, select either Yes (audio
indication is played when a chat message is received), or No (no audio indication is
played when a chat message is received). If using the up/down arrow keys, press
Enter to finalize the selection.
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Commands-

This option allows you to modify the appearance of commands typed in the console

screen.
Settings X
Settings Parameter Value
[+ Audio )
Font Size 22
- Camera
- Challenges Foreground Color r=255g=255b=0
£ Console Background Color
Instructions Background Alpha (%) 75
& Notifications
Warnings
- Errors

i Chat Messages (Sent)
Chat Messages (Received)
- Controller

[+ Graphics

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

- Wind

Cancel

These options function in the same manner as the options for the Instructions
messages, except that they only affect Commands messages.
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Controller-

This option allows you to modify/determine the deadband percentage of the
controller inputs. This is important and applicable for anyone that is not using a
RealFlight controller (InterLink, Spektrum WS2000 Wireless Simulator Dongle, Wired
Interface or SLT Wireless Interface).

Pilots using one of the aforementioned control methodologies will most likely want
to retain the default value (0).

Allowing refinements to the deadband on the stick inputs is helpful for pilots using a
gamepad controller or joystick to pilot RealFlight. We encourage these users to
experiment with different percentages until the aircraft responds as desired when a
control input is given.

Settings Parameter Value

[+- Audio
- Camera Deadband Percentage (%) 10

- Challenges
[+ Console
i Instructions

- Notifications

Warnings

Errors

Chat Messages (Sent)
Chat Messages (Received)
‘.. Commands

[+ Graphics

- Heads-Up Display
- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

- Wind

Cancel
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Graphics-

Double-click on the Graphics name or click on the [+] (plus) to expand the menu and display
the various Graphics options.

Quality-

The Quality options are quite useful in fine-tuning your simulator, to ensure that it
runs as efficiently and realistically as possible on your PC. Use the settings in the
Graphics options to obtain the perfect blend of optimal visuals and performance
from your PC. If you are experiencing slow frame rates or other performance issues,
it may be prudent to turn down some graphics quality options.

Settings_ Parameter Value 2
- Audio Clouds Yes
- Camera
.. Challenges Partides Yes
- Consale Scenery Objects Yes
. Instructions Shadows Enabled Yes
Motifications Soft Shadows Enabled No
Terrain Detail Yes
Trees fes
Chat Messages (Sent) Wind Field Indicators Yes
Chat Messages (Received) Post-processing: Bloom Mo
- Commands Post-processing: Might Flying Glow  Yes
- Contraller Post-processing: Depth of Field ~ None
= Graphics Foliage Density (%) 5
Mormal Maps Mo
Harduare Water Quality Medium
~ Heads-Up Display Water Partide Quality Medium ¥
- Language
- Multiplayer
- Physics
- Rewind
- Safety Alerts
- Virtual Reality
- Wind

Cancel

Please note: Many of the adjustments will not take place immediately. In many cases,
you will need to restart the simulator in order for the selection(s) to take effect.
Clouds-
This option determines whether your flying sites will include clouds in the

skyline.

Click on the respective value indicator. From the pull-down options select
either Yes (clouds will be present) or No (clouds will not be present).

Please note: This setting will not affect the presence of clouds in the
PhotoField airports.
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Particles-

This option determines whether RealFlight will utilize particles such as engine
smoke.

Click on the respective value indicator. From the pull-down options select
either Yes (RealFlight will display smoke), or No (RealFlight will not display
smoke).

Scenery Objects-

This option determines whether the simulation displays background objects
such as buildings, rocks, benches, etc. If Yes is selected, the background
objects will be present. If No, the background objects will not appear in the
simulation.

To change this setting, first click on the respective value indicator. From the
pull-down options select either Yes or No.

Please note: This setting will not affect the presence of scenery objects that
are part of the high-resolution digital image in the PhotoField airports.

Shadows Enabled-

The Shadows option determines whether the simulation displays shadows.

To change the Shadows setting, click the value located to the right of the
Shadows name. Next, click Yes to display the shadows, or No to hide the
shadows.

Soft Shadows Enabled-

This option determines whether or not RealFlight displays softer, more
realistic appearing shadows.

Enabling this option offers a more realistic appearance within the simulation
but may adversely impact performance. If you notice a poor frame rate while
running RealFlight, try turning off this option by selecting No.

Terrain Detail-

This option determines whether or not RealFlight displays the details found in
the textures associated with the terrain.
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Modify the Terrain Detail setting by clicking on the value located to the right
of the Terrain Detail name. Click Yes to display the terrain detail texture or
No, to eliminate the terrain details.

Please note: This setting will not affect the terrain detail in the PhotoField
airports.

Trees-

The Trees setting determines whether or not RealFlight will display trees.

To change the Trees setting, click the value located to the right of the Trees.
Select No, if you do not wish to display the trees in your simulation. If you
wish to view the trees during flight, select Yes.

Please note: This setting will not affect the presence of trees that are part of
the high-resolution digital image in the PhotoField airports.

Wind Field Indicators-

This parameter determines whether or not RealFlight displays the wind field
indicators that are present at select airports.

Post-processing: Bloom-

The Bloom effect will cause lighter colors or lights to bleed into neighboring
parts, enhancing their perceived brightness.

Please note: Enabling the Post-Processing: Bloom effect may adversely
impact performance. If you notice a poor frame rate while running RealFlight,
try turning this option to No.

Post-processing: Night Flying Glow-

This option affects whether lights for night flying glow, causing the objects to
appear brighter.

Please note: Enabling the Post-Processing: Night Flying Glow effect may
adversely impact performance. If you notice a poor frame rate while running
RealFlight, try turning this option to No.

Post-processing: Depth of Field-

This option affects the strength of the depth-of-field effect. A stronger effect
will cause out of focus objects to appear more blurry — great for screen shots.
Some pilots will prefer to turn this setting lower for actual flight.
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The RealFlight 9.5 program defaults to None, indicating that the objects in the
background will not be as blurry. We suggest experimenting with the
settings to achieve the desired impact.

Foliage Density (%)-

This setting determines the density and drawing time of the trees and the
grass. Lowering the percentage will ensure that the scenery is drawn faster.
Again, if you are experiencing low frame rates, lowering this value will speed
up the simulation.

To adjust the percentage, click on the value located to the right of the Foliage
Density (%) name. Enter the desired input directly from your keyboard, or use
the mouse wheel to adjust accordingly.

Normal Maps-

Normal Maps add increased details to aircraft and objects without a large
increase in video card processing. Normal Maps are part of the Real
Rendering feature in RealFlight.

RealFlight 9.5 defaults to No, however, to ensure that the simulation renders
rapidly. If your frame rate is fast, we suggest refining this value to Yes, to add
increased detail within the simulation.

Water Quality-

This setting specifies the quality of the water in the simulation. To modify the
quality of the water, click on the value indicated in the column to the right of
the Water name. Select the desired level for your simulation from the pull-
down list.

The Highest setting will render the best water, but it requires additional
processing power. If your frame rate is low, we suggest reducing the water
quality until optimal frame rate is achieved.

Water Particle Quality-

This setting controls the different type of graphical particles related to water.
A Low setting turns off all water particle effects while a High setting will show
wakes, splashes, and ripple effects. RealFlight defaults to Medium. If your
frame rate is high, we suggest refining this to the High setting to add realism
to the simulation. Conversely, if your PC frame rates are lower than what
you'd like, please select Low to improve frame rates accordingly.
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Water Shadow Quality-

Turning this setting On, will show shadows on the surface of the water as well
as on the surface beneath the water for a more realistic appearance. It does
increase the demands on the video card though. As such, the setting is
defaulted to Off.

Shadow Quality-

This setting specifies the quality of the shadows in the simulation as well as
how often the shadows are updated. To modify the quality of the shadows,
click on the value indicated in the column to the right of the Shadows name.
Select the desired level for your simulation from the pull-down list. The
Highest setting will render the best shadows, but it requires additional
processing power. If your frame rate is low, we suggest you reduce the
shadow quality accordingly.

Shadow Map Quality-

Shadow Map Quality setting controls the size of the shadow texture. A larger
size texture will show more detail for a more realistic appearance. A higher
setting improves the look of the shadows as well as the drawing distance for
shadows, but requires additional processing power. If your frame rate is low,
try reducing the shadow map quality.

Particle Quality-

This setting adjusts the quality of the smoke, debris and other small objects
during the simulation. If the frame rate drops when the smoke is thick, try
lowering the particle quality selection until you achieve an acceptable frame
rate.

To do so, click on the existing particle quality. Next, from the pull-down
menu, select the desired quality level.

Screenshot Quality-

This setting adjusts the quality of the screenshots. At a low quality, all
screenshots are saved as JPG files. If the quality is set to high, screenshots are
saved as BMP files.

To change this setting, click on the existing screenshot quality level. Next,
from the pull-down menu, select the desired quality level.
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Streamer Quality-

This setting adjusts the quality of the streamers during the simulation. If the
frame rate drops when flying an aircraft with streamers, try lowering the
quality of the streamers until you achieve an acceptable frame rate.

To do so, click on the existing streamer quality level. Next, from the pull-
down menu, select the desired quality level.

Texture Quality-

Use this setting to add the realistic textures to the items and various other
objects found in the simulation.

To do so, click on the existing texture quality level. Next, from the pull-down

menu, select the desired quality option. Generally speaking, if the dedicated
video memory of your graphics card meets, or exceeds, 128Mb it is possible

to increase the quality of the textures to the highest setting.

Please note: You must restart the simulation for the new setting to take
effect.

Misc. Graphics Quality-

This setting adjusts the quality level of miscellaneous items in your
simulation.

To alter the Miscellaneous Graphics level, click on the value located to the
right of the Misc. Graphics name. Next, select the desired level to utilize for
the graphics.

Please note: You must restart the simulation for the new setting to take
effect.

RealFlight 9.5 RC Flight Simulator




Hardware-

The hardware settings are used to adjust various graphics-related settings to achieve
the best possible performance for your PC.

Settings Parameter Value

[+ Audio )
- Camera Graphics Adapter MVIDIA GeForce GTX 10800
.. Challenges Graphics Device  HAL

- Console Full Screen Mo

- Instructions Resolution 1280 x 1024
Motifications Refresh Rate &0 Hz

Vertical Sync Mo

Chat Messages (Sent)

Chat Messages (Received)
i Commands

- Controller

[=- Graphics

Quality

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Vfirtual Reality

- Wind

Cancel

Graphics Adapter-

The Graphics Adapter is the device that RealFlight utilizes to run the
simulation, generically referred to as a video card. Most PC’s have only one
video card, however, some PC’s are equipped with multiple cards.

To determine if your PC has an additional video card available to you, click on
the video card information located in the values column to the right of the
Graphics Adapter name. If multiple cards appear in the drop-down selection
there is another option for you. If not, your PC is equipped with only one
video card.

Graphics Device-

Some video cards offer multiple devices. HAL (Hardware Abstraction Layer) is
the preferred device to use for the graphics rendering. In general, you should
never need to modify this setting.

To determine if your PC offers alternative devices, click on the value indicated
in the column to the right of the Graphics Device name.
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Full Screen-

This option determines whether RealFlight will run using the entire monitor
screen for the simulation. If you decide to run in the Full Screen mode,
RealFlight’s menus will not appear on the screen.

To access the menu while in Full Screen mode, press the ALT key on the
keyboard.

To adjust the Full Screen option, click on the value as indicated in the column
to the right of the Full Screen name. From the pull-down menu, select Yes to
run in Full Screen or No, to run in the Windowed mode.

Alternatively, you may access the Full Screen mode by pressing the Alt and
Enter keys simultaneously on the keyboard. To exit Full Screen mode, press
the ALT and Enter keys simultaneously.

Resolution-

This control adjusts the screen resolution and color depth when the
simulation is operating in full screen mode. This setting does not impact the
resolution when running in a windowed mode. If your frame rate is
unacceptably low, you can improve it by reducing the resolution or color
depth. This will reduce some of the rendering processes required of your
video card.

To adjust the resolution for your simulation, click the value indicated in the
column to the right of the Resolution name. Select the desired level for your
simulation from the drop-down list.

Again, please note: This option is only effective when using RealFlight in the
Full Screen mode.

We suggest that you test a variety of resolutions and color options to achieve
the optimum performance and setup for your system.

Refresh Rate-

The refresh rate is the number of times per second that your monitor
retraces its video display. Your video hardware (monitor and graphics card)
dictates what refresh rates you are able to utilize in the simulation. As with
Resolution, this option is only effective when running RealFlight in the Full
Screen mode.
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To adjust the refresh rate, click the value that is indicated in the column to
the right of the Refresh Rate name. If there are multiple options in this list,
you might opt for a lower value to determine if this improves the frame rate
of your simulation.

Vertical Sync-

Enabling this option can create smoother motion by forcing RealFlight to limit
your frame rate to the refresh rate of your computer monitor. Vertical sync
may improve performance if you experience excessive ‘tearing’ of screen
images or regular ‘stuttering’ or ‘hitching’, especially if your average frames
per second (FPS) is above 60.

To adjust the Vertical Sync, click the respective value. Select Yes or No from
the pull-down menu that appears.

Heads-Up Display-

Heads-Up Display is a useful tool to display a variety of flight data in real time similar to an
FPV(First Person Video) system. Depending on the environment, you may wish to change the
color of the HUD.

Settings X

Settings

[+ Audio

- Camera

- Challenges

=~ Console
Instructions

Notifications

Warnings

Errors

- Commands
- Controller
[=- Graphics

e Quality

.- Hardware
- Language
- Multiplayer
- Physics
- Rewind
- Safety Alerts
- Virtual Reality
- Wind

Chat Messages (Sent)
i Chat Messages (Received)

Parameter Value

Display Color ' r=255 g=170 b=55

Cancel
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To change the color, click on the current value, then click the more options button that
appears to the right (the gray button with the ellipsis). This will reveal a screen that appears
as follows:

17T FAEAEEE
1T HEEENT
17T TTHHERER

Define Custom Colors ==

Cancel

To select a color, click the desired color on the palette. If you wish to make a custom color,
click the Define Custom Colors button and create the color or colors to suit your tastes. Click
OK to finalize the selection. The selected color will be reflected immediately in the value
column.
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Language-

If you wish to adjust the text of the menus, dialogs, etc. to a different language, you can

make that change from this setting. Please note: You must restart RealFlight for the change
to take effect.

Settings
D 2::.::@ Language English
- Challenges
- Console
Instructions
-~ Notifications
\Warnings
Errors
- Chat Messages (Sent)
- Chat Messages (Received)
- Commands
- Controller
[=- Graphics
- Quality
.-Hardware
- Heads-Up Display
- Multiplayer
- Physics
- Rewind
- Safety Alerts
- Virtual Reality
- Wind

Parameter  Value

Cancel

To select an alternate language, click the respective value, select the language preference
from the drop-down list that appears.
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Settings Parameter  Value
- Audio
- Camera Language | English hiid
- Challenges English
- Console Frendh
- Instructions Italian

- Motifications Spanish
- Warnings

- Errors

- Chat Messages (Sent)

- Chat Messages (Received)
- Commands

- Controller

[=- Graphics

- Quality

-~ Hardware

- Heads-Up Display

- Language

- Multiplayer The language RealFlight will use for all of its menus and dialogs.
You must restart the simulation for this setting to take effect.

- Physics
- Rewind
- Safety Alerts
- Virtual Reality Default: English
- Wind

This setting also controls the language for the RealFlight Launcher.

Cancel

Multiplayer-

Settings available here affect multiplayer parameters and split screen MultiMode.

Settings Parameter Value
(- Audio . ]
. Camera Multimode Screen Layout Horizontal
- Challenges Base Internet Port 51234
= Console Announce Aircraft Changes Mo
i Inetructions Cloge Chat Gadget After Sending Mo
- Motifications Post-game Cooldown Duration (sec) 30
- Warnings Preferred First-person Camera Cockpit
- Errors Simulation Sound Reduction (%) 15
- Chat Messages (Sent) Auto-targeting Mode Smart
- Chat Messages (Received)
Commands
- Controller
E_j..
- Heads-Up Display
- Language
- Physics
- Rewind
- Safety Alerts
- Virtual Reality
- Wind

Cancel
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MultiMode Screen Layout-

This setting specifies the layout of the screen for the MultiMode option. If you select
Vertical, the computer screen will split in half on its vertical axis. If you select
Horizontal, the computer screen will split in half on the horizontal axis.

To select which mode best suits your tastes, click on the value displayed to the right
of the MultiMode Screen Layout column. Next, select either Horizontal or Vertical
from the pull-down options.

Base Internet Port-

To access multiplayer sessions with other pilots over the internet, RealFlight utilizes
eight ports on your internet connection. By default, RealFlight is set up to use 61234
to 61241. You can change this range by setting the base port numeric value
RealFlight will use the next seven ports.

Settings Parameter Value
(- Audio )
. Camera Multimode Screen Layout Horizontal ~
- Challenges Base Internet Port
- Console Announce Aircraft Changes Vertical
.. Contraller Close Chat Gadget After Sending Mo
[ Graphics Post-game Cooldown Duration (sec) 30
- Heads-Up Display Preferred First-person Camera Cockpit
- Language Simulation Sound Reduction (%) 15
- Multiplayer Auto-targeting Mode Smart
- Physics
- Rewind
- Safety Alerts
- Virtual Reality
- Wind

For multimode sessions, this determines whether the two screens will be on
top of each other (horizontal) or side by side (vertical). Changes to this
setting will not take effect until the next multimode session,

Default: Horizontal

Cancel

Please note, if you connect to the internet through a network router and/or firewall,
you may need to open these ports in order for RealFlight to connect to multiplayer
sessions. Check the user manual for your router for information on how to do so.
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Announce Aircraft Changes-

During multiplayer sessions, RealFlight 9.5 can update you with a short message
whenever another pilot switches aircraft. To view these messages, set the Announce
Aircraft Changes to Yes. Otherwise, to disable this message, set this parameter to
No.

Close Chat Gadget After Sending-

The Chat Gadget allows you to send messages in multiplayer sessions using the
keyboard. By default, this gadget remains visible when it’s enabled. If you wish for
the Chat Gadget to close after you send a message, set this parameter to Yes.

Post-game Cooldown Duration (sec)-

When running through a Game List as the Host of a multiplayer session, you may
wish to add a cooldown period between games. This allows players to review the
score of the game they just completed and to relax before the next game begins.

If you wish to start the next game immediately, select the respective value and set
the value to zero using the keyboard. Conversely, if you’d like a longer period of time
to reflect upon the results, etc. increase this number according to your preferences.

Preferred First-person Camera-

Some games allow you to change your viewpoint. Change this parameter to your
preferred camera position for use in games. Alternative perspectives offered are:
Cockpit, Nose or Tail. Simply select one of these offerings from the drop-down menu
when the respective value is selected.

Simulation Sound Reduction (%)-

If voice chat is active during multiplayer sessions, RealFlight will automatically reduce
the volume of all other simulator sounds. Change this percentage to adjust how low
simulation sounds are relative to the voice chat.

Auto-targeting Mode-

This parameter allows you to set how RealFlight chooses your target during
multiplayer events. This takes effect after each reset of the aircraft. The options
available:

Disabled — RealFlight does not change the targeted player. This allows you to
have full control of the targeting system.
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Leader — RealFlight will target the player with the highest score. If this
happens to be you, then RealFlight will select a player at random.

Random — RealFlight will randomly select a player to target.

Smart — All players with a higher score than yourself will be selected
somewhat randomly. The player with the highest score and the player that
most recently damaged you will have a higher chance of getting selected.

Threat — This option will target the last player which caused damage to you.

Physics-

The physics options are quite useful in fine-tuning the items applicable to the physics of your

simulated aircraft.

Settings Parameter Value
(- Audio ) ) ) .
. Camera Airplane Physics Quality Highest
.. Challenges Helicopter Physics Quality Highest
B Console Use Metric Units fes
.. Instructions Automatic Reset Delay (sec) 0
. Notifications Projectile Physics Quality Low
Warnings Fause Sim When in Background  Yes
Errors Pause Sim When in Menu No
Chat Messages (Sent) Check Physics Setting on Startup Yes
i Chat Messages (Received) FlightAxis Link Enabled Mo
- Commands
- Controller
[=1- Graphics
- Quality
.-Hardware
- Heads-Up Display
- Language
- Multiplayer
- Rewind
- Safety Alerts
- Virtual Reality
- Wind
Cancel

Airplane Physics Quality-

This setting determines the detail level of physics utilized for the airplanes in the
simulation. When the physics level is adjusted to the highest setting, the simulation
performs the aircraft calculations more accurately and more frequently. Unless you
are running the simulation on an older, slower PC, we suggest using either the ‘high’
or ‘highest’ settings. Lowering the physics level will reduce the quality and detail level
used in the simulation, thereby allowing the simulation to run at a faster rate on

slower PC's.
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To alter the physics options, click on the value indicated in the column to the right of
the Airplane Physics Quality name. Using either the up/down arrow keys on the
keyboard, or the mouse, select the level for your simulation from the pull-down list. If
using the up/down arrow keys, press Enter to finalize your selection.

Helicopter Physics Quality-

This setting determines the detail level of physics utilized for the helicopters in the
simulation. When the physics level is adjusted to the highest setting, the simulation
performs the aircraft calculations more accurately and more frequently. Unless you
are running the simulation on an older, slower PC, we suggest using either the ‘high’
or ‘highest’ settings. Lowering the physics level will reduce the quality and detail level
used in the simulation, thereby allowing the simulation to run at a faster rate on
slower PC'’s.

To lower the physics option, click on the value indicated in the column to the right of
the Helicopter Physics Quality name. Using either the up/down arrow keys on the
keyboard, or the mouse, select the level for your simulation from the drop-down list.
If using the up/down arrow keys, press Enter to finalize your selection.

Use Metric Units-

This option determines the unit of measurement for the various displays found in the
simulation. RealFlight defaults to display measurement in SAE units. You can easily
change this to use metric units.

To do so, click on the value column to the right of the Use Metric Units name. Using
either the up/down arrow keys on the keyboard, or the mouse, select either Yes or
No from the pull-down listings. If using the up/down arrow keys, press Enter to
finalize your selection.

Automatic Reset Delay (sec)-

This setting will force RealFlight to automatically reset the aircraft after a crash during
which a piece of the aircraft has broken off.

To adjust the Reset Delay, click the respective value. Enter the desired value directly
from the keyboard or use the mouse wheel.

Projectile Physics Quality-

This setting, as the name suggests, is use to determine the physics quality of the
rockets, paintballs and guns. With the highest setting, projectiles will collide with
terrain, vehicles and all objects at an airport. This is more realistic but requires more
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processing power. To improve your computer’s rendering performance, select a
lower setting.

Pause Sim When in Background-

This setting, when enabled, will pause your flight when you switch away from it. If
set to No, your flight will continue even when you access other applications. Note
that during multiplayer sessions, RealFlight will never pause regardless of this setting.

Pause Sim When in Menu-

This setting, when enabled, will pause your flight when you access any of the menus.
If set to No, your flight will continue even when you access the menus. Note that
during multiplayer session, RealFlight will never pause regardless of this setting.

Check Physics Setting on Startup-

The simulation is most accurate when the physics difficulty is set to "Realistic" in the
Physics Gadget. If any other setting is selected (including "Custom"), RealFlight shows
the Physics Gadget on startup to make it obvious. Disable that behavior by setting
this to No.

Flight Axis Link Enabled-

This determines whether or not the FlightAxis toolkit is enabled and responds to
FlightAxis link connections for testing flight controllers. RealFlight defaults to No. To
activate, change the setting to Yes.
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Rewind -

The rewind section allows you to control the parameters for the Rewind feature. You may
disable the Rewind feature altogether, or alter how it functions with the following settings.

Settings Parameter Value

D :::::ra Wind Variation (3%) 0

- Challenges Wind Gust (%) 0

= Console Turbulence (%) 0
- Instructions Thermals Simple
Notifications
\Warnings

Errors
Chat Messages (Sent)
Chat Messages (Received)
‘.. Commands

- Controller

(=] Graphics
- Quality
.-Hardware

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

Cancel

Enable Rewind-

The Rewind feature is enabled by default. If you wish to turn off this feature, change
this setting to No.

Enable Audio Effects-

If you wish to turn off the unique audio effects when activating the Rewind feature,
change this setting to No. This setting is set to Yes by default.

Enable Visual Effects-

If you wish to turn off the video tape graphical effects when activating the Rewind
feature, change this setting to No. This setting is set to Yes by default.

InterLink Button Reset Threshold (sec)-

The Rewind feature is only activated if the Reset button is held down for a specific
amount of time. This setting allows you to adjust that threshold. If the Reset button is
released before this time limit, the flight is simply reset as normal. The adjustable
range is between 0.1- 2.0 seconds with 0.3 as the default setting.
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Slowdown Duration (sec)-

Before the Rewind feature kicks in fully, your flight will slow to a stop, then proceed
in reverse. The Slowdown Duration setting allows you to adjust how long this process
takes. The adjustable range is between 0.1- 2.0 seconds with 0.3 as the default
setting.

Time to Reach Maximum Reverse Speed (sec)-

This setting allows you to adjust the amount of time it takes before the Rewind
feature is functioning at full speed. The adjustable range is between 0.1 and 10
seconds with 1 second as the default.
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Safety Alerts -

When you are at the flying field, it is important to make sure your transmitter’s switches,
dials and throttle are all set appropriately before you start your aircraft. The RealFlight 9.5
program helps to remind you of this important safety practice when resetting your
helicopter.

Settings Parameter Value
- Audio

- Camera

- Challenges

=~ Console
Instructions
Notifications

Helicopter Resets Yes

Chat Messages (Sent)
Chat Messages (Received)
‘- Commands

- Controller

- Heads-Up Display
- Language

- Multiplayer

- Physics

- Rewind

- Virtual Reality

- Wind

Cancel

Helicopter Resets-

When you reset your helicopter, a small window will appear, warning you if the
throttle or switches are in a position which could damage the helicopter. For
example, you would not want the helicopter to be reset with the throttle stick in the
full throttle position as this could prove to be embarrassing at the least or even quite
possibly disastrous. To disable this feature, change this setting to No.

Alternatively, you can also eliminate this warning screen within the simulation by
clicking the box in the ‘Do not show this alert again’ Safety Alert that appears on-
screen.
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Virtual Reality -

RealFlight 9.5 continues to embrace the use of virtual reality goggles such as the Oculus Rift
and HTC's Vive headsets. This setting enables the user to change the size of the user
interface (Ul) while using the VR within RealFlight.

Settings

(- Audio

- Camera

- Challenges

= Console

Instructions

- Notifications
Warnings
Errors
- Chat Messages (Sent)
Chat Meszages (Received)
- Commands

- Controller

=~ Graphics
- Quality
--Hardware

- Heads-Up Display

- Language

- Multiplayer

-~ Physics

- Rewind

- Safety Alerts

- Wind

Parameter Value

VR User Interface Scale (%) 100

Cancel

The adjustable percentage range is between 50 and 200%; with 100% being set as the
default. If, within VR you determine that this is too large for your personal preference,
simply click on the Value and adjust this percentage using the mouse wheel or input directly

via the keyboard.
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wind -

The wind and weather options control the atmospheric conditions encountered in the
simulation. You can adjust these to match the conditions typically found at your local flying
site.

Settings

Parameter Value
- Audio
D Camera Wind Variation (%) 0
- Challenges Wind Gust (%) 0
= Console Turbulence (%) 0
. Instructions Thermals Simple
Notifications
- Warnings

i Errors
Chat Messages (Sent)
Chat Messages (Received)
L. Commands

- Controller

(=)~ Graphics
- Quality
.- Hardware

- Heads-Up Display

- Language

- Multiplayer

- Physics

- Rewind

- Safety Alerts

- Virtual Reality

Gance

Wind Variation (%)-

This adjustment represents the variation in the wind speed and direction in relation
to the average speed. Just as the winds that you experience at the local field are not
constant, neither are the winds in RealFlight.

To adjust this variable, click on the value indicated to the right of the Wind Variation
(%). Using either your keyboard or the mouse wheel, input a numerical value
between 0 (unchanging) and 100. A higher value produces more dramatic changes in
the wind.

wind Gust (%)-
This value represents the change of the wind speed and direction corresponding to a

proportion of the wind speed it calculates in one second.

To adjust this variable, click on the value indicated to the right of the Wind Gust (%).
Using either your keyboard or the mouse wheel, input a numerical value between 0
(no changes) and 100 (large changes).
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Turbulence (%)-

This option allows you to adjust the strength of the turbulence. Since this setting
represents a median, some turbulence will be more severe, and some turbulence will
be less noticeable.

To adjust the Turbulence Strength Proportion (%) settings, click on the value
indicated in the column to the right of this option. The desired values may be input
directly from the keyboard or modified using the mouse wheel. A value of 0%
indicates that there will not be any mid-level turbulence.

Thermals-

This option allows you to adjust how much of the environment is affected by
thermals. Setting this to Simple will only activate the thermals that are designed into
the airport. Dynamic will cause thermals to be located throughout the entire terrain
of the simulation. If you wish to fully enjoy bungee and aero tow, we suggest
enabling Dynamic thermals.
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W Capture Screenshot
Just like the perfect photo opportunity at the local flying field, RealFlight offers the chance to

snap off screenshots. Captured screenshots are great to share with friends, add as your
desktop wallpaper, or put on the internet for the world to see.

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Scenario...

Manage Scenarios...

Select Controller...

Physics...

Graphics...

Flight Failures >
Setup Failures >
Import >
Export >

Manage User Files...

Mute/Unmute Audio M
Settings...

Capture Screenshot Tab
+~  Show Title Bar

Exit

Flight Modes OX
® SAFE: Beginner

To snap a screenshot, click the Capture Screenshot menu item. Alternatively, press the Tab
key on the keyboard.

Screenshots are stored in the My Documents folder. Each time a screenshot is captured, you
will receive an on-screen notification as to the storage location.
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Show Title Bar

This menu item determines whether or not the RealFlight title bar is displayed on the screen.
By default, the title bar is enabled.

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Scenario...

Manage Scenarios...

Select Controller...

Physics...

Graphics...

Flight Failures >
Setup Failures >
Import >
Export >

Manage User Files...

Mute/Unmute Audio M
Settings...

Capture Screenshot Tab
[V Show Title Bar

Exit

To access this menu item, click on the Simulation menu followed by the Show Title Bar. This
will remove the RealFlight title bar from the screen.

Please note: Removing the title bar also eliminates the ability to minimize or maximize the
screen.
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Exit

Use this menu item to exit the program entirely.

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Scenario...

Manage Scenarios...

Select Controller...

Physics...

Graphics...

Flight Failures >
Setup Failures >
Import >
Export >

Manage User Files...

Mute/Unmute Audio M
Settings...
Capture Screenshot Tab

~  Show Title Bar

Exit
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The Aircraft Menu

OFFERS ACCESS TO A VARIETY OF AIRCRAFT- RELATED FEATURES,

FUNCTIONS, AND OPTIONS.

Chapter

6

licking the Aircraft menu brings forth a pull-down menu similar to the following

screen shot.

# RealFlight

Simulation = Aircraft Environment Challenges Gadgets

Select Aircraft...

Edit E-flite Habu STS 70mm EDF (4S)
Quick Edit...

Select Color Scheme

Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position
Clear Aircraft Position
Reset Position

Kill Engine
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Ctrl+Q

P
Ctrl+P
Space
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Aircraft Selection...

When you click on Select Aircraft... the following dialog appears:

Select Aircraft X

% E-flite Delta Ray One A
2 E-flite EC-1500 Twin 1.5m
2 E-flite EC-1500 Twin 1.5m (large aileron)
2 E-flite Extra 300 3D 1.3m
2 E-flite Extra 300 3D 1.3m (InterLink DX)
2 E-flite F-15 Eagle 64mm EDF
2% E-flite F-16 Thunderbirds 70mm EDF
2 E-flite F-27 Evolution
e E-flite Habu STS 70mm EDF (35 with LAS)
- E-flite Habu STS 70mm EDF (35)
s E-flite Habu STS 70mm EDF (45 with LAS)
2 E-flite Habu STS 70mm EDF (45)
2 E-flite Havoc Xe 80mm EDF
2 E-flite Havoc Xe 80mm EDF (InterLink DX)
2 E-flite Mini Convergence VTOL (advanced)
2 E-flite Mini Convergence VTOL (simple)
2 E-flite Night Timber X 1.2m
e E-flite P-51D Mustang 1.5m
e E-flite Timber 1.5m
2 E-flite Timber 1.5m Float Plane
2 E-flite Timber X 1.2m
2 E-flite Timber X 1.2m (3D)
2 E-flite Timber X 1.2m (3D] (InterLink DXX)
2 E-flite Timber X 1.2m (with slats)

2 E-flite Turbo Timber 1.5m
e E-fite Turbo Timber 1.5m Float Plane The original Timber(R) captured the thiill of incredible Short Takeoff and Landing (STOL) capabilitiesina A
s E-fite Twin Otter 1.2m design featuring sporty flight performance and ultra-friendly handling. From low-time to very experienced

¥ ¥ pilats, nearly everyone enjoys flying the Timber - but some wish it had even more aerobatic capability. The

Description  Specifications

= E-llile Twin Otter 1'2‘”‘ Float Plane E-flite{R) Timber X 1.2m combines the STOL capabilities of the original model with a new wing design

2 E-flite UMX Turbo Timber featuring oversized ailerons and flaps, plus an enlarged rudder and elevator and a more powerful 35 and

s E-flite VV-22 Osprey VTOL 45 compatible power system, to also deliver 3D performance you'd expect from an all-out aerobat! It's also

s E-flite 1200 1.2m v eauioped with Horizon Hobby and Soektrum exclusive A5 3XIR1 [Artificial Stabilization - 3-aXis| and b
Grouping | Product v Color Scheme | E-flite Timber % 1.2m Standard Cancel

Change aircraft simply by using the InterLink DX. Press the Scroll
Wheel/Select button, then, with the airplane tab highlighted, press
the Scroll Wheel/Select button again. This will bring up the Select
Aircraft QuickSelect dialog window. Use the scroll wheel in this dialog
to rotate through the available aircraft. Press the Scroll
Wheel/Select button once again to select a new aircraft, or press
Reset to resume flying without making any changes.

If multiple trim schemes are available for an aircraft, the Color
Schemes button on the screen will be illuminated. You can use the
mouse to click this button, or press and hold the Scroll Wheel/Select
button to display the list of different trim schemes. Roll the scroll
wheel to select the desired trim scheme, press the Scroll
Wheel/Select button to finalize this selection. To return to the
aircraft list, press the Cancel button.
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The list on the left of the dialog box displays all of the aircraft available to you. If you have
created any customized aircraft, they will also appear in this list.

By default, the aircraft are listed in directories that have been optimized for ease of selection.
For example, the aircraft in the RealFlight Legacy folder are either aircraft that are no longer
in production or are what we consider legacy items. To make it easier, and more efficient, to
find more recent offerings, these are included in the RealFlight 9.5 folder. Additionally, if
you’ve created/imported any custom aircraft, these will be found in a Custom folder.

Click the [+] (plus) or [-] (minus) symbol next to the desired folder to reveal or hide the
aircraft within these directories and folders.

Aircraft Selection-

Every aircraft has its own unique flying characteristics, special features, and functions. To
view an aircraft from the listings, simply use the mouse to click on the aircraft name.
Alternatively, use the up/down keys on the keyboard to scroll through the list one aircraft at
atime.

Click the [+] (plus) symbol to reveal the aircraft contained within the folder. Using either the
up/down arrow keys on the keyboard or the mouse, select the desired aircraft from the
listings. If utilizing the up/down arrow keys, click OK to finalize your selection. If using the
mouse, double-click on the aircraft to load it.

Have some fun while you’re in the Select Aircraft dialog! Using the mouse, click and drag the
preview screen to point the camera angle to your choosing. Use the scroll wheel to zoom in
and out or move the gimbals to see the control surfaces move. To resume rotating
automatically, right-click the preview screen.

Description/Specifications-

The pane below the Aircraft Preview box shows either the aircraft description or aircraft
specifications. This box provides you with a brief history of the aircraft (if applicable) and
serves to provide you with specific information pertaining to the model selected.

Using the mouse, select either the Description or Specifications tab.

Grouping-

This list controls how the dialog organizes the list of available aircraft. By default, the aircraft
are sorted by Product. Here is an explanation of the different sorting methods:

e Product, Airframe: The aircraft are first grouped into folders named by their parent
product (i.e. RealFlight 9.5, Custom, Add-On, etc.). Within each parent product folder,
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the aircraft are further grouped into sub-folder by their Airframe names. For
example, “P-51 Mustang” and “P-51 Mustang (Combat)”, “P-51 Mustang (Paintball)”,
and “P-51 Mustang (Streamer Cut)”are all found in the P-51 Mustang airframe folder.

e Product: Aircraft are grouped by product alone.

e Airframe: Aircraft are grouped alphabetically by airframe, not by product. Individual
aircraft are grouped inside each airframe folder.

e None: There is no grouping at all. All aircraft are sorted alphabetically.

Color Scheme-

If applicable, this list contains the alternative trim schemes for the selected model. If the
Color Scheme dialog is grayed out, there are no alternative trim schemes available for this
particular aircraft.

If the list control is active, click on the down arrow to reveal the alternate trim scheme(s). To
select an alternate trim scheme, use either the up/down arrow keys on the keyboard or
select one with the mouse. When an alternative trim scheme is selected, this scheme wiill
appear immediately in the ReadySelect preview box replacing the previous trim scheme.

Modelers may also create their own trim schemes in RealFlight using a third-party bitmap
editor capable of manipulating Targa (*.tga) files. Please see the section titled “Save Color

4

Scheme As....”.
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Edit Current Aircraft

RealFlight offers the user unparalleled freedom to edit or modify their aircraft. It’s possible to
add and remove components, alter their location, change airfoils, and much, much more!
The first several times that you access the aircraft editor, the task might seem daunting. It
may require some getting used to before you are comfortable with this feature and its
related functions. The best way to do so is to simply dive in and experiment.

To modify the currently selected aircraft, click the Aircraft menu followed by the Edit Current
Aircraft menu item. This brings up the Aircraft Editor dialog, which will allow you to modify
any of the hundreds of parameters for the currently selected aircraft.

M Aircraft Editor - E-flite Habu STS 70mm EDF (4S)

File Edit Component Options View

Vehicle |Physics | Electronics Radio Visuals

v A Airframe Parameter Value
Main Battery Standard Parameters ~
> ¥ Fuselage g
CG Adjustment (mm) x=0, y=43, z=0
Material EPP Foam
Read-Only Parameters -

Component Type Root
Current CG (mm) x=0, y=103, z=8

The Aircraft Editor dialog will have an appearance similar to the screen shot shown above. It
may deviate slightly depending upon the type of aircraft that you are editing (i.e., biplane,
electric model, etc.), as well as the editing tab selected (Vehicle, Physics, Electronics, etc.).
However, all aircraft are edited in a similar manner. This section presents you with the
general information necessary to edit any aircraft found in the RealFlight 9.5 offering.
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Aircraft Editor Menus-

Selecting the Edit Current Aircraft option activates the screen shown above.

File Menu-

This menu and its menu items are used to manipulate and control the various folders
and related items in the aircraft editor.

W Aircraft Editor - E-flite Habu STS 70mm EDF (4S)

File Edit Component Options View

Open...
Save
Save As...

Revert

Exit to Simulator

Vehicle | Physics | Electronics Radio Visuals

v A Aiframe Parameter Value
Main Battery

Standard Parameters ~
“+ Fuselage

CG Adjustment (mm) x=0, y=43, z=0
Meaterial EPP Foam
Read-Only Parameters ~
Component Type Root
Current CG (mm) x=0, y=103, 2=8

Open...-

This menu item is used to open existing and edited aircraft. Selecting this
menu item opens the Select Aircraft dialog. To select an aircraft from this list,
follow the procedure described in the Aircraft Selection section of this
manual.

Save-

This option becomes active once you have renamed and saved the edited
aircraft. Prior to doing so, this option will remain inactive and grayed out. This
allows you to make further modifications to the aircraft without renaming it
each time.

Save As...-

Upon completion of the aircraft editing, click this menu item to rename and
save the modifications. You will be asked to create a name for this new
aircraft. After you have renamed the aircraft, click OK to accept the new
name. Afterward, the aircraft will appear in the aircraft listing found under
Select Aircraft... in the Aircraft menu.
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Revert-

This menu item allows you to revert, or go back to the settings the last time
the aircraft was saved. If you have not previously saved the aircraft, the
aircraft will return to the default settings.

To use this menu item, open the File menu and click Revert. This will bring
forth the verification dialog. Click Yes if you wish to return to the last saved
version of this model.

Please note: Any modifications performed after the last time this model was
saved will be lost. Clicking No will allow you to save the modifications or
continue refining the aircraft.

Exit to Simulator-

This menu item returns you to the simulation. If you have performed any
modifications to the aircraft and have not saved these modifications, a
verification dialog will appear. Choose Yes to save the modifications. If you
select No, the modifications will be lost. Selecting Cancel will return you to
the editing dialog.
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Edit Menu-

As is suggested by the name, this menu is utilized to edit the aircraft. This menu may
be used for some simple editing functions on the current aircraft.

M Aircraft Editor - E-flite Habu S

File Edit Component Options View

Undo Ctrl+Z
Redo Ctrl+Y

Rescale Physics to

Vehidle Physics  Electronics Radio  Visuals

v A Airframe Parameter Value
s :’Z:’:;:“’y Standard Parameters )
- CG Adjustment (mm) x=0, y=43, z=0
Material EPP Foam
Read-Only Parameters ~

Component Type Root
Current CG (mm) 0

Undo-

Select this to undo the last change you made in the aircraft editor.

Redo-

Choose Redo to repeat the last action you performed in the aircraft editor.

Rescale Physics to-

This setting is used to alter the physics calculations utilized for the aircraft.
Select one of the predetermined percentages from the sub-menu items, or
select the custom option and input the percentage desired.

Use this option to refine the flight characteristics of the selected aircraft
accordingly.
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Component Menu-

As is suggested by the name, this menu is utilized to edit the aircraft. This menu may
be used for some simple editing functions on the current aircraft.

M Aircraft Editor - E-flite Habu STS 70mm EDF (4S)

File Edit Component Options View

Cut Ctri+X
Copy Ctrl+C
Paste Ctrl+V
Add

Delete Del

Rename

Vehicle Physics | Electronics Radio Visuals

v A Airframe Parameter Value
Main Battery

Standard Parameters ~
¥ Fuselage

CG Adjustment (mm) x=0, y=43, z=0
Material EPP Foam
Read-Only Parameters ~
Component Type Root
Current CG (mm) x=0, y=103, 2=8

Cut-

Select a part on the aircraft and choose Cut to remove the object. The part is
stored temporarily in RealFlight's memory and can be pasted back onto the
aircraft later, if so desired.

Copy-

Like the Cut option, Copy will store the selected part in RealFlight’s memory
allowing you to later paste it into the aircraft. Unlike Cut, the selected part
will remain at the current location.

Paste-

If any aircraft part has been cut or copied, choose Paste to add it to the
current aircraft.

Add-

As the name suggests, this enables you to add items to the aircraft. For
example, if the aircraft name is highlighted and the Edit menu is selected,
there will not be any actions available to you. If the airframe is highlighted,
the aircraft editor will allow you to add various components to the airframe.
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If you wish to either add or remove an item from one of the aircraft
components, right-click on the respective component. This will bring forth
the available options.

When editing aircraft, you can click and drag the mouse in the preview area

to rotate the aircraft to different angles. Additionally, it is possible to enlarge
or shrink the aircraft representation within this preview box. Doing so helps
to better see components you might be modifying.

Delete-

Delete will remove the selected part from the aircraft. It cannot be retrieved
later. Therefore, you cannot paste the part back onto the aircraft.

Rename-

Delete will remove the selected part from the aircraft. It cannot be retrieved
later. Therefore, you cannot paste the part back onto the aircraft.

Options Menu-

This menu provides you with a number of choices or options available in the aircraft
editor.

Selecting the Options menu brings forth the drop-down menu items discussed
below.

W Aircraft Editor - E-flite Habu STS 70mm EDF (4S)

File Edit Component Options View

~ Play Engine Sounds
Control Surface Deflections
Units
Reload Color Scheme

Fuel Level

Vehicle Physics | Electronics Radio Visuals

v I Airframe Parameter Value
Main Battery

Standard Parameters ~
“+ Fuselage

CG Adjustment (mm) x=0, y=43, z=0
Material EPP Foam
Read-Only Parameters a
Component Type Root
Current CG (mm) x=0, y=103, z=8
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ﬂ Play Engine Sounds-
Selecting this menu item plays the respective engine sounds during the

editing of this aircraft.

Please note: This setting is only temporary. That is, this setting is not retained
after you exit the aircraft editor.

To select this option, click the Play Engine Sounds menu item. This will place
a check mark before the setting and return to the aircraft editor. The engine
sounds will become audible.

ﬂ Control Surface Deflections-
Selecting this menu item displays the deflection, either Simple or Advanced,

of the selected control surface. If using ailerons, for example, and Simple is
selected, the parameter available to modify will show only the maximum
deflection. If, however, Advance is selected, the maximum, minimum and
center deflection parameters will be visible for editing.

n Units-
This option toggles the units of measure between metric and SAE units. It is

important to note that modifying this option affects all measurements in the
simulation. For example, changing from SAE to metric in the editor also
affects the airport editor dialogs.

To modify this option, click the Display Metric Units setting. Then select the
unit of measurements you would prefer from the drop-down menu. The
options are English or Metric. A check mark will appear next to the unit that
is currently displayed.

Reload Color Scheme-
This option allows you to view the results of an edited trim scheme.

There are two ways that you can do so. The first is to use the Select Color
Scheme menu, which is found within the Aircraft menu. Simply click on the
color scheme that you have just edited, and RealFlight will reload the color
scheme onto your aircraft and reset the aircraft back on the runway.

Alternatively, within the aircraft editor, click on the Options menu item.
Select Reload Color Scheme. Clicking this reloads the color scheme, showing
any changes you have made to the aircraft. To improve visibility of the trim
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scheme, you may wish to remove the wireframe from the preview. To do so,
please follow the procedure noted in the description for “Show Wireframe.”

Fuel Level-

In the aircraft editor, the mechanics of the aircraft will be running to allow
you to see how it functions. If you prefer, you can set the fuel level to empty,
which will essentially kill the motor.

Select the Fuel Level menu item, and then click your preference.

View Menu-

The View menu in the aircraft editor offers choices on the perspectives of the aircraft
in the preview window.

BN Aircraft Editor - E-flite Habu STS 70mm EDF (4S)
File Edit Component Options View
Look At
Look From
Background

Component Indicators

Select Layout

Vehicle Physics | Electronics Radio Visuals

v A Airframe Parameter Value
Main Battery

Standard Parameters ~
¥ Fuselage

CG Adjustment (mm) x=0, y=43, z=0
Material EPP Foam
Read-Only Parameters .
Component Type Root
Current CG (mm) x=0, y=103, z=8

A Look At-

This option allows you to determine the view of the aircraft being edited.
There are three options available from this menu.

e Aircraft Center- Check this option if you wish to keep the entire aircraft
centered in the view.

e Component Center- Check this option to center the view on the
component you are editing. For example, if you are modifying the rudder,
the aircraft will shift, so that the rudder appears in the center of the
preview area.
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To adjust the Look At perspective, click the Look At menu item and select the
desired view. Alternatively, you may use the ‘A’ key on the keyboard to
toggle through the aforementioned selections.

Look From-

You can select from pre-determined angles from the Look From menu item.
They include:

e Above — Look from above the aircraft. Or press the Q key to quickly
change to this view.

e Below — Look from below the aircraft. Or press the Shift-Q keys to quickly
change to this view.

e Right — Look from the right side of the aircraft. Or press the W key to
quickly change to this view.

e Left— Look from the left side of the aircraft. Or press the Shift-W keys to
quickly change to this view.

e Front— Look from the front of the aircraft. Or press the E key to quickly
change to this view.

e Back— Look at the back of the aircraft. Or press the Shift-E keys to quickly
change to this view.

Background-
This option displays a sub-menu that allows you to change the background

color of the preview pane. Depending on personal preference, or the colors
of the trim scheme for the aircraft that you are editing, you may want to
change the background color to make the aircraft easier to see.

To adjust the background color, click the Background menu item and select
the desired color.

Component Indicators-

When the wireframe is visible, each component is represented by small
wireframe indicators. For aircraft that include many components, these
indicators can sometimes get in the way and make things confusing.

There are two methods to assist you with reducing or removing the visibility
of components.
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/ e Size — By default, all component indicators are large. Switch to small to
reduce the chance of each indicator overlapping in the wire frame.

V l o Visibility — For aircraft with a large number of components, you may wish
to change their visibility to Selected Component Only. Then, only the
component you have selected will be visible, while all others will
disappear. Those components still exist, they just won’t be visible.
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Select Layout-

There are two default layout options available from the sub-menu. They will
alter the way the different panes in the aircraft editor window are positioned.
The options will change the aircraft editor layout as follows:

Aicaft Editor - E-ie Haba STS Tomm EDF (4 X I Aircraf Eitor - E-fite Habu STS T
File Edit Component Options View
Vehide Physics  Electronics  Radio  Visuals
v ¥ Aiframe
Main Battery
+ Fuselage
Parameter Value A
Standard Parameters "
€6 Adjustment (mm) =0, y=43,2=0
Vehide | Physics | Electronics Radio  Visuals Matenal EPP Foam
v T e | py— e Read-Only Parameters B
. :‘:‘; ety Standard Parametess N Componert Tpe
SRR G Adjustment (mm) x=0, y=43, 220 | Cument CG{mm) _x=0y=103,28_¥)
Material EPP Foam
Read-Only Parameters A
Component Tpe
CumentCG (mm)

The Aircraft Editor contains three important areas: the Parts Tree, Parameter window, and
the Description pane.

The Parts Tree and Parameter screen are also further grouped into a number of different
tabs.

e Vehicle —This tab will only display a Parameter window. The options here
are more general, affecting the overall aircraft.

e Physics — This tab allows you to view and edit physical components of an
aircraft, like the wings, fuselage, and landing gear.

e Electronics — Select this tab to view and edit parameters for the aircraft’s
electronics, like servos.

e Radio— To view and modified the built-in radio programing for the
aircraft, select this tab.
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e Visuals — More advanced users that create their own aircraft for
RealFlight from scratch will use this tab to match the graphical parts with
the physical parts.

There might be times where you want multiple tabs visible at the same time. For example,
you may want to modify the programming for the radio that will then affect one or more
servos. Those servos are then linked to certain control surfaces. In this case, it might be of
some assistance to be able to view Radio, Electronics and Physics tab at the same time.

Luckily, the Aircraft Editor in RealFlight 9.5 allows you to do this with ease. Simply click and
drag a tab and move it to another location on the screen. The tab can float independently, or
lock to the edge of the Aircraft Edit screen as desired.

Fée £dt Component Options View

The Parts Tree breaks down the list of aircraft components and radio data, depending on the
tab selected, into an easy-to-use hierarchy.

For example, with the Physics tab visible, the first item listed is Airframe, which is considered
the root item for all other items listed here. Selecting it will offer a variety of common
parameters that you can edit in the Parameter window.

Below the Airframe there are additional options that allow you to customize the individual
parts of the aircraft. Similarly, you also have the ability to modify the electronics and radio
program for the aircraft in the Electrons and Radio tabs, respectively.

Each part belongs to a higher component, or parent, with the root being the highest
component. In return, it’s possible that the part itself also has children parts that belong to it.
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For example, if you wish to edit the wheel diameter on the Habu STS 70mm EDF, you will find
it under the following path in the Parts Tree:

[ Aircraft Editor - E-flite Habu STS 70mm EDF (4S)

File Edit Component Options View

Vehicle |Physics @ Electronics Radio

Visuals

Main Battery
~ ¥ Fuselage
\ Ducted Fan
~ J Steering Gear
© Steering Wheel
» < Horizontal Stabilizer
v < Main Wing
o—a Aileron
v /7 Main Gear
© Main Wheel

~

Parameter

Standard Parameters
Weight (g)
Wheel Diameter (mm)
Wheel Width (mm)
Has Wheel Pant
Rotation about Y (Camber) (deg)
Rotation about Z (Toe-In) (deg)
Brake Servo

Value

85

65

16

No

0

0
<None>

Brake Sen:n R Mo g

+ Physics Tab
¥ Airframe — Contains all the physical parts of the aircraft, such as wings, fuselage, etc.
¥ Fuselage — One of many physical parts found in the Airframe

¥ Main Gear — The Main Gear on the Habu STS attaches to the wing, therefore,
is listed under the Main Wing part.

¥ Main Wheel - Finally, you’ll see the wheel component which,
understandably, is found under the Main Gear part.

Once the Main Wheel is selected, the Parameter window will change to show all parameters
available to the Main Wheel. You’ll notice that one of these parameters is wheel diameter.

All other parts are found and modified in much the same way. However, if you are unsure as
to the location of a part, an easier way to access the part is to click on the desired item in the
Preview screen on the top half of the window. For example, if you want to modify the
parameters for the horizontal Stabilizer of the Habu STS, simply click on that portion of the
image. You'll notice that the Horizontal Stabilizer is now selected in the Parts Tree.

Preview Screen-

As mentioned above, to quickly find the part in the Parts Tree for modification, you can
simply click that part in the Preview screen itself. At times, you’ll notice that the part you
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want to click might be hidden behind another section of the aircraft. If you find yourself in
this situation, click and drag the mouse cursor around the Preview screen. This will rotate the
aircraft image around, so you may view it from different angles. You may also use the scroll
wheel on the mouse to zoom in and out for a closer look at the section you are working on.

Parameter Window-

The final component of the on-screen layout is the Parameter window. This window will list
all the parameters available for the currently selected part in the Aircraft Parts Tree.

M Aircraft Editor - E-flite Habu STS 70mm EDF (4S)

File Edit Component Options View

Vehicle Physics | Electronics Radio  Visuals

Main Battery A || Parameter Value A
v T Fuselage Standard Parameters -
A\ Ducted Fan %
~ J Steering Gear Weight (g) 55
© Steering Wheel Wheel Diameter (mm) 65
» < Horizontal Stabilizer Wheel Width (mm) 16
v < Main Wing Has Wheel Pant No
2 Aileron Rotation about Y (Camber) (deg) 0
~ / Main Gear Rotation about Z (Toe-In) (deg) 0
© Main Wheel M Brake Servo <None>
£ > Brake Sen:n R Mo b

Clicking on the parameter will allow you to view a description of its use in the Description
pane next to the Parameter window. This will also allow you to modify the currently selected
parameter.

Adding and Removing Components-

There are times when you may want to add a new component to the aircraft. The first step is
to determine the location for the new part. For example, if you were to add flaps, it makes
more sense to add them to the main wing, than to the fuselage.

After determining a location for the new part, you can add it in one of two ways. Select the
new part from the Component menu then click on the component to which you are adding
the new part from the Add sub-menu. Alternatively, right-click on the Main Wing
component in either the Parts Tree or in the Preview screen, then select the Add sub-menu.

Removing a component works in much the same way. In the Parts Tree, select the
component you wish to remove and then select Delete Component from the Component
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menu. You can also accomplish the same thing by right-clicking on the part to remove and
selecting Delete.

More Information-

The Aircraft Editor may seem a little overwhelming at first. The best way to become familiar
with the editor and its related functions is to simply use it and start experimenting. RealFlight
does not allow you to customize the stock aircraft. If you want to make a change to one of
the stock aircraft, you will be forced to save it under a new name. Therefore, you always
have the stock aircraft to default to should the need arise.

Our online forums and swap pages provide a great source of information and assistance
from other RealFlight users. These pages may be found at:

www.knifeedge.com/forums
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m Quick Edit...

This window allows you to make quick, simple changes to the aircraft without opening the
full Aircraft Editor. Often times, you may feel that simple changes, such as the amount
(expressed in degrees) of rudder deflection are all that is needed to make an aircraft fly more

like your model. Instead of working through the complexity of the Aircraft Editor, you may
make the change rapidly using RealFlight’s Quick Edit.

When you click on Quick Edit... a window similar to the following appears:

Ceflection
Aileron
Ceflection

Elevator
Ceflection

w“q "
power g . I
e

Ducted Fan
Pawer 100.0

To make such simple refinements to the respective aircraft, click the Aircraft menu followed
by Quick Edit. The Quick Edit dialog will appear, showing the adjustment options.

Changes made through the Quick Edit will make a copy of the aircraft and save it as a custom
aircraft with “(Quick Edit)” appended to the name.
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Select Color Scheme

This menu item allows you to quickly choose an alternative trim scheme (if available) for the
current aircraft.

#* RealFlight

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (45 with LAS)

Quick Edit... Ctrl+Q
3

Select Color Scheme > « E-flite Habu STS 70mm EDF Standard
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position P
Clear Aircraft Position Ctrl+P

Reset Position Space
Kill Engine K>

1. E-flite Habu STS 70mm EDF (4S)

Flight Modes 9X
® SAFE: Beginner

To view the alternative color schemes, click the Select Color Scheme menu item. To select an
alternate trim scheme, click the desired selection in the value box. Alternatively, you may use
either the Up/Down arrow keys on the keyboard, or the mouse to select the desired scheme
option. If utilizing the arrow keys, press Enter to finalize the selection. The new trim scheme
will appear immediately on the aircraft. Please note: if only one scheme appears in the pull-
down menu, alternative schemes are not available for this aircraft.
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Save Color Scheme As...

This menu item is used to create an editable version of the currently selected trim scheme.

#= RealFlight

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (4S with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme >
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position P
Clear Aircraft Position Ctrl+P
Reset Position Space

Kill Engine K>
1. E-flite Habu STS 70mm EDF (45)

Flight Modes X
® SAFE: Beginner

RealFlight allows you to create a custom paint/decal scheme for your aircraft. The color
schemes you create are limited only by your imagination.

However, only individuals that own and know how to use a third-party bitmap editing
program such as Adobe® Photoshop® should attempt to create a custom color scheme. Your
editor must be able to read and edit Targa (“.tga”) files.

To create a custom color scheme, click the Save Color Scheme As... menu item. Enter the
desired name in the dialog box that appears. The location of the file will appear in the lower
left corner of the RealFlight screen.

To access the file that contains the custom color scheme, open the My Documents folder.
Next, open the RealFlight 9.5 folder followed by the Vehicles folder. A number of folders are
available here; open the folder called ColorSchemes. This will bring up all of the custom color
schemes that have been stored in RealFlight. The name of the aircraft will precede the name
that you have selected for your custom color scheme. Click on the file for which you wish to
modify the trim scheme.
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DO NOT ALTER THE NAME OF THIS FILE, AS REALFLIGHT MAY NOT BE ABLE TO CORRELATE
THE COLOR SCHEME WITH THE AIRCRAFT.

Once you have finished editing and saving your color scheme, you will probably want to see
the results of your work. There are two ways that you can do so. One is to use the Select
Color Scheme menu, which is found within the Aircraft menu. Simply click on the color
scheme that you have just edited, and RealFlight will reload the color scheme onto your
aircraft and reset the aircraft. Within seconds, you are ready for flight with your new color
scheme.

Alternatively, access the Aircraft Editor (see section Edit Current Aircraft on page 134). Within
the aircraft editor, look for Reload Color Scheme which is located in the Options menu. Clicking
this will reload the color scheme, showing any changes you have made to the aircraft. You can
disable the wireframe using the Options menu to improve your view.

While looking in the Color Schemes directory for your new color scheme, you may also
notice a “.color scheme” file with the same name as the “.tga” file. This file can be opened in
a text editor such as Notepad. Within the file, you will find six values to edit: Specular,
Reflectivity, Power Specular Off, Power Specular On, Power Reflective Off, and Power
Reflective On.

Specular - A multiplier for the overall specularity of the aircraft. Specular=1 is neutral,
Specular=0 disables specular highlights.

Reflectivity - A multiplier for the overall reflectivity of the aircraft. Reflectivity=1 is neutral,
Reflectivity=0 disables reflections.

Specular highlights vary from fully off to fully on as the specular power of each piece of the
aircraft goes from the value Power Specular Off to Power Specular On.

Reflections vary from fully off to fully on as the specular power of each piece of the aircraft
goes from the value Power Reflective Off to Power Reflective On.

Tips for Color Schemes-

e A quick and easy way to change a color scheme is to replace one color with
another. Photoshop has a command that can easily do this called, “Replace
Color”.

e Make sure you save the file as 32 bit TGA files, so that the Alpha Channels are
preserved (See below).

e You are only allowed a single Alpha Channel.

e Do NOT alter the resolution of the image.
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e Other formats (JPG, BMP, etc) are not allowed.

Alpha Channels-

Almost all of the color schemes for the aircraft incorporate an Alpha Channel, which defines
what areas of the color scheme are opaque and what areas are transparent. White portions
of the alpha channel will be 100% opaque and Black portions of the alpha channel will be
100% transparent. Shades in-between will be partially transparent.

Consult the image editor’s manual to determine how to properly use Alpha Channels.

Please note: RealFlight uses TGA files instead of the BMP format. This is because BMP
formats do not support alpha channels.

Randomize Color Schemes

When this menu item is checked, RealFlight will randomly choose a color scheme for the
selected aircraft, if multiple schemes are available. Uncheck this menu item to disable this
feature.

#* RealFlight

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (45 with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme >
Save Color Scheme As...
Randomize Color Schemes

Remember Aircraft Position P
Clear Aircraft Position Ctrl+P

Reset Position Space
Kill Engine
1. E-flite Habu STS 70mm EDF (45)

Flight Modes 9X
® SAFE: Beginner
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P | Remember Aircraft Position

The Remember Aircraft Position menu item saves the current position of the aircraft. When
you reset the aircraft, it will return to the same position (speed, attitude, heading, etc.). This
feature is ideal for practicing maneuvers, such as an autorotation in a helicopter.

#* RealFlight

Simulation | Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (45 with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme
Save Color Scheme As...

Randomize Color Schemes
Remember Aircraft Position P
Clear Aircraft Position Ctrl+P

Reset Position Space
Kill Engine K>

1. E-flite Habu STS 70mm EDF (4S)

Flight Modes OX
® SAFE: Beginner

To activate this menu item, click the Remember Aircraft Position menu item when the
aircraft is in the desired location and altitude.

Each time the aircraft is reset, it will begin flight from the saved location.

Please note: The saved position is only temporary. If you select another airport, aircraft, or if
you exit the simulation and restart, you will need to save the desired position once again.
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m Clear Aircraft Position
This menu item clears the position saved in the Remember Aircraft Position without exiting

the simulation, changing flying sites, and/or aircraft.

#* RealFlight

Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (4S with LAS)
Quick Edit...

Select Color Scheme
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position

Clear Aircraft Position

Reset Position

Kill Engine

1. E-flite Habu STS 70mm EDF (4S)

Flight Modes OX
® SAFE: Beginner

To do so, simply click the Clear Aircraft Position menu item. When the aircraft is reset, it will
return to one of the default starting positions.
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E Reset Position
There are three ways to reset the aircraft to its takeoff position:

1. Press the Reset button on the InterLink DX controller. This is probably the fastest and
simplest method.

2. Press the keyboard’s space bar.

3. Click the Reset Position menu item.

#= RealFlight
Simulation | Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help
Select Aircraft...
Edit E-flite Habu STS 70mm EDF (45 with LAS)
Quick Edit...

Select Color Scheme
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position
Clear Aircraft Position Ctrl+P
Reset Position Space

Kill Engine K>

1. E-flite Habu STS 70mm EDF (45)

Flight Modes (74
® SAFE: Beginner
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n Kill Engine
Click on this item to instantly stop the motor from running. This is useful when you are
practicing dead-stick landings in airplanes and practicing autorotation for helicopters.

#* RealFlight
Simulation = Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help
Select Aircraft...
Edit E-flite Habu STS 70mm EDF (4S with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position

Clear Aircraft Position

Reset Position

Engine Motor 1

1. E-flite Habu STS 70mm EDF (45)

Flight Modes OX
SAFE: Beginner

If the aircraft has multiple motors, the sub-menu will allow you to select which motor to kill.
Alternatively, pressing ‘K’ on the keyboard, or selecting Random will kill one of the motors at
random.
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Aircraft MRU

The final items in the Aircraft menu indicate the most recently used aircraft. The MRU shows
only the eight most recently selected aircraft.

# RealFlight

Simulation | Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Aircraft...
Edit E-flite Habu STS 70mm EDF (4S with LAS)
Quick Edit... Ctrl+Q

Select Color Scheme >
Save Color Scheme As...

Randomize Color Schemes

Remember Aircraft Position P
Clear Aircraft Position Ctrl+P
Reset Position Space

Kill Engine K>

1. E-flite Viper 70mm EDF

2. E-flite Twin Otter 1.2m

3. E-flite P-51D Mustang 1.5m

4, E-flite Apprentice S 15

5. Blade Fusion 480

6. Blade Fusion 270

7. Dynaflite Super Decathlon

8. E-flite Habu STS 70mm EDF (4S with LAS) F|Ight Modes 0 X

® SAFE: Beginner

You can load an aircraft by selecting it from this list. This shortcut allows you to switch
amongst your favorite aircraft without using the Select Aircraft dialog.
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Chapter

7

The Environment Menu

ALLOWS ACCESS TO A VARIETY OF ENVIRONMENT-RELATED FEATURES,
FUNCTIONS AND OPTIONS.

he Environment menu gives you access to many scenery related features, such as
changing flying sites, or adjusting weather related items.

Clicking the Environment menu will open the drop-down menu as illustrated in the
following screen shot.

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Airport...
Edit Eli Field
Create New Airport...

Sun

Thermals

Wind

Reset to Default

1. Eli Field

Flight Modes OX
® SAFE: Beginner
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Select Airport...

When you click on Select Airport... the following dialog appears:

Select Airport X

= & sierra Nevada ~
?:? Air Race Stadium
?:! Alpine Lake
m Apocalypse
Kj Buena Vista
Bad Carnival
?:j Castle

?:’! Castle HD

?:! Construction Site
Kj Dry Creek RC Field
&:j DS Ridgeline

Fad Flight School

Fad Flight School (Night)
a4 Flight School HD
Fad FPV Racing Site

Kj Japanese Temple Home of the Monticello Model Masters, or M3 for short, Eli Field is -~

Bad Joe's Garage located on the outskirts of Monticello, Ilincis and is named after the

gj Joe's Garage HD father of Horizon Hobby's founders Rick and Larry Stephens. It has

served as the host field for Horizon Hobby's RC Fest as well as

?:’ Junkyard countless other national and international events. It also serves as

?:! Observatory the test site for many of Horizon's RC offerings and home field for

@ Obstade Course world-dlass pilots such as Dustin Buescher, Ali Machinchy, James

B Ahetada Feorea Miaki) e Haley and David Payne amaonast others. b
Grouping | Product, Scene i Cancel

RealFlight 9.5 offers two different types of flying sites: 3D and PhotoField. PhotoField, as the
name suggests, are flying sites created from photo imagery. 3D flying sites are, again as the
name suggests, sites rendered in a 3-dimensional environment. If the PC is running slowly at
a 3D flying site, try selecting a PhotoField site.

This dialog lets you choose the flying site that you wish to use for your flight. Each location
offers its own unique characteristics and challenges.

Change airports simply by using the InterLink DX. Press the Scroll
Wheel/Select button, then use the scroll wheel to highlight the
runway icon, and press the Scroll Wheel/Select button again. This
will bring up the Select Airport QuickSelect dialog window.

You can continue using the Scroll Wheel/Select button in this
dialog to select a new airport, or press Reset to resume flying
without making any changes.

The list on the left of the dialog box displays all of the flying sites available to you. If you have
created or downloaded any flying sites, those sites will also be visible here.

The flying sites are listed in files and folders in accordance with the software from which they
were loaded. For example, if you have installed Expansion Pack 7, the sites from this disc will
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be listed alphabetically, beneath the Expansion Pack 7 folder. You can change how the
airports are organized, by selecting one of the options under the Grouping drop-down
selection box. The options are:

Product, Scene: As explained above, airports are first grouped into folders by the product in
which they are contained. Within each group, they are then grouped further by scene.

Product: Airports are grouped by product alone.
Scene: Airports are grouped by scene alone.
None: Airports are not grouped into folders at all. Rather, they are listed alphabetically.

Click the [+] (plus) or the [-] (minus) symbol to reveal or hide the airports within these
folders. To select an airport, click on the name of the airport at which you wish to fly.

The rotating image on the right side of the screen provides you with a preview of what to
expect at the desired location. The airport information pane below the terrain map contains
a description and pertinent information regarding the highlighted airport.

Have some fun while you're in the Select Airport dialog. Using the mouse, click and drag the
preview screen to point the camera angle to your choosing. To resume rotating
automatically, right-click the preview screen.

When you are satisfied with your selection, click OK to return to your flight using the new
airport selection. The Cancel button will return you to the simulation at the previously
selected flying site.

Movement Modes-

If applicable to the respective airports, RealFlight 9.5’s Movement Modes allows you
to explore the scenery without an aircraft. Movement is not possible at PhotoField
airports.

To select a Movement Mode, press the ‘Q’ key on your keyboard. You can press the
‘Q’ key repeatedly to cycle through the available modes: Walk, Fly, or Hover.

Walk mode simulates the effect of you, the pilot, physically walking across the field,
complete with sound effects. The Fly mode allows you to move through the air and
position the camera anywhere that you desire.

Once you have entered the desired Movement Mode, use the ‘W’, ‘S’, ‘A’ and ‘D’
keys on your keyboard to control the movements. If you wish to increase the speed
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of your movement, press and hold the Shift key at the same time you are using the
‘W, ‘S’, ‘A’ or ‘D’ key.

The mouse wheel controls the angle or height at which you traverse the scenery. To
increase the altitude, roll the wheel away from you. This is known as the Hover
Mode.

You may also control the zoom levels during your travel. Press the [+] (plus) key to
Zoom In and the [-] (minus) key to Zoom Out. The Backspace key resets the zoom
level to its default value.

Edit Current Airport...

RealFlight 9.5 offers unparalleled freedom to edit flying sites. You can add and remove
objects, alter their location, rotate, and even modify the physical size of the items. It is also
possible to alter the atmospheric or lighting conditions at the various flying locations.

The first several times you access the airport editing function, the possibilities might seem
daunting. It will require some getting used to before you are comfortable with this feature
and its related functions. The best way to do so is to simply dive in and experiment.

To modify the currently selected flying location, click the Simulation menu followed by the
Edit <Current Airport>... menu item, where <Current Airport> is the name of the airport you
have loaded at the moment. This activates RealFlight 9.5’s FlexiField flying site editor, with
the currently active airport loaded and ready to edit.

~= RealFlight

File Edit View Options Window

-3 Tents aTables ~
W@ 12 foot table
&# 12 foot table
S# 12 foot table
W@ Streamer Cut Foamy
&# Furion 450
&# Dynafiite Super Decathlon
W@ Tent - OS Engine
W# Tent - Kinexsis - Blue
W# Tent - Spektrum - Black
W# The Gnome
W# Tent -FMS - Green

[VIRT W SN

(=~ Buildings
i W# Air Race Grandstand
a# Air Race Hangar
W@ Aircraft Barn
% Ajrolane Hanaar

< >
Properties

Parameter Value L
Custom Name Tent-...
Relative Position (m) x=-1.8...
Object Name Tent-...
Object Location RealFlig
ZBoost [}
Fade Out Start Distance (m) 1]
Fade Out End Distance (m) 0 >

Name of the object. Folders whose names are ~
preceded by an underscore character are hidden
from view outside of the editor unless made
visible by the Challenge system, a multiplayer
event, or some other simulator feature.
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Airport Editor Menus-
Selecting the Edit Current Airport option activates the screen shown above.

File Menu-

This menu and its menu items are used to manipulate and control the various folders and
related items in the airport editor.

#= RealFlight

File Edit View Options Window

Open...
Save

Save As...

Save Folder
Load Folder

Exit to Simulator

Open-

This menu item is used to open existing and edited airports. Selecting this menu item
opens the Select Airport dialog.

Save-

This option becomes active once you have renamed and saved the edited airport.
Prior to doing so, this option remains inactive and grayed out.

Save As-

Upon completion of the airport editing, click this menu item to save the
modifications. You will be asked to type in a name for this new airport. Once you
have renamed the airport, click OK to accept the new name. The airport will now
appear in the airport listings.
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Save folder-

This option allows you to select an entire sub-folder in an airport and save it as a new
file. For example, it is possible to select the entire “Objects” sub-folder in RealFlight
Ranch and save it on a disc.

To save a folder, highlight it, click on the File menu and select Save Folder.

Alternatively, you can right click on the existing folder and select Save Folder. This
brings forth a dialog that allows you to determine the new folder’s name, as well as
the location where it will be saved.

Load Folder-

This option allows you to load a folder from the saved folders. To do so, first highlight
a destination folder, click on the File menu and select Load Folder.

Exit to Simulator-

Use this option to close the Airport Editor and return to the simulation. If you have
not made any changes to the airport, you will return directly to the simulation. If you
have unsaved changes, a message box will ask for confirmation before returning to
the simulation.

Edit Menu-

This menu may be used for some simple editing functions in the selected airport.

m= RealFlight
File Edit View Options Window
Undo Ctri+Z
Redo Ctrl+Y

Cut Ctrl+X
Copy Ctri+C
Paste Ctri+V
Delete Del

Select All Ctrl+A
Deselect Esc
Previous Object Up Arrow
Next Object Down Arrow
Select Parent Left Arrow
Select Child Right Arrow

Set As Default Pilot Spawn
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Undo-

Select this to undo the last change you made in the airport editor.

Redo-

Choose “Redo” to repeat the last action you undid with the “Undo” command.

Cut-

Select one or more objects at the airport and choose “Cut” to remove the selected
objects. The objects are stored temporarily in RealFlight's memory and can be pasted
back into an airport.

Copy-

Like the Cut option, “Copy”, will store the selected objects in RealFlight's memory
allowing you to later paste it into an airport. Unlike Cut, the selected object will
remain at the current airport.

Paste-

If any objects have been cut or copied, choose “Paste” to add them to the current
airport.

Delete-

“Delete” will remove the selected objects from the airport without copying them to
RealFlight’s memory. They cannot be retrieved later.

Select All-

This menu option will select all objects at the airport you are currently editing.

Deselect-

Choosing this menu option will deselect any airport objects that might be selected at
the moment. If no objects are selected, “Deselect” will remain grayed out.

Previous Object-
If any airport object is currently selected, choosing “Previous Object” will select the
preceding object in the folder list.

Next Object-

If any airport object is currently selected, choosing “Next Object” will select the next
object in the folder list.
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Select Parent-

All objects belong to a group or parent. To select the parent that the current selected
object belongs to, choose “Select Parent”.

Select Child-

If a group is currently selected, choose “Select Child” to select the first object listed in
that group.

Set As Default Pilot Spawn-

Choose a pilot spawn and click this menu option to set it to the default spawning
point. This point will be the default camera position each time you load the current
airport.

View menu-

This menu allows you to modify your view of the airport while editing it.

File Edit View Options Window

Mode >
Center View on Selection Spacebar

Fit Selection in View 0 (zero)

Zoom In +
Zoom Out

Zoom Reset Backspace

Mode-

The Mode menu is utilized to alter the camera perspective when viewing the scene.
There are four distinct view modes in RealFlight 9.5: Fly Camera, Pan Camera, Pivot
Camera and Normal Camera. These modes, as well as the methods to access them,
will be discussed in depth in the sections that follow.
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Fly Camera-

The Fly Camera option allows the camera to function just like the Movement
Mode in the simulation. See page 161 for more details.

There are several ways to access the Fly Camera mode. The first, and
probably the easiest, is to press the ‘V’ key on your keyboard. You may also
right click on the scene and select Fly Camera from the menu box that
appears. The final method is to select Fly Camera through the View menu and
Mode sub-menu item.

To exit the Fly Camera feature, right click in the editing view and select the
desired option from the menu box that appears. You can also exit this mode
by hitting the ‘Z’ key, which returns you to the normal viewing mode.

Pan Camera-

The Pan Camera option allows the camera to shift the vantage point on the
selected scenery.

There are several ways to access the Pan Camera mode. The first, and
probably the easiest, is to press the ‘C’ key on your keyboard. You may also
right click on the scene and select Pan Camera from the menu box that
appears. The final method is to select Pan Camera through the View menu
and Mode sub-menu item.

To exit the Pan Camera feature, right click in the editing view and select the
desired option from the menu box that appears. You can also exit this mode
by hitting the ‘Z’ key, which returns you to the normal viewing mode.

Pivot Camera-

The Pivot Camera mode pivots or rotates the camera around a particular
object or location.

There are several ways to access the Pivot Camera mode. The first, and
probably the easiest, is to press the ‘X’ key on your keyboard. You can also
right click on the scene and select Pivot Camera from the menu box that
appears. The final method that may be used is to select Pivot Camera View
menu in the Mode menu item.

To exit the Pivot Camera feature, right click in the editing view and select the
desired option from the menu box that appears. You can also exit this mode
by hitting the ‘Z’ key, which returns you to the normal viewing mode.
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Normal Camera-

This mode returns the camera to its normal, or default perspective.

There are several ways to access the Normal Camera mode. The easiest, is to
simply press the ‘Z’ key on the keyboard. Alternatively, you can right click in
the editing view and select Normal Camera from the menu box that appears.
Finally, you may select Normal Camera through the View menu and Mode
menu item.

Center View on Selection-

This option centers the vantage point on a particular object. This is useful for
repositioning, changing object sizes, rotating, etc.

If you have not selected an object from the Folder Listing, or highlighted an object in
the scene, this option will remain inactive or grayed out. If, however, you have made
a selection or highlighted an object, there are several ways to select the Center View
on Selection option.

Simply right click on the selected object or folder in the Folder Listing and select
Center View on Object. Alternatively, in the scene, right click on the highlighted
object and select the Center View on Selection from the options listed. The final
option is to use the View menu and select the “Center View on Selection” option.

Fit Selection in View-

This option is utilized to ensure that your selection fits in the view. For example, if
your zoom magnification is at an extremely high level, the object may not completely
fit on the screen. This feature ensures that it will.

To access the Fit Selection In View, right click on the highlighted object in the scene
and select the Fit Selection In View from the options listed. You can also use the View
menu and select the Fit Selection In View option. Alternatively, press the ‘0’ (zero)
key on the keyboard.

Zoom In-

Click this menu item to magnify or zoom in on the selected item. Alternatively, you
may magnify the view or zoom in on the selected item by pressing the [+] (plus) key
on the keyboard. Each time you press the [+] (plus) key or select the Zoom In menu
item, the zoom level increases incrementally.
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Zoom Out-

Click this item to reduce the magnification, or zoom out of the current view.
Alternatively, press the [-] (minus) key on the keyboard. You may zoom out via
RealFlight 9.5’s menu. Each time the [-] (minus) key or the Zoom Out menu item is
pressed or selected, the view will decrease incrementally.

Zoom Reset-

This menu item resets the view to the default magnification. Alternatively, you may
also press the Backspace on the keyboard to reset the zoom to its default value.

Options Menu-

The Options menu allows you to adjust the behavior of many of the airport editor’s
functions.

~= RealFlight

File Edit View Options Window
Selectable Items
Add Object Grouping

Rotation Snap
~ Display Metric Units

Selectable Items-

The Selectable Items menu determines whether a particular type of object may be
clicked and selected on-screen.

To toggle the ability to select a particular type of item, simply mouse click on the
desired listing in the pull-down menu. This is useful when there are many objects
clustered in a small area and you want to select just one of them. For example,
suppose that an airport has a tight cluster of trees with a dirt pile in the middle and
you want to select the dirt pile, it may be easier to first, turn off the tree selection.
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This will allow you to easily select the dirt pile without the trees interfering with the
selection.

There are three selections available: Objects, Overlays and Trees. Objects includes
items such as the structures, fences, vehicles, tents and so forth. Overlays are, as the
name suggests, the items that are placed over the scenery such as the runways, etc.

The easiest and simplest way to determine which grouping an item belongs to is to
simply toggle the Selectable Items off (no tick-mark next to a selection) and then
attempt to choose a particular object. If it allows selection, the object did not belong
to the Selectable Items type that was disabled.

Add Object Grouping-

The items available for addition in RealFlight 9.5 are all grouped or organized
accordingly. This menu item determines the way they are grouped in the Object
Palette window.

Product, Type, Name-

Selecting this option causes the objects in the Object Palette to be displayed
by the Product, then by the Type, and finally by the Name. That is, objects are
first listed within the product in which they appear (e.g., RealFlight 9.5,
Expansion Packs, etc.). Within the product, the objects are then classified by
Type (e.g., Buildings, Trees, etc.). Once you’ve selected the Product and Type
of object that is desired, the objects are then listed alphabetically by Name.

For information on adding objects and how to use the Object Palette, please
refer to the Object Palette section of this manual.

Type, Name-

This option causes the objects in the Object Palette to display by the Type
and the Name designations only. They are not sorted by the Product in which
they appear. Objects that appear in RealFlight 9.5, Expansion Packs, etc. will
be included in one extensive listing.

This option is useful if you are unsure as to which product includes a
particular object.

Name-

Selecting this option causes the objects to be listed in alphabetical order by
their name designations (e.g., Barn). This listing is extensive as it includes all
of the objects available to you.
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This option is useful if you are unsure as to which product contains the
object, or if you are unsure as to the type of object that you wish to utilize. It
also offers a rapid overview as to the type and number of objects available to
you.

Rotation Snap-

When rotating an object on the flying site, you have the ability to control the amount
of rotation with the Rotation Snap. There are four snap settings that may be utilized
in the editor to provide quick orientation settings for placing objects.

To rotate an object’s position on the flying site, follow the procedure mentioned
above to select an object. Next, press and hold the Shift key on the keyboard. While
holding the Shift key, use the mouse to rotate the object as desired.

None

The object rotates without any restrictions. This is useful for making minor
refinements to object placement.

45 Degrees

The object will rotate 45 degrees each time this option is selected. This is
useful for making large changes to object position.

15 Degrees

The object will rotate 15 degrees each time this option is selected.

5 Degrees

The object will rotate 5 degrees each time this option is selected.

Display Metric Units-

Click this item with your mouse to switch the measurement indicators in the
Properties pane from SAE (feet, inches, pounds) to metric (meters, centimeters,
kilograms). Please note that the unit of measure selection in this menu will also be
reflected elsewhere in the simulation (e.g., aircraft specifications, etc.).
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Window Menu-

This menu item activates or eliminates items from the display or window. For example, if you
were to click the Properties item in the pull-down menu, this would eliminate the Properties
window from the screen.

File Edit View Options Window

Folder Listing
Object Palette
Pilot Preview

Properties

Reset Window Positions

Folder Listing-

This listing includes all of the folders available in the airport editor. Selecting this item
from the pull-down menu will toggle the presence of the Folder Listing dialog.

Object Palette-

The Object Palette includes the complete selection of objects available in editing an
airport. Selecting this item from the pull-down menu will toggle the presence of the
Object Palette dialog.

Pilot Preview-

Selecting this item from the pull-down menu will toggle the presence of the Pilot
Preview dialog.

Properties-

Selecting this item from the pull-down menu will toggle the presence of the
Properties dialog.

Reset Window Positions-

This menu item resets the positions of the airport editing windows back to their
default locations. Additionally, if you have removed any of the default windows, they
will return to the screen at this time.
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Utilizing the Editor

Opening the airport editor reveals four distinct windows. For the purpose of clarity, we will
examine each window individually. It is, however, important to note that these windows
interact with one another.

Folder Listing Window-

The Folder Listing window consists of the folders and items (objects) that comprise the
currently selected airport.

Folder Listing X

[ Fight Schaol HD. A
{0 Objects
2L Buidings
9
-l Airplane Hangar
-l Airplane Hangar
= Fied
{3 Tents & Tables
-4 12 foot table
-l 12 foot table
-l 12 foot table
-l Streamer Cut Foamy
- Furion 450
-l Dynafite Super Decathlon
-l Tent - 05 Engine
-l Tent - Kinexsis - Blue
-l Tent - Spekirum - Black
- The Grome
-l Tent - FMS - Green
- 12 foot table
-l 12 foot tzble
-l Tent -Force RC - White
- Tent - Blads - White
-l 12 foot table
{3 Lights
{3 Fending
{3 Vehices
{:,J Epawning paints v

To determine what items are contained within the Objects and Clouds folders, click on the
[+] (plus) or double-click on the name itself (e.g., Objects). Doing so brings up the various
objects and sub-folders that are contained within the folder.

As denoted by the [+] (plus) symbols, these folders, in turn, also have another level. Again, to
open these respective levels, click on the [+] (plus) icon or double-click the folder name.
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Alternatively, clicking on an object in the scene will highlight the respective object. It will also
open the folder that contains the object. The converse is also true; clicking the folder or
object in the Folder Listing menu will highlight the respective item as well.

If you wish to move an object from one folder to another, mouse click and hold the object to
be moved. Next, drag the object to the desired location (folder) using the mouse and release.
The object will be listed at the bottom of the folder.

Please note: This action removes the object from the original folder.

You may use either of two methods to delete an object from the folder. First, you can
highlight the object or sub-folder in the Folder Listing and press the Delete key on the
keyboard. Second, with the object or sub-folder highlighted, right click and select the Delete
Object pull-down option.
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Properties Window-

The Properties window indicates the detailed information for the item highlighted in the
Airport Editor window. The contents of the Properties window may vary depending upon the
selection in the Folder Listing window.

The example below indicates what is displayed if the flying site’s root or top-level folder is
highlighted. Regardless of what is selected, the Properties are all very similar in nature and in
their method of modification.

Parameter Value

Tent - Spektrum - Black

Relative Position {m) ®*=-1,801, y=21.853, z=0

Object Mame Tent - Spektrum - Black

Object Location RealFlight 9.5

ZBoost a

Fade Out Start Distance {m) a

Fade Out End Distance {m) v}

Conform to Ground Mo

Collidable Yes

Cast Shadows Yes

Permitted to Cast Shadows Yes

Receive Shadows fes

Permitted to Receive Shadows Yes

Render to Depth Buffer Only Mo

Forced to Render to Depth Buffer Mo

Orientation {(deg) azim=0, incl=0, roll=0

Scale (%) 100

Height {m) 3.23

Width {m) 3.35

Length {m) 3.96

Material Plastic (Soft)

Absolute Position {m) ¥=1389.9, y=-840.949, z=1156.99

Object Type Static Scenery Object
£ >
Mame of the object. Folders whose names are preceded by an underscore
character are hidden from view outside of the editor unless made visible by
the Challenge system, a multiplayer event, or some other simulator feature.
Default: 'Tent - Spektrum - Black’ &

If an item has been modified, an icon will appear to the left of the Parameter name. Right
clicking the either the Parameter or the Value associated with an item will bring up the
Restore Original Value, Set to Default Value or Apply To options. The Apply To option is only
applicable to the items that relate to the aircraft spawn items or items that have siblings
associated with them accordingly.
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Object Palette Window-

The Object Palette window is used to add a new object or objects to the airport. The object
window consists of two separate sections: the preview box in the top section of the window,
and the objects list in the bottom section.

Object Palette x

----- ¥ Air Race Grandstand
----- a# Air Race Hangar
----- a# Aircraft Barn

----- a# Car Port
----- a# Car Port Double

Add

All objects are grouped according to their root directory. Within the root directory, the
grouping is further refined. For example, you will find all available benches in the Benches,
Chairs, and Tables group. This, of course, assumes that you are utilizing the Product, Type, or
Name as determined by the Add Object Grouping Selection in the Options menu.

Each object group is preceded with a [+] (plus) and an icon. The [+] (plus) indicates that there
is another expansion level, or selection, available to you. Clicking on the [+] (plus) or double-
clicking the respective root directory name (e.g., RealFlight 9.5) will bring forward the pull-
down menu of the items contained within the specified folder.

For example, if you wanted to add a bench to the current airport, take the following steps:
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1. Click on the [+] (plus) icon in front of the Benches, Chairs and Tables group (or, double-
click the group name itself). This reveals the next expansion level.

2. From the expansion list, select the ‘Bench’ object. The selected object appears in the
preview box.

3. Click the Add button, which adds the object to the scene.

You will find additional information pertaining to object placement, positioning, etc., in the
Properties section of this chapter, which follows.

You may use several available methods to change the location of an object in the airport. To
use the drag and drop method, click on the object to select. Once you have highlighted the
object, press and hold the mouse button. Move the mouse to the desired location, then
release the button to drop the object in the new location.

With the object highlighted, right click the mouse elsewhere in the scenery. This brings up a
pop-up menu with several options. To move the selected object, point the mouse to the
location that you desire and click the Move Here option.

RealFlight 9.5 also allows you to easily replicate the selected objects. To do so, hold the ‘Ctrl’
key down, click and hold the mouse button and use the mouse to drag the object to a new
location. You will see that the original object stays in place. Release the mouse button and
the ‘Ctrl’ key to drop the new item in place.

Once you have added an object to the airport, you can modify it freely. Refer to the
Properties Window — Object Selection section for information on how to do so.
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Pilot Preview-

This window provides you with the ability to view the scene from the pilot’s perspective. It is
very useful when editing PhotoField airports.

Flight Instructor x

The number of pilot perspectives available varies dependent upon the selected scene. For
example, RealFlight Ranch offers: Runway Center, Runway End and Helipad as the viewing
options. To select from these options, open the Control Objects in the Folder Listing. Use the
up/down arrow keys on the keyboard or the mouse to select the desired perspective.

It is also possible to modify the selected vantage points. For example, you may Zoom In and
Out, or simply scan the horizon. Note that in order to modify the vantage point, the Pilot
Preview window must be the active window. To ensure that the Pilot Preview window is the
active window, simply click on, or in, this window.

To zoom in, press the [+] (plus) key on the keyboard. To or zoom out, press the [-] (minus)
key on the keyboard.

In most cases, you can also use the scroll wheel on the mouse to zoom in and out on the
scenery.

RealFlight also allows you to scan the scene. To do so, press and hold the mouse button.
Moving the mouse will shift the scenery.
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Create New Airport

This menu enables you to create an entirely new airport, starting with a fresh canvas. The
FlexiField™ flying site editor provides you with virtually unlimited editing options, limited only
by your imagination.

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Airport...

Edit Eli Field

Create New Airport...
Sun

Thermals

Wind

Reset to Default

1. Flight School HD
2. Eli Field

Flight Modes (7.4
® SAFE: Beginner

The options available to you when creating an airport are identical to those found in the
section pertaining to the airport editor described previously. As such, we will avoid
duplicating these instructions. Instead, we encourage you to experiment with the options,
settings, and choices as you see fit.

After you have finished creating your airport, click the File menu and save the airport. The
airport name will appear in your Custom Airports folder in the RealFlight 9.5 directory.
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Sun-

RealFlight 9.5 gives you the ability to adjust the position of the sun in the sky. By changing the
Azimuth, you can rotate the sun around. Change the Inclination to adjust how high in the sky
the sun should be, or turn day into night by moving the sun below the horizon.

# RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Select Airport...

Edit Eli Field

Create New Airport...

Sun Azimuth
Thermals Inclination
Wind
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Please note, the sun settings are not applicable at PhotoField flying sites.
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Adjusting the Sun Azimuth-

If you customize an airport and find that the sun is always in your flight
path, adjusting the sun’s azimuth is a good way to move it around the

sky, out of your way. m H

To adjust the azimuth, select the Sun menu. This will bring forth the

Azimuth and Inclination options. Highlight the Azimuth menu item in the pull-down
selections. To rotate the sun to the right, click Increase. Clicking Decrease will rotate the
sun to the left.

Shift Home

When altering the azimuth, the simulation temporarily displays the new location in the
lower left corner of the window.
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Adjusting the Sun Inclination- Page

Shift Up

To position the sun higher in the sky, or set it below the horizon, modify
the inclination. Page
Down

To adjust the inclination, select the Sun menu. This will bring forth the Azimuth and
Inclination options. Highlight the Inclination menu item in the pull-down selections. To
raise the sun higher in the sky, click Increase. Click Decrease to lower the sun, or to set it
below the horizon to make it night time.

When altering the inclination, the simulation temporarily displays the new location in the
lower left corner of the window.

At night time, RealFlight 9.5 will automatically enable lighting effects on the objects and
aircraft that offer the lighting abilities.
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Thermals-

Thermals add to the realism in the RealFlight environment. A thermal is a column of rising air
that is hotter than the surrounding air. Thermals affect all aircraft, but they are most
important to gliders and soaring aircraft, as thermals assist them in obtaining additional
altitude and potentially increasing flight duration.
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RealFlight 9.5 offers two types of thermals.

Dynamic-

Dynamic thermals are most realistic. These thermals can appear anywhere in the
environment, just as they would in the real world. The simulation will automatically generate
thermals when the Dynamic setting is selected.

Simple-

Unlike dynamic thermals, these type of thermals are static or stationary and do not move
around the environment. Only the thermals that were designed into the airport are active.
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Wind-

RealFlight 9.5’s TruFlo Wind Dynamics offers an incredibly realistic wind model. Its
components work together to capture this complex, ever-changing force with unbelievable
realism. Just as it would at the field, your model will encounter a variety of wind forces as it
soars across the skies in RealFlight. Sailplane enthusiasts will appreciate the lifelike effect of
the winds as they follow the drafts on the slopes and hills of RealFlight 9.5.
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RealFlight offers you the ability to adjust the speed, direction, and turbulence of the wind. To
access the Wind settings, click on the Environment menu, followed by the Wind menu item.
Several methods may be utilized to adjust the wind speed and direction.
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Adjusting the Wind Direction-
Home
RealFlight 9.5 allows you to alter the direction (expressed in degrees) of the wind. This
function is perfect for practicing crosswind landings.
End

Selecting the Wind menu item brings up the Speed, Direction, and Turbulence options.
To adjust the wind direction, highlight the Direction menu item in the drop-down
selections. To increase the degree of wind direction, click on the Increase option in the
drop-down selections. Likewise, clicking the Decrease option lowers the degree of wind
direction. The wind direction degree increases and decreases in 15-degree increments.

When altering the wind direction, the simulation temporarily displays the new wind
direction, in degrees, in the lower left corner of the window.
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Page | Adjusting the Wind Speed-

Up . . . . . .
Increasing the wind speed is an ideal way to learn to fly in less-than-perfect wind

Page conditions that frequently occur at an RC field. To adjust the speed of the wind, select

Down the Wind menu. To adjust the speed of the wind, highlight the Speed menu item in the
pull-down selections. To increase the speed of the wind, click on the Increase option in
the pull-down selections. Clicking the Decrease option reduces the wind speed.

When altering the wind speed, the simulation temporarily displays the new wind speed
in the lower left corner of the window.
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Adjusting the Turbulence-
Insert
Increasing the turbulence is another ideal method for learning to fly in challenging
conditions. Modelers and full-scale pilots alike will all agree that winds are not constant.
Delete This setting accurately reflects the lifelike effects of turbulence.

To adjust the turbulence, select the Wind menu, and highlight the Turbulence menu
item in the pull-down selections. To increase the speed of the turbulence, click on the
Increase option in the pull-down selections. Clicking the Decrease option reduces the
turbulence.
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Reset to Default

Selecting Reset to Default will adjust all weather and environment parameters back to their
default settings for the currently selected flying site.
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Airport MRU

If you have previously selected an alternative flying location, or locations, you will note that it
will appear on a list in the Simulation menu. This list is at the very bottom of the menu and is
commonly referred to as a Most Recently Used, or MRU list. It is limited to the eight most
recently selected locations. If you wish to fly at one of these locations, simply click on the
respective location and it will begin loading.
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Chapter

8

Challenges Menu

TEST AND IMPROVE YOUR FLYING SKILLS WITH EXCITING PILOT
CHALLENGES.

he Challenges menu allows you to practice and improve your flying skills while adding
some excitement and fun along the way. There are a variety of challenges available
with rewards that unlock as you complete more difficult levels.
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Clicking Select Challenges menu item will display the following screen:

All Airplane Heli

Air Race

(o

'.v;*“'t' Balloon Burst

Pop all the bal

FPV Drone Racing

{\
& Pilot an FPV Racing Drone through an introductor

B Grapple

Lift and move object

A number of options are available to you from this screen. The most obvious is the list of the
different types of challenges available (Air Race, Balloon Burst, etc.). Displayed with each
Challenge are any medals that you might have won, along with your progress.

Along the top, you will see your current score tally for Airplanes, Helis, and Drones as well as
a cumulative total.

Filter-

Along the header are the filter options for the challenge list. If, for example, you wish to view
only the challenges that require flying a helicopter, click Heli in the Filter section. Similarly, if
you wish to focus on the Drone challenges, simply click on the Drone tab accordingly.

Settings/Ghost Run-

Once you have completed 10 levels of any Challenges, you are then allowed to compete
against your best times. You’ll notice a ghosted image of an aircraft flying through levels you
have already completed. This ghosted aircraft represents your best time for that level, giving
you something to compete against.

The gear icon in the upper right corner of the challenge window gives you the ability to
enable or disable the Ghost Run feature. Simply click the gear icon, then check or uncheck
the Ghost Run option.
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Air Race

Air Race challenges will put your aerobatic flying skills to the test while timing your
proficiency. You will be given any number of gates that you must fly through.

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Time Gates Countdown

:10.58 /2 03:50

! Up Next: Gate 2 _ w2
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As you improve, the level of difficulty increases. More gates, more aerobatic aircraft, and
strict aircraft orientation through the gates will be added. Points are awarded based on the
time it takes you to complete the course.

As you complete levels, more levels will become available. Scoring enough points may award
you with a new medal, more challenges, or even more aircraft to fly in RealFlight.
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Balloon Burst

Flying from a chase camera, you’re required to pop all the balloons at the field. The faster
you can do this the more points you will earn.

#* RealFlight
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As more difficult levels become available, you may be required to fly different aircraft or
forced to search for hidden balloons.
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FPV Drone Racing / FPV Racing League

Drone racing has gained incredibly popularity in recent years and can even be seen on major
television networks. While many modelers won’t be able to race at that level of
involvement, the simulation offers a drone racing experience for anyone to enjoy.
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From the aircraft’s point of view, fly through a course of gates. Each level requires quicker
reactions from more aerobatic aircraft, on more difficult courses.

Points are awarded by how quickly you can fly through the course.
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Grapple

For those that wish to test their skills at flying rotor aircraft, the Grapple challenges are a
must.
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Using the Switch C on the InterLink DX, or channel 5 on your radio, you will be able to pick up
objects and release them. Each level will require different tasks for you to perform. Points
are awarded based on how quickly you can complete each level.
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Hangar Obstacle Course

Navigate amongst the obstacles in the hangar using Horizon’s SAFE technology to stabilize
the aircraft. As the levels increase, the number of obstacles increase, also.
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Limbo

A true pilot isn’t recognized until they can prove themselves with high-speed low passes. The
Limbo challenges can test who has the guts to get low and fast.
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As you progress to more difficult levels, you may find objects in your way, more aerobatic
aircraft to fly, or even inverted flight requirements. Like many other challenges, points are
awarded based on the time it takes to complete each level.
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Quadcopter Trials

You think you have what it takes to fly a Quadcopter? Then the Quadcopter Trials will test
your skills.
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You'll be walking and following a quadcopter through a number of obstacles. Some you must
fly through, while others are platforms you must land on.

Scoring is best on how quickly you can fly through each level. Do well through this challenge,
and you’ll be rewarded at the end.
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Ring Race

For the real thrill seekers, try jumping into the cockpit and try your hand at Ring Race.
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From the aircraft’s point of view, fly through a course of rings. Each level requires quicker
reactions from more aerobatic aircraft, on more difficult courses.

Like many of the other challenges, points are awarded by how quickly you can fly through
the course.
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Scavenger Hunt

Flying multi-rotor aircraft from First Person View has become a popular past time. Now you
can try your hand at doing so, and testing your skills at the same time with the Scavenger
Hunt Challenge.
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With each level, you must locate objects around the flying site that are highlighted in a red
box. Fly to them closely, and hold that object inside your targeting circle. Once held there
long enough, a picture will be snapped by your on-board camera. At that point, you must
find the next object.

Scoring is provided based on how quickly you can find and snap a picture of each object. Try
capturing your pictures in different order, finding the best path, to increase your time.
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Spot Landing
As the old saying goes, “Takeoffs are optional, landings are mandatory.” How well can you
land?

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Time Countdown

:20.19 01:40

With the Spot Landing challenge, you must be able to land accurately on a target on the
runway. The closer to the center of the target you land the more points you will be awarded.
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Locked Challenges

You will also note that RealFlight 9.5 includes a number of challenges that are locked
and grayed out initially. If/when you complete the existing challenges and have earned
enough points/medal to do so, these challenges will unlock accordingly.

Filter: =~ All Airplane Heli

- &= Spot Landing

Air Race |l

Earn a medal in the 'Air Race' challenge to unlock

Balloon Burst Il

Earn a medal in the Balloon Burst' challenge to unlock

FPV Drone Racing Il

Earn a medal in the FPY Drone Racing' challenge to
unlock

During Flight

While competing in a challenge, a number of statistics and data are available to you. First, in
the upper left corner is information pertinent to the current challenge. For example, this is
the area where the event timer is found as well as the remaining time to complete a
particular level/challenge. Additionally, an onscreen indicator as to the remaining gates,
balloons, etc. may be found in this area, depending upon the challenge selected. If you are
participating in an Air Race Challenge, this area will also indicate the number of the next gate

through which you must pilot your aircraft.

The right side of the screen also contains information that is useful to challenge participants.
The banner contains two icons (and text) that will allow you to:

e Pause — As the name implies, this will pause your flight. Click the Resume button that
is now visible to continue.
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e Restart — Clicking this will return you to the Begin screen where you can view your
current high score, description of the current challenge, or return to the level
selection screen.

Depending upon the challenge selected, you might also see a ‘map’ indicating visually where
the next gate that you must conquer is located.

Pre-Flight Information

After you’ve selected a challenge and determined the level that you would like to attempt, a
screen similar to the following will appear.

This screen allows you to select an alternative level (Level Select), read the information as to
what is to be accomplished within a given challenge (Instructions) and to start your adventure
(Begin!).

Resume Existing Challenge...

If you wish to return to the most recently used challenge (and level), simply click this option.
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Chapter

9

Gadgets Menu

THE GADGETS MENU IS USED TO DETERMINE ANY ONSCREEN INDICATORS,
AUDIO INDICATORS AND OTHER SUCH GADGETS THAT WILL ASSIST THE
PILOT DURING FLIGHT.

he Gadget menu allows you to select amongst a wide variety of options that you might
find useful during flight.

A Gadget is an on-screen display that provides you with information pertaining to a certain
aspect of your simulation experience. To access the Gadgets menu item, click the Gadgets
menu title. This will open the list of available gadgets for the simulation.

o
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Simulation  Aircraft

Radio Mode (gadget only)

FHight Modes oXx
® SAFE+: Beginner

Radio Mode (gadget only)-

This option allows you to change the Mode in which the on-screen radio is displayed. For
example, if you prefer to fly with the throttle and rudder on the left stick, and ailerons and
elevator on the right stick, then you fly Mode 2. Some modelers prefer Mode 1. In this mode,
the left stick controls the rudder and elevator; the right stick controls the throttle and
ailerons.

Hight Modes ox
® SAFE+: Beginner

Whichever mode you fly, you will want the on-screen radio to match. Select Radio Mode
(gadget only) to show the list of available radio modes. Click the mode that is appropriate for

you.
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’ NavGuides

A NavGuide is an on-screen display that allows you to view some basic information
pertaining to your aircraft. If you wish to alter the contents of the NavGuide, please refer to
the Edit NavGuides... section later in this chapter.

NavGuides C} 7)(

0MPH
11t

1441 RPM
Wind: 0 MPH

To access the NavGuides, click the Gadgets menu title, followed by the NavGuides menu
item.

You may also load the NavGuides using the InterLink DX with the
QuickSelect buttons. Press the Scroll Wheel/Select button. Then
use the roller to highlight the NavGuides tab. The NavGuides tab
looks like an aircraft gauge. Press the Scroll Wheel/Select button
again to activate the NavGuides. Repeat these steps to remove the
NavGuides from the screen.

When the NavGuides are active, an overlay screen will appear on your display. This screen
displays the NavGuides information to you.

If you do not wish to view this information, double-click on the title bar of the display box.
This hides the information. To view it once again, simply double-click the title bar.

Clicking the Gear icon in the title bar will open the NavGuide settings and options. See page
219 for more information.

Clicking on the ‘X’ in the title bar of the frame will remove it from the screen entirely.
Items included by default in the NavGuides are the following:

Airspeed-
This option displays the airspeed of the aircraft.
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Altitude (ASL)-

This option displays the altitude for the respective aircraft above sea level. Even
though the aircraft may be taxiing on the runway, the altitude may reflect hundreds
or thousands of feet, if applicable.

Battery/Fuel Remaining-

This indicates of the amount of battery mAh or fuel that remains for your aircraft at a
given moment. This value will decrease throughout the longevity of the flight.

Graphics Frames/Sec-

This is an abbreviated version of Frames per Second, or FPS. While the data displayed
is not relevant to your aircraft, it is used to provide you with feedback on how your
computer is performing at any given time. The higher the frames per second, the
smoother the simulation will appear.

RPM-

This option indicates the current revolutions per minute, or RPM’s, for the engine.

wind-
This option displays the current wind speed at the flying site.
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E Radio

The on-screen radio display is useful for many facets of flight. For example, when used in
conjunction with recordings, this allows you to see real-time control input from the original
pilot. Observing the link between controller movements and aircraft performance will
advance your knowledge and understanding of a maneuver.

[¥] [u]) () o) 20

ChthS Ch8 ChT Ch8 Ch9

To access the Radio, click the Gadgets menu title, followed by the Radio menu item.

You may also load the Radio using the InterLink DX with the
QuickSelect buttons. Press the Scroll Wheel/Select button. Then
rotate the scroll wheel until the Radio tab is highlighted. Press the
Scroll Wheel/Select button again to activate the on-screen Radio.
Repeat these steps to remove the Radio from the screen.

If you click the on-screen radio, the entire viewport is displayed, including the title bar.

To resize the viewport, position the cursor over the lower right corner of the viewport’s
frame. Using the mouse, drag the frame according to your wishes. If you drag it downward,
the vertical size of the viewport will increase. Dragging the frame to the right or left increases
or decreases the width of the viewport respectively.

Clicking on the ‘X’ in the title tab of the frame removes the radio gadget from the screen.

RealFlight 9.5 RC Flight Simulator




u Binocular

The Binocular option will show a perfectly zoomed aircraft, as if you were looking through a
pair of binoculars. The background of the viewport box becomes transparent. This provides a
visual indicator alerting you that you are using “binocular vision.”

k4 Binocular
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The Binocular option is a great way to see the control surfaces on an aircraft that is too far
away to see in the main view. Although not realistic, it does help to see the effects of control
input.

By default, the Binocular view will automatically hide when the aircraft is close enough to be
seen in the main window. When it does so, the Binocular icon will be visible to indicate that
this gadget is still active. The view will reappear when the aircraft flies off into the distance. If
you wish for the Binocular view to remain on the screen permanently, simply click the
thumbtack button in the gadget’s title bar.

To access the Binocular menu item, click the Gadgets menu title. Next, click Binocular.

You may also load the Binocular viewport using the InterLink DX
with the QuickSelect buttons. Press the Scroll Wheel/Select
button. Then rotate the scroll wheel until the Binocular tab is
highlighted. Press the Scroll Wheel/Select button again to activate
the Binocular viewport. Repeat these steps to remove the
Binocular viewport from the screen.

To adjust the size of the viewport, position the cursor over the arrow indication found in the
lower right corner of the viewport’s frame. Click and hold on the arrow. Using the mouse,
drag the frame according to your wishes. If you drag it downward, the vertical size of the
viewport will increase. Dragging the frame to the right or left increases or decreases the
width of the viewport accordingly.

Clicking on the ‘X’ in the title tab of the frame removes the frame from the screen.
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Viewport

The Viewport menu item allows you to open up a smaller window so you can adjust
independently from the main simulator screen. This works much like a picture-in-picture
feature found on many TVs.

## RealFlight
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Once you create a new viewport, you can adjust the size or reposition it by dragging with
your mouse. You can also fully adjust all the viewport’s properties (zoom level, vantage point
options, etc.), independent of any properties of the main window.

To access the Viewport menu item, click on the Gadgets menu. Then select Viewport.

You may also load the Viewport using the InterLink DX with the
QuickSelect buttons. Press the Scroll Wheel/Select button. Rotate
the scroll wheel until the Viewport tab, pictured with a computer
monitor, is highlighted. Press the Scroll Wheel/Select button again
to activate the Viewport. Repeat these steps to remove the
Viewport from the screen.
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To change the vantage point options and features, use the commands found in the View
menu. Ensure that the viewport you wish to modify is the active viewport, or the
modifications will not take effect. Alternatively, you may click the left or right arrows that
appear at the bottom of the Viewport.

Note that some camera angles are not available at PhotoField airports. The Viewport will
display static if these cameras are chosen. Additionally, a Warning will appear within the
Viewport noting that this camera selection is not supported. To utilize these camera angles,
switch to a flying site that is not a PhotoField.

Clicking on the ‘X’ in the viewport’s title bar removes it from the screen.
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ﬂ Variometer

A variometer is an instrument designed to indicate the rate of climb or descent of an aircraft.
The variometer is useful to pilots flying powered aircraft so they can ascertain that level flight
is maintained. This is useful during turning maneuvers. Glider pilots typically make the most
use of a variometer, to help determine the areas of rising or sinking air currents.

Variometer

To access the Variometer, click the Gadgets menu title, followed by the Variometer menu
item.

The variometer available in RealFlight also offers an audio indicator, much like the real
instrument. As the rate of climb increases, the pitch in the audio tone will increase, as well.
The opposite holds true, as the descent of the aircraft increases, the pitch in the audio tone
decreases accordingly.

If you wish to turn off the audio queues, click the button with the speaker symbol in the
lower right corner on the variometer. To turn the audio back on, click the button once again.

The variometer in RealFlight 9.5 is split into two parts. The left side of the variometer
includes a status meter which indicates whether the aircraft is ascending, descending or
maintaining level flight. If the bar is in the green, the aircraft is rising. If it is in the red, then
the aircraft is descending. If it remains stationary in the middle, the aircraft is maintaining its
existing altitude. The farther the bar moves from the center, the faster the rate of change in
altitude. On the right, there are three readouts that offer the following information:

e Rate —This indicates the rate of change in altitude.

e ASL-This shows the altitude above sea level.
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e AGL-This indicates the altitude above ground level.

Clicking the Variometer viewport will display the title bar and frame. Clicking on the ‘X’ in the
title tab of the frame removes the frame from the screen.

Multiplayer

This gadget enables the Scoreboard, which offers a wealth of information about all the
players connected to the multiplayer session, as well as details on the current game (if one is
in progress).

For more information about the Scoreboard, see page 246.

Overhead

To help you track your location relative to the airport, use the Overhead gadget. This gadget,
as the name suggests, gives you an overhead view of the airport with a small airplane picture
representing your aircraft.

Overhead

During multiplayer sessions, the Overhead gadget will show the location of all players. The
color of the airplanes will match the color chosen in the Pilot Profile.

Note that the Overhead gadget is not available at PhotoField airports.
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H Timer
The Timer gadget is a simple stopwatch to offer timing functions. This is especially useful for
sailplane pilots that wish to time the duration of their flights.

Clicking the Start/Stop button on the gadget will start and stop the timer. Reset will set the
timer back to zero.

You may also change how the timer starts and stop. See Timer Settings below for more
details.
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B Heads-Up Display
The Heads-Up Display (HUD) projects an FPV (First Person Video) or combat jet-like display

over the screen that provides useful data in real time.

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

il -0.0 m/s

——100

Flight Modes (7.4

® SAFE: Intermediate

Hom X Pisal

Information displayed by location on screen:
e Upper left — Fuel Remaining
e Top center — Heading
e Upper right — Variometer; the rate of climb or descent.
o Leftside— Airspeed

e Center — Pitch ladder, showing the aircraft’s pitch and roll in relationship to the
horizon.

e Right side — Altitude
e Bottom center — Direction and distance to your starting location.

While the HUD can be displayed at any time, it's most useful when flying from the cockpit or
nose views.
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m Quick Load...
The Quick Load gadget allows you to rapidly search and select a new aircraft or flying site.
Select Quick Load from the Gadgets menu, or press ‘Ctrl + F’ to display the following gadget:

Quick Load X

- E-flite Habu =
=& E-flite Habu
=& E-flite Habu 5

=& E-flite Habu STS T0mm EDF (45

Cancel

To begin your search, begin typing the name of the aircraft or airport you wish to load. As
you type, any aircraft or airport that is installed (including Expansion Packs) that match what
you type will begin to appear. The more precise the search word, the narrower the selection
of rows available. Select the aircraft or airport you wish to load, and then click OK.
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Close All

This menu item closes all open gadgets. It offers the user an easy method to clean up the
screen without having to close each gadget separately.
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Edit NavGuides...

This menu item allows you to modify the data and display of the NavGuides box.

To access the Edit NavGuides feature, click the Gadgets menu title, followed by the Edit
NavGuides... menu item. Alternatively, clicking on the ‘gear’ of the on-screen NavGuides will
open the edit screen also.

Edit NavGuides X

Aircraft P - Airzpeed
eed This iz how fast the aircraft is moving.
itude [AGL)
Altitude [A5L)
[ Adkitude [ATL)
[ Adtitude [&w/L) Colar

[ G Farce
[ G Force Total (®) Default () Custom

[ Graund Speed

[ Heading Gadget Options
L Pitch Rate tManage MavGuide item vizibility automaticallp
] Roll Rate [e.g. hide heli items when flying an airplane)
[ Time Since Reset
[ % Position of Aircraft Gadget Text (@) Smal O Large
[ ¥ Pasition of Aircraft
1 *¥aw Rate
Helicopter o Restore Defaults Catcel

Modifying the NavGuides-

To add any of the options from the top list to the NavGuides display, click in the
checkbox next to the respective item.

The pane below the list of the Edit NavGuides dialog box contains a description of the
item when selected or highlighted.

The NavGuides available are listed in the following table:

Option Description

Aircraft: Airspeed Check this item to display the current airspeed of the
aircraft.

Aircraft: Altitude (AGL) Check this item to display the current altitude of the
aircraft above ground level.

Aircraft: Altitude (ASL) Check this item to display the current altitude of the
aircraft above sea level.

Aircraft: Altitude (ATL) Check this item to display the current altitude of the
aircraft compared to the terrain below. This option does
not account for water.

Aircraft: Altitude (AWL) Check this item to display the current altitude of the
aircraft above the body of water at the airport.
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Aircraft: G Force

Check this item to display the gravitational load that the
aircraft is experiencing as felt by the pilot.

Aircraft: G Force Total

Check this item to display the gravitational load that the
aircraft is experiencing in any direction.

Aircraft: Ground Speed

Check this item to display the current ground speed of
the aircraft.

Aircraft: Heading

Check this item to display the current heading of the
aircraft. This heading is displayed in degrees, as they
would appear on a compass. “0” degrees is North, “90”
degrees is East, “180” degrees is South and “270”
degrees is West.

Aircraft: Pitch Rate

Check this item to display the current rate of pitch for
the aircraft.

Aircraft: Roll Rate

Check this item to display the current rate of roll for the
aircraft.

Aircraft: Time Since Reset

Check this item to display the amount of time that has
elapse since the last time the Reset button has been
pressed.

Aircraft: X Position of Aircraft

Check this item to display the current X position of the
aircraft.

Aircraft: Y Position of Aircraft

Check this item to display the current Y position of the
aircraft.

Aircraft: Yaw Rate

Check this item to display the current rate of yaw for the
aircraft.

Helicopter: Main Rotor RPM

Check this item to display the current main rotor RPM of
the helicopter.

Helicopter: Tail Rotor RPM

Check this item to display the tail rotor RPM of the
helicopter.

Engine: Battery Remaining

Check this item to display the remaining capacity in the
battery pack.

Engine: Current Draw

Check this item to display the amount of current that the
motor is draining from the battery pack.

Engine: Energy % Remaining

Check this item to display the amount of fuel or battery
charge remaining, as a percentage.

Engine: Fuel Remaining

Check this item to display the amount of fuel remaining.

Engine: Motor Efficiency

Check this item to display the efficiency of the electric
motor.

Engine: Power In

Check this item to display the amount of power being
transferred to the electric motor.

Engine: Power Out

Check this item to display the amount of power being
generated by the engine.

Engine: RPM

Check this item to display the RPM’s of the engine.
Please note: This measurement does not take into
account any gear reduction which might be utilized.

Engine: Voltage

Check this item to determine the voltage across the
electric motor.

Environment: Wind Direction

Check this item to display the direction that the wind is
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blowing.

Environment: Wind Speed Check this item to display the velocity of the wind at the
current time.

Environment: Wind Updraft Check this item to display the velocity of the wind in the
upward direction.

Pilot: Distance to Aircraft Check this item to display the current distance from the
pilot to the aircraft.

Pilot: Field Of View Check this item to display the field of view angle for the
main window.

Pilot: Height (AGL) Check this item to display the height of the pilot above
the surface below, water or ground.

Pilot: Height (ASL) Check this item to display the height of the pilot above
sea level.

Pilot: Height (ATL) Check this item to display the height of the pilot above
the terrain, not including any body of water.

Pilot: Height (AWL) Check this item to display the height of the pilot above

the body of water at the airport.

Pilot: Look Direction Check this item to display the compass direction in
which the pilot is looking.

Pilot: Zoom Magnification Check this item to display the amount of zoom being
utilized; 1 is equivalent to normal eyesight.

System: Graphics Frame Rate Check this item to display the number of times the
screen updates per second.

System: Physics Frame Rate Check this item to display the number of times the
physics system updates per second.

Color-

This setting allows you to adjust the Color for the selected item when displayed in the
NavGuide gadget. To select an alternate Color, first click the Custom option, and then
click on the color swatch. This will open the color palette dialog and you may choose
an alternate color for the item.

For example, highlight the Graphics Frame Rate in the NavGuides listing. Next, click
the color swatch and select the desired color. The Graphics Frame Rate will now be
indicated in the desired color.

Gadget Options-

The Gadget Options panel found at the bottom of the Edit NavGuides dialog affects
all checked NavGuide options, not just the currently selected item.

Some NavGuide items are not relevant to the aircraft you are flying. For example,
Fuel Remaining is not pertinent to an electric aircraft. In this case, you might check
both Fuel Remaining and Battery Remaining, and then check the box labeled
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Manage NavGuide item visibility automatically. RealFlight will then automatically
hide the NavGuide item from the gadget that doesn’t relate to the currently selected
aircraft.

As the name suggests, the Gadget Text allows you to set the font size of the text on
the NavGuide to either Small or Large.

Restore Defaults-

The Restore Defaults button returns all NavGuides to their default values and
options.

Radio Mode (gadget only)-

This option allows you to change the Mode in which the on-screen radio is displayed. For
example, if you prefer to fly with the throttle and rudder on the left stick, and ailerons and
elevator on the right stick, then you fly Mode 2. Some modelers prefer Mode 1. In this mode,
the left stick controls the rudder and elevator; the right stick controls the throttle and
ailerons.

#* RealFlight
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Timer Settings

Whichever mode you fly, you will want the on-screen radio to match. Select Radio Mode
(gadget only) to show the list of available radio modes. Click the mode that is appropriate for
you.
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Timer Settings-

This option allows you to change how the Timer gadget operates. Instead of manually
clicking the Start/Stop or Reset buttons with the mouse, it is possible for RealFlight to control

these for you by linking them.

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

NavGuides
Radio
Binocular
Viewport

Variometer

Multiplayer

Overhead

Timer

Heads-Up Display
Flight Modes
Quick Load

Close All

Edit NavGuides...
Radio Mode (gadget only)
Timer Settings

e

(=T = B~ T~ I L PR )

Reset Timer on Reset
Start/Stop with Throttle
Mute Notification Sounds

e Reset Timer on Reset — When enabled (a checkmark will appear next to the menu
item), the Timer gadget will reset to zero whenever you reset the aircraft.

e Start/Stop with Throttle — With this enabled, the Timer gadget will start when the
throttle is increased. When the throttle is at idle, the Timer gadget will stop. The
timer is cumulative, however, assuming that the model is not reset. For example, if
you land at 1:00 and close the throttle and then decide to take off once again, the
Timer will start from 1:00 and count upwards.

e Mute Notification Sounds — Enable this menu option if you would like the Timer
gadget to eliminate timer sounds.
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Chapter

10

Multiplayer Menu

FLY WITH FRIENDS, AT THE SAME COMPUTER, OR OVER THE INTERNET.

he Multiplayer option allows you to fly with many other RealFlight users. These pilots
can be across the street, around the block, or around the world!

There are two ways to link up with the additional pilots: via a LAN (Local Area Network), or
over the internet. In order to do so, you will need a TCP/IP connection either through your
LAN or an ISP (Internet Service Provider).

Every session requires someone to serve as host. The host initiates the multiplayer session.
When the Host starts a session, other participants may join in.

The Multiplayer menu allows you to access a variety of multiplayer-related features,
functions, and options. Clicking the Multiplayer menu brings forth a pull-down menu which
will look similar to the following screen shot:

Aircraft  Envi halleng: Gadgets Multiplayer Recordings Training View Help
Pilot Profile...

Join..,

Host...
Disconnect
Host Options
Scoreboard...
Server Details...
Game Help...
Game Gadgets
Select Target
Simulation Sounds
Voice Chat
Text Chat

Enter MultiMode

Fight Modes
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Some of these items will be grayed out or disabled if they do not apply to the current
situation. For example, you cannot disconnect unless you are currently connected. As such,
the Disconnect menu item is grayed out unless you are in a multiplayer session.

When you participate in a multiplayer session, the menu commands you will access depend
on whether you are the host or whether you opt to join someone else’s session. These
commands also depend upon whether you already have a specific session you want to join.

It is possible to participate in a public session using our List Server. The List Server is a publicly
available list of open RealFlight sessions. Currently, we provide the List Server to all RealFlight
owners, free of charge. The List Server allows you to participate in multiplayer sessions with
other RealFlight users anywhere in the world.

IMPORTANT INFORMATION ABOUT THE LIST SERVER: At the time of this writing we are
providing the List Server service on a trial basis. This service may be modified, interrupted,
or canceled at any time without notice. In particular, we make no guarantee about the
reliability of this service. To use this service, you may need to obtain product updates.
Mention of the List Server in this manual does not imply that this service will be available
at the time you purchase this product. Moreover, we reserve the right to bar any individual
user, or all users at individual IP addresses or domains, from using the list server at our
discretion. Abusive behavior, for example, will not be tolerated.
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Important Multiplayer Connectivity Tip: Port Forwarding-

If you are connected to the internet behind a router (cabled or wireless) or software firewall,
you may need to open up access to a certain range of port numbers before RealFlight can
successfully connect for multiplayer gameplay.

Please Note: If you are unfamiliar with how to set up port forwarding on your router device
and/or software firewall product(s), please refer to the supporting documentation
(installation guide, user's manual, etc.) that came with the networking hardware or software
you are using, or you may also try contacting the manufacturer's technical support for those
products.

For RealFlight multiplayer gaming, by default the following port ranges must be forwarded to
the client IP under the UDP traffic protocol:

61234-61241

You may adjust this range in the RealFlight Settings dialog window. See section on
page 116.
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Pilot Profile

The Pilot Profile allows you to customize the information about yourself. This information is
available to other pilots during multiplayer sessions.
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The Pilot Profile will also display the first day you ran RealFlight 9.5 (shown as your License
Date), and keep track of the number of days, hours, and minutes you have spent flying the
simulator (shown as Hours Logged).

Pilot: Profile

Name
markdwilliams1 205
L o¢

Hoffrman Estates

REALFLIGHT PILOT LICENSE

Elying is in my blood!

cancel
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The items that you may change for the Pilot Profile are as follows:

e Avatar—The image on the left-hand side of the profile is your avatar. An avatar is a
graphical representation of one’s self commonly used on the internet. RealFlight allows
you to choose from a variety of avatars in your Pilot Profile. To do so, click on the avatar
to display arrows at the bottom of the image. Clicking either arrow will cycle through the
different avatars that are available. To select an avatar, click Apply. Alternatively, click OK
to exit the Pilot Profile.

e Name - DVD and Tower Hobbies Digital versions of RealFlight also allow you to select a
name for use in the simulation. Click the field below the Name label and type the name
you wish to appear. Steam versions of RealFlight use your Steam user profile name
(unsupported characters are automatically removed).

e Location — RealFlight 9.5 also allows you to enter your location. Click the field under
Location to edit this information.

e Favorite Color — Click either arrow next to the color to pick your favorite color. This color
will be used for your avatar background, streamers, and paintballs during multiplayer
sessions.

e Tagline — Edit this field to display a short line about yourself, or use it to taunt your fellow
pilots.

e Additional Information — The field at the bottom allows more room to add any additional
information you wish to share.

As noted previously, the Pilot Profile is visible to other pilots during multiplayer sessions. Do
not enter any personal information in the Pilot Profile that you are not comfortable sharing
with other pilots.

Upon completing the Pilot Profile, click OK to retain these settings and close the window.
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Join
This option allows you to participate in a Multiplayer session without being the Host of the
session yourself.
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To access the Join... menu item, click on the Multiplayer menu followed by the Join... menu
item.

Before you can join a session, you will need a network connection.
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Join Session-

This dialog allows you to select the multiplayer session that you wish to join. It also provides
a variety of information pertaining to the various sessions available.

Join Session

Server List Refresh
Server Airport Game Players Latency Password
Lost Vegas Wacky Fun Fly Waco Field Mone /8 MHone
DuduRC's Session! Evergreen Airport Naone 2/20 226 MNone
Florida SunShine Fly 4 Airports Florida FunPort International Mone 1/8 192 Mone
YOLTAGE RC WORK IN PROGRESS 3 MNone 4/32 84 MNone
RF Brasil “Waco Field Naone 3425 257 MNone
il Waco Field Mone 243 171 Required
Team Wobbly Leg Gold Country Aeromodeler Park. Mone 2/8 175 MHone
NY'C Free Fly FPY Racing Site None 1/15 98 Mone

Fier Servers | >>

Search The:
Inernet v Cancel
Server-

The Server column displays the names of all available sessions. If you have not
searched for (and found) a session, this column will remain blank.
Airport-

This column shows the currently selected airport being utilized by the host.

Game-

If there is a game in progress, this column shows the game that is currently running.

Players-

This column indicates how many players are participating in a given multiplayer
session. It also indicates the maximum number of participants allowed for the
session. The host determines the number of allowable participants.

Latency-

Latency is the amount of time it takes a packet of information to travel from its
source to the destination. The larger the number, the slower the information travels.
High latency can result in sluggishness and “lag” while running the simulation. As
such, you will want to avoid sessions where the latency number is high.
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Password-

This column indicates whether or not a password is required to join a particular
multiplayer session. This allows the host to maintain a private session for friends,
family, etc.

Search-

The bottom left corner displays a drop-down selection box indicating the location
that you wish to search for multiplayer sessions. RealFlight will search the List Server
(Internet) or the Local Network (LAN) for multiplayer sessions.

To determine the Search area, click the down arrow. This activates the pull-down
selections. Click on the location that you wish to search.

After making your selection, RealFlight will automatically search for multiplayer
sessions at the desired location. When the search completes, the available sessions
and information appear in the server list dialog box above. To select one of these
sessions, click on the respective session and then click Connect. Alternatively, you
may double-click on the Session Name to join.

Please note: If a multiplayer session is private, RealFlight 9.5 will ask for a password in
order to join. If you know the password for the session, enter it now.

Refresh-

To repeat the search for multiplayer sessions, click the Refresh button located in the
upper right corner of this dialog window.

Also, if you are using an updated version of Windows Vista or Windows 7, you may
have Windows Firewall installed and running. If this is the case, Windows Firewall
warning dialog may appear (similar to that shown below) the first time you use the
Search function. You must select the Unblock or Allow Access option in order to allow
RealFlight 9.5 to continue searching.
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@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of RealFlight 7 on all public, private and domain
networks.

E Name: RealFlight 7
Publisher: Knife Edge Software
Path: C:\program files (x86)\realfight7\realfight.exe|

Allow RealFlight 7 to communicate on these networks:
Domain networks, such as a workplace network

Private networks, such as my home or work network

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing a program through a firewall?

[ Allow access }[ Cancel ]

Filter Servers-

Below the List Server is an option to filter your search results. If a large number of
multiplayer sessions are listed, you may want to narrow your search results to quickly
and easily find the session you wish to join. Filter options include:

e Server Name — If you know the name of the session you wish to join, type it in
this field.

e Airport — If you wish to participate at multiplayer sessions only at certain
airports, you can select that airport from this drop-down.

e Game — Like the Airport option, if you wish to find sessions running a
particular event, you may select it from this drop-down.

e Free Slot — Use this drop-down to select sessions that have a certain amount
of open player slots.
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Host

Every multiplayer session requires one participant to function as the host. If you are the host,
you will be the one who starts the session. The host is also the one who starts and ends the
events.
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Once you have started the session, other players may join in as they wish. Unless you opt to
make your session private, the session will be open to RealFlight owners searching for
multiplayer events.

To access the Host... menu item, click on the Multiplayer menu followed by the Host... menu
item.
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Host Information-

The Host Information allows you the ability to name your multiplayer session. You can also
choose the maximum number of pilots and whether or not to make your multiplayer session
public or private.

Host Information X

Sezzion Mame: |D|:|n Willlamz Combat |

Mate: Residential internet connechions

Max Players: 8 twpically support 8 to 16 players.

Publish Tax | nternet =

Advanced Hosting Optionz “ £ |

[] Password Protection

FPazzwiord:

[] UseaGame List
[Fame Lizt: | Biplane Paintball

Euecute: Sequentially Dizplay Games

R andorly Dizplay Games

tanage Ean List

Huost Cancel

Session Name-

Using the keyboard, enter the name of the session that you will be hosting.

Please note: This is the name of your session, not necessarily your personal name. In
fact, you might find it useful to use a descriptive name such as “3D Fun Fly.” This is
particularly useful when other participants are searching for a session to join.

Max Players-

To adjust the maximum number of players allowed in your session, click the down

arrow.

Currently, a multiplayer session may not have more than 32 members. If the host
computer is somewhat slow or has a poor internet connection, you may want to limit
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the number of participants. We suggest 8-16 players for typical residential internet
connections.

Publish To-

This option allows you to choose how other people will find and connect to your
multiplayer sessions. There are two options available.

e Internet — This option will publish your session on the RealFlight List Server,
so anyone in the world can connect to you.

e LAN-Short for “Local Area Network”, choose LAN if you wish to host a
multiplayer session on your local home or work network. For others to join,
they must also connect from the same local network. This option will not list
your session on the RealFlight List Server.

With the Host Information dialog window open, you may click the Advanced Hosting
Options arrows for additional options. Some of these options are also accessible
from the Multiplayer menu, after the multiplayer session has already been started.

Password Protection-

Should you wish to host a private multiplayer session, you may choose to set a
password to prevent other random pilots and participants from joining. If you choose
to password protect your session, you will need to share this password with the
people you want to join.

To enable and set the password, check the box to the left to activate the password
field, then enter the desired password accordingly.

Use a Game List-

Check this box to enable the different Game List options. This will allow you to
automatically run a Game List at the start of the multiplayer session. When enabled,
the available options are:

Game List — This drop-down box shows all Game Lists available. If you want to
manage or create a new customized list, click the “...” next to the drop-down. If you
wish to create a customized Game List, there are a number of options available. This
includes Airport selection, Game type, Duration and Points. To do so, click

“Configure...” to access the Manage Game options.

Execute — This determines the order in which each contest is loaded in the Game List.
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These options are also available from the Multiplayer menu if you wish to select
them at a later time. For more information about Game Lists, turn to page 241.

Manage Ban List-

Click this button to display the Ban List dialog window. This option is also available
from the Multiplayer menu. See page 245 for more information.

Port numbers-

Prior to hosting a multiplayer session it is important to note that if you are connected to the
internet behind a firewall or a router, you might need to open up access to a certain range of
port numbers. RealFlight 9.5 looks for an open port from 61234 to 61241 by default. For
more information on how to open these ports, please refer to your firewall or router’s
manual.

Disconnect...

This menu item is used to disconnect from, or exit, the multiplayer session.
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To access the Disconnect... menu item, click on the Multiplayer menu followed by the
Disconnect... menu item.

Please note: If you are not currently participating in a multiplayer session, this item will be
grayed out and will not be accessible.
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Host Options

This menu option will open a sub-menu that allows the host of a multiplayer session a variety
of options to start, stop, and manage events. Many of these menu items are not accessible
unless you are currently hosting a multiplayer session.
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Start Game-

To start an individual game at the airport currently loaded, select the event from the list that
appears in this sub-menu. The options are:

e Combat (Biplanes) — Full-fledged combat with machine guns and rockets flying the
Sopwith Pup.

e Combat (Jets) — Full-fledged combat with machine guns and rockets; flying the L-39.

e Combat (Unlimited) — Aircraft choice is up to the participants. Of course, we
recommend utilizing an airplane equipped with the proper combat equipment.

e Combat (Warbirds) — Full-fledged combat with machine guns and rockets; flying the
P-51 Mustang.

e Combat Aces (Warbirds) — A more challenging version of Combat.

e DeadRinger — Race to fly through all the rings (in any order), but don’t get shot down
in the process.
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e Fun Fly—An open event without any weapons or scoring involved.

e Hardcore Combat (Biplanes) — Like the Combat event, but with limited ammo and
bonuses. You can only shoot from the cockpit camera flying the Sopwith Pup.

e Hardcore Combat (Warbirds) - Like the Combat event, but with limited ammo and
bonuses. You can only shoot from the cockpit camera perspective flying the P-51
Mustang.

e Paintball (Biplanes) — Fly combat, shooting paintballs in the Sopwith Pup.
e Paintball (Warbirds) — Fly the P-51 Mustang and shoot paintballs at your opponents.

e Rocket Wars (Foamies) — Fly the Multiplex Parkmaster and battle each other shooting
rockets.

e Streamer Cut (Biplanes) — Fly the Sopwith Pup in traditional RC combat with
streamers.

e Streamer Cut (Foamies) — The traditional RC combat with streamers, flying the
Multiplex Parkmaster.

e Streamer Cut (Jets) — Take to the skies in the L-39 and try to cut your opponent’s
streamer.

e Streamer Cut (Warbirds) — Like the other streamer cut events, only this time you will
be piloting the venerable P-51 Mustang.

Power-Ups-

When a combat event is in progress, a number of Power-Ups will be available,
scattered about the airport. These Power-Ups will benefit you by offering points,
additional ammunition, fuel, and other items of interest. Not all Power-Ups appear at
every game. For example, during a Streamer Cut game, you will not see Power-Ups
that will replenish your ammunition, as it is not applicable.

To acquire or activate the Power-Up, simply fly through it during the game. Some
Power-Ups will affect you, while others will affect everyone else.
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This Power-Up restocks your bullet ammunition.

If you are running low on fuel or battery power, fly
through this Power-Up.

Flying through this Power-Up will only “infect” the other
participants in the game, yet leave you unharmed. The
effects vary depending upon the game. In Streamer Cut,
for example, all streamers except for yours will be twice
as long. If the event utilizes Paintballs, Guns, or Rockets,
your opponents will be unable to fire. Thisis a
temporary Power-Up.

During Paintball combat, if you are running low on
ammunition, fly through this Power-Up to receive more
paintballs.

Fly through these Power-Ups to obtain bonus points. If
you have negative points, these Power-Ups are useful to
erase the deficit.
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This is the one Power-Up to avoid at all cost. This Power-
Up functions in reverse of the Infect Power-Up, whereby
it harms you providing the advantage to your
opponents.

You never know what you will receive with this Power-
Up. As the name suggests, this Power-Up will randomly
act like one of the other Power-Ups when you fly
through it.

If your health is low during combat games with guns and
rockets, fly through this Power-Up to repair your
aircraft.

Restock the quantity of rockets by flying through this
Power-Up.

For temporary immunity from your competitors, grab
the Shield Power-Up. While this prevents your aircraft
from obtaining damage from your opponents, the shield
does not protect you from crashes.

Get the advantage over your opponents with the Speed
Boost Power-Up. This will allow you to fly faster for a
short period of time.
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Don’t be so quick to hit that Reset button if it is not required. Each
time you reset during a combat event, you will lose 15 points.
Resetting also eliminates any Power-Ups you might currently have.

Stop Game-

Select this to stop the currently running game. This option is only available if you are the host
of the multiplayer session and are running a single game, not a Game List.

Set Game Limits-

Select this menu item to open a window that allows you to alter the game limits.

Set Game Limits

Time Minutes

Score 10000 | Points

[] Disable Game Limits

Cancel

The game will end when one of the limits is met. For example, if you wish for the game to
end when the first player reaches 100 points, enter “100” in the Score field. If you wish the
game to continue indefinitely, click the checkbox labeled Disable Game Limits.

Start Game List-

This menu item will display all Game Lists available to the host. Selecting one will begin that
list, allowing the host to compete and without having to worry about changing the games or
time limits. For more information about Game Lists, see Manage Game Lists below.

End Game List-

If you are currently running a Game List and wish to cease this list, select this menu item.
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Manage Game Lists...-

RealFlight 9.5 allows you to manage and run a list of events automatically giving you the
opportunity to enjoy the competition without worrying about controlling the multiplayer
session.

Clicking on this menu item will display the following dialog window:

Manage Game Lists

Game List
Biplane Paintball s Capy
Deadringer Series
Excessive Combat
Rename
Float Flying
Hardcore Combat (Expert)
House Favorites Delete
Might Flying
PhotoField FunFly v Configure. ..
Create Mew Game List
Mame: | Enter Mew Mame | Create

On the left side of this window, it will display the Game Lists available on your computer. A
number of pre-configured Game Lists are included with RealFlight 9.5. To the right of this list
are four buttons that have the following functions:

e Copy—You are not able to modify the default Game Lists included with RealFlight.
However, if you wish to make a change to one of these default lists, you must first
make a copy of it. To do so, first select the Game List on the left then click the Copy
button. If you do not rename the Game List, it will appear as “Copy of ....” In the
Game List.

e Rename — If you wish to rename a Game List, first select it from the list on the left.
Then click the Rename button. This button will be disabled if the selected Game List
was a default list included with RealFlight 9.5.

e Delete — Click this button to delete the selected Game List. Like Rename, this option
is not available for the default Game Lists included with RealFlight 9.5. Please note
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that after you have confirmed the removal of the Game List, it will no longer be
available nor will it be stored on your machine.

e Configure ... - To configure the contests, timers and other settings and options for the
Game List, select it from the list on the left, then click the Configure... button. See
below for an explanation on how to configure a Game List.

If you wish to create a completely new Game List from scratch, type in the name of the
desired list at the bottom of the Manage Game List dialog window. Next, click Create. The
new Game List will appear in the list above. You may now add contests and other options to
this list. To do so, select the desired contest from the list, then click the Configure... button.
The following window will appear.

Manage Games

Game List: Biplane Paintball | T b

Airport Mame Game Type Timeout Points
Construction Site  Paintball (Biplanes) 10000
Boneyard Paintball (Biplanes) 10 10000
RealFlight Ranch Paintball (Biplanes) 10 10000
Castle Paintball (Biplanes) 10 10000
Apocalypse Paintball (Biplanes) 10 10000

Airport: Construction Site Add New

Game: | Paintball (Biplanes) Update

Game Time: 10 g Delete

Points Limit: 10000~ points

The Manage Games dialog window allows you to add and configure individual games within
the Game List. For each event, you have the option to select the airport, contest, the amount
of time spent at the game before switching to the next game, and the upper limit of points
any player can reach before switching to the next game. You may also modify the order of
these events.
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Please note: These options are disabled for stock Game Lists that are included with RealFlight
9.5.

The main pane on this window indicates all games listed for the selected Game List. Each
game will list the Airport at which it will load, the contest it will run, and the amount of time
that remains in the contest before proceeding to the next game on the list. If you wish to
change the order that these contests are loaded, select it from the list, then click either the
up or down arrow buttons in the upper, right-hand corner.

There are three main functions available on this dialog window:

e Add New —To add a new game to the Game List, select the Airport and Game. If so
desired, adjust the amount of time you wish the game to last. Next, click the Add
New button.

e Update — This button enables you to make a change to a game that is already on the
Game List. Select the desired game, and then choose your new settings for the
Airport, Game and Game Time. Once you have made your changes, click the Update
button. The Game List will reflect the new settings.

e Delete —Finally, if you wish to remove a game from the Game List, simply select it,
then click the Delete button. The game will be permanently removed from the Game
List.

Once you have configured your Game List, click the Done button. Your new Game List will
now appear as a menu option under the Start Game List. See page 241 for more information
about how to start a Game List.

RealFlight 9.5 RC Flight Simulator




Manage Ban List...-

Generally speaking, the RealFlight and the RC community are a great group of people, all
sharing a common interest and passion for all things aviation. Unfortunately, there are times
when some people choose not to abide by the host’s rules or wishes, or will otherwise
conduct themselves in an inappropriate manner during a multiplayer session. Rather than
choking the stuffing out of them, we’ve taken a more peaceful, yet still equally effective
approach, preventing them from ruining your fun. If you are hosting a public multiplayer
session, where someone is not behaving in a way you feel is appropriate, you can choose to
ban that person.

To do so, click the Manage Ban List... menu item to display the following dialog window.

Ban List )

MName | IP | Date
CMN  10.1.15.90:61234 9/19/2011
Mega P: 10.1.15.95:61234  9/19/2011

Remove I

Done |

To add a person to the ban list, select their name in the drop-down selection box at the
bottom of the window, then click the Ban Player button. Their name, IP address of their
computer and the current date will appear in the list above. This will prevent them from
participating in the events that you are hosting now, and in the future.

If you later change your mind and wish to allow the individual to participate once again, you
may remove someone from the banned list. To do so, simply select their name in the list
then click the Remove button.
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Scoreboard

The Scoreboard offers a wealth of information about all the players connected to the
multiplayer session, as well as details on the current game (if one is in progress).

4 o'clock mad dash - Boneyard/Paintball (Warbirds)
Target Player Foints

& John
<

!‘ Kenny Tarmac

Rogue Leader

B FivonKEY

-

ion Time: 0:00 MNext Map: None/None

If a combat contest is currently in progress, you can show and hide
the Scoreboard simply by pressing the Scroll Wheel/Select button
on the InterLink DX controller. This allows you to display the
Scoreboard without taking your hands off the controller and missing
that well-placed shot.

The main area in the middle of the Scoreboard displays all players connected to the
multiplayer session as well as a variety of useful information. This includes, from left to right:
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e Look At — This function allows you to quickly change your camera’s point of view to
look at the desired player’s aircraft. To do so, simply click the icon to change your
view. The icon will be highlighted next to the current player you are looking at. If you
are participating in a combat event, the Look At icon will be represented as a target.
If you are simply participating in a multiplayer session, this icon will be represented as
an eyeball.

e Pilot Profile — Situated between the Look At icon and the player’s name is a small
arrow and the picture of the avatar that player is using. Clicking the arrow will display
that player’s Pilot Profile. You may also double-click the desired player’s name to
display these contents.

4 o'clock mad dash - Boneyard/Paintball (Warbirds)

Player Points
0

Name
Kenny Tarmac

Location Favorite Color ute
ATL to ORD to LAX m

License Date Hours Logged

08y24/09 0D, 8H, 50M

Tagline

l'justlanded!

Hang on! 'just got another calll

&= John
d
Rogue Leader

m FTMONKEY

-

Mext Map: None/None

Within the Pilot Profile, you will also notice four buttons along the right side of the
Pilot Profile. They include:

o Hide/Show — This button will hide or show the selected player’s aircraft on
the screen.
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o Mute/Unmute — As the name suggests, this button will mute or unmute the
voice chat from this player only. Note that this does not mute your
microphone.

o Kick — Clicking this button will kick (remove) the selected player from the
multiplayer session. This is only available to the host of the session. This will
not ban a player from reconnecting.

o Ban-—This button will add the selected player to the Ban List and kick the
player. Once this is done, this player cannot reconnect. This is only available
to the host of the multiplayer session. See the Manage Ban List for more
information about banning players.

e Player—This column, as the name suggests, show the player’s name.

e Points — The Points column will show the points for all players in the current game.
This list will automatically order itself, so that the player currently winning will be
listed first. Second place is next, and so forth.

e Crashes — Look to this column to find out how many times a player has crashed
during a combat event.

e Ping — At times, this column can be very important. It displays, in milliseconds, the
amount of time data will travel between this player’s computer and the host
computer. The lower this number, the better results you will have during multiplayer.

If there is a Game List in progress, more information is available at the bottom of the
Scoreboard. At the lower left, it shows the remaining time left for the current event as well
as the Point Limit. The lower right corner displays the airport that will be loaded for the next
event in the Game List.
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Server Details...

As the host of a multiplayer session, you may choose to edit the details of your server. This
information will be displayed to each player as they join your session.

Don Williams Combat

markdwilliams1 2045
Faintball (Biplanes)

Construction Site

Tou are currently reading the defaultr

. located in RealFlight's=

ou may update the
file with a

Every time you update the
ServerMeszzage,.txt file, player= that

The title bar of the window displays the name of your multiplayer session. This information
will be displayed in the server list and also in the Join dialog window when other players
search for multiplayer servers.

The top portion of this window displays the host information. This includes the Host Name,
or the name that you entered into your Pilot Profile. Also displayed here are the Current
Game (if active) and the Current Airport. The Current Game and Current Airport will be
displayed in the Join dialog window when other RealFlight users search for multiplayer
sessions.

The lower portion contains information which you can edit in a separate file, called
ServerMessage.txt, located on your hard drive. This file is located in the \RealFlight
9.5\Multiplayer folder within My Documents. If you make changes to this file, the
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information will be shared to all players that connect to your multiplayer session. Otherwise,
if you leave the ServerMessage.txt file alone, making no changes to the default text, this
screen will not be displayed to joining participants.

If you do not wish to see this screen, simply click the checkbox next to Do not show this

dialog again unless it changes and click OK.

Game Help...

The Game Help window is displayed to all participants at the beginning of a game.

Please note: This menu option is disabled if combat events are not currently in progress.

Paintball (Biplanes)

Game Description

Each aircraft iz equipped with a limited
supply of paintball=s and unlimited fuel.
Ammunition and special power-ups are
available.

How To Play

Shoot paintballs using the dual rate

awitch.

Hit other aircraft to get points.

Avoid getting hit by paintballs=s.

About Paintballs

Do not explain this game to me again

This window will explain how to play the current game, the scoring process, and provide you
with other useful information to ensure you enjoy your experience. If you do not wish to see
this screen, simply click the checkbox next to Don’t show this dialog again and click OK. Note
that this checkbox is independent for each game. For example, if you checked the box to
hide the Game Help dialog from appearing when the Combat (Jets) game was loaded, you
will still see this dialog if the Streamer Cut (Foamies) game is loaded.
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Game Gadgets

There are three onscreen gadgets that are only available during multiplayer sessions.
Therefore, unlike other gadgets which are located in the Windows menu, you will find these
under the Multiplayer menu. Selecting Game Gadgets from the Multiplayer menu will display
five choices.

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help
e~

Pilot Profile...

Join...
Host...

Disconnect

Host Options
Scoreboard...

Server Details...

Game Help...

Game Gadgets Al

Select Target Pilot Status

Simulation Sounds Targeting
Voice Chat Targeting Ring

Text Chat None

Enter MultiMode

To display all of the Multiplayer Gadgets on the screen at the same time, click the All menu
item. To remove all of the Multiplayer Gadgets, select None.

Alternatively, you may select each desired gadget individually. Each gadget offers unique
information about the current game.

RealFlight 9.5 RC Flight Simulator




Pilot Status-

This gadget displays pertinent data regarding your current status. The name entered in the
Pilot Profile will be noted at the top of the status display. The bottom of this gadget indicates
your current score. The middle section displays a variety of progress bars. The level of the
progress bar will differ depending on the current status of the game, and the game you are
playing. They include:

Fuel — Indication of the remaining fuel or battery power.

Health — In combat with guns and rockets, the health status determines whether
your aircraft is destroyed or not. Nearby rocket explosions will cause some damage,
where a direct impact will likely terminate your aircraft.

Paintball — This bar displays your remaining paintball ammunition.

Bullets — This bar indicates the amount of ammunition you have remaining for the
machine gun.

Rockets — Like Bullets and Paintballs, this progress bar displays the amount of rockets
you have remaining.

3

I

Speed Boost — If you fly through a speed boost Power-Up, this progress bar will
appear, showing you the remaining time left until the boost is depleted.

Poison — If you fly through a Poison Power-Up, or if another player flies through an
Infect Power-Up, this bar will appear on your screen indicating the amount of time
you have left until the infection wears off.
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Shield — Flying through the Shield Power-Up will give you temporary immunity from
all other players. This progress bar displays the amount of time left before you lose

your shield.

Gun Temperature — During hardcore combat events, your guns can overheat and
temporarily stop working. You must let them cool down before firing again. If this
progress bar fills up completely, your guns have overheated.
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Targeting-

The Targeting gadget displays the player you currently have selected as your target. The
avatar for the intended target will appear with their name and score for the current game.
Below this will show their Tagline from the targeted player’s Pilot Profile.

| Targeting

T Konger 1/2
Score

RIC Rules!

The Targeting gadget also controls whether the targeting indicator (red triangle) will appear
around the selected target’s aircraft. This triangle only appears if the gadget is on screen and
a player is selected. If no player is targeted, it will read “No Target Selected.”

While a game is in progress, the QuickSelect buttons take on new
functions. If the targeting gadget is enabled, pressing the Cancel
button will cycle through the different modes for the Targeting
gadget, including:

e Activating the gadget and targeting the last player you had
selected as a target.

e Leaving the gadget on the screen, but deactivating the
current target; no players are targeted

e Removing the gadget altogether. No players are targeted
when the gadget is removed.

Note that when you reset your aircraft, the Targeting gadget may select a new player
depending on the targeting settings. See page 117 on how to select the method which the
Targeting gadget will operate each time you reset.
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Targeting Ring-

The Targeting Ring, when activated, will appear directly in the middle of the screen. This
heads-up gadget helps you locate your currently targeted opponent during combat events.

## RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Targeting

markdwilliams 1205

When displayed, an arrow will appear on the outer perimeter of the circle. This indicates the
direction of the targeted aircraft. Note that the arrow will not be displayed if the aircraft
appears within the perimeter of the Targeting Ring.
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Select Target

] The menu items located in the Select Target menu allows you to select amongst the
connected players as a target. Clicking Previous, or Next will cycle through the players
[ accordingly. Alternatively, you can press the ‘[* or ‘]’ keys on the keyboard.

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Pilot Profile...

Join..,

kdwilliams 1205 ~NNo Tar
IELCIIES Hosting.. mm%

Disconnect

ore

Host Options
Scoreboard...

Server Details...

Game Help...
Game Gadgets
Select Target Previous

Simulation Sounds Dexk

Voice Chat Clear

jlect Chat Auto-targeting Mode

Enter MultiMode

To deactivate the current target so that no players are targeted, simply choose Clear from
the menu, or press ‘\” on the keyboard.

During combat events, you can quickly cycle through different
targets using the InterLink DX Select Function. Simply rotate the
scroll wheel left or right to select different opponents.

Auto-targeting Mode-

This sub-menu allows you to set how RealFlight chooses your target during multiplayer
events. This takes effect after each reset of the aircraft. The options available:
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Disabled — RealFlight does not change the targeted player. This allows you to have
full control of the targeting system.

Leader — RealFlight will target the player with the highest score. If this happens to be
you, then RealFlight will select a player at random.

Random — RealFlight will randomly select a player to target.

Smart — All players with a higher score than yourself will be selected somewhat
randomly. The player with the highest score and the player that most recently
damaged you will have a higher chance of getting selected.

Threat — This option will target the last player that caused damage to you.

Simulation Sounds

During multiplayer sessions, you may wish to turn down, or off, the sounds generated by the
simulator, including engine sounds. This will allow you to better hear and understand other
players using voice chat.

#= RealFlight
Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help
Pilot Profile...

markdwilliams1205 domn.. mNo Target Selected

Hosting...

Disconnect

Host Options
Scoreboard...

Server Details...

Game Help...

Game Gadgets

Select Target

Simulation Sounds

Voice Chat > ‘& Reduced
Text Chat Enter Normal

Enter MultiMode
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By default, RealFlight will set the Simulation Sounds to Reduced. At this setting, you will still
be able to hear all of the sounds, including engine noises and crashes, but at a lower volume.
Select Off to turn off all simulator sounds. If you prefer that all sound settings remain the
same in multiplayer sessions as they do offline, select the Normal menu item.

Voice Chat

With a microphone plugged into the computer, RealFlight allows you to talk to other players
in a multiplayer session, as if everyone was sitting in the same room.

## RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Pilot Profile...

markdwilliams1205 - ot mNo Target Selected

Hosting...
=

Disconnect

Host Options
Scoreboard...

Server Details...

Game Help...
Game Gadgets
Select Target

Simulation Sounds
Voice Chat Disable
Text Chat Test Microphone...

Enter MultiMode Toggle Microphone On/Off

Three options are available when choosing Voice Chat from the Multiplayer menu.

Enable/Disable-

Choose this menu item to either disable or enable voice chat. When disabled, you will not be
able to send or receive voice chats.
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Test Microphone...-

This menu item will bring up a small dialog window, which will allow you to test the
microphone connected to your computer. Follow the on-screen instructions to test the

microphone.
Microphone Test X

RealFlight's voice chat system allows players to
communicate in an open channel while connected to
a multiplayer session.

In normal operation, all players on a session can
hear other players. This means the overall quality of
the voice communication can be affected adversely
for everyone if even a single player has set up their
speaker and microphone improperly.

Itis very important that you use a headset with an
integrated microphone if you intend to use voice
chat.

I have a headset and
integrated microphone

| have separate speakers
and a microphone

Cancel

Select the button that best matches your setup. If you are using a microphone and speakers,
we suggest turning the speaker volume down or off. Otherwise, audio feedback could be
sent to all participating pilots, making voice chat difficult for all players.
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Once you have selected your setup, the following dialog will appear to test the microphone.

Microphone Test X

Put on your headset and verify that it is correctly
connected to your computer.,

Then, speak into the microphane.
If everything is working properly, you will hear

yourself in your headset and see a light flash as you
speak,

If you do not hear a response, ensure that your
microphone is set up correctly.

A slight delay in the response is normal.

Is everything working properly?
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Follow the on-screen instructions. If your microphone test is successful, click the button labeled
Yes. Doing so will display the following:

Microphone Test X

Congratulations, you are now ready to use voice
chat.

Mow that your microphone has been tested, you can
togale it on and off during a multiplayer session by
pressing the ™" key.

Close
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Clicking No on the microphone test dialog will display the following screen with

troubleshooting tips:

Troubleshooting

Here are some common causes of problems with
microphones:

-Is your microphone plugged into the correct port?
-Is the microphone set as your default recording
device?

Do you have your microphone muted?

Would you like to retry testing your microphone?

Please note: If you are having difficulties setting up your microphone, please refer to your
computer user manual for proper setup.

Toggle Microphone On/Off-
This option will turn on or off your microphone, so other players can/not hear you. You will

still be able to hear other players. Alternatively, you can press ‘V’ on the keyboard to toggle
the microphone on or off.
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Text Chat

During Multiplayer sessions, you may want to chat with other participants. Doing so is as
simple as typing a message, much like popular instant messenger programs.

#* RealFlight

Simulation Aircraft Environment Challenges Gadgets =Multiplayer Recordings Training View Help

Pilot Profile...

markdwilliams 1205 Join... mNo Target Selected

Hosting...
Core

Disconnect

Host Options
Scoreboard...

Server Details...

Game Help...
Game Gadgets
Select Target

Simulation Sounds
Voice Chat
Text Chat

Enter MultiMode

To send a chat message, press the Enter key to bring up the Chat field at the bottom of the
screen. Using the keyboard, type the message you wish to send. Press the Enter key again on
the keyboard to send the message.

Please note: All messages are viewable by all participants. RealFlight does not offer private
chat.

Any messages received from other participants will appear at the bottom of the screen.
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Enter MultiMode

MultiMode allows you to fly with another pilot on the same PC; with each pilot controlling
his or her own aircraft. This feature is ideal for offering personal flight instruction, practicing
formation flights, or simply for chasing one another across the skies.

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Pilot Profile...

Join...
Host...

Disconnect

Host Options
Scoreboard...

Server Details...

Game Help...
Game Gadgets
Select Target

Simulation Sounds
Voice Chat
Text Chat

Enter MultiMode

To access the MultiMode menu item, click on the Multiplayer menu followed by the Enter
MultiMode menu item.
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MultiMode will split the screen either horizontally (default) or vertically. You can change this
option in the Settings window. Simply click the Simulation menu followed by Settings. On
the left side of the Settings screen that appears, choose Multiplayer. On the right, you can
adjust the MultiMode Screen Layout — select either Horizontal or Vertical.

All options available in RealFlight are also available in MultiMode. The difference is most will
function on half of the screen that currently is active. To determine which half has the focus
or is active, look for the yellow outline. To change focus, click the half that doesn’t have the
yellow outline. You'll notice the focus changes when you do.

For example, if you are flying in MultiMode with a horizontally split screen, you might notice
that the yellow outline is around the top half. If you want to change the aircraft for the
person flying on the bottom half of the screen, first click that half of the window, so it has the
focus or is the active screen. Next, select an aircraft following the normal procedure.

Please note, there are a number of ways to control the additional aircraft within MultiMode.
For example, you may use another InterLink DX or InterLink-X controller. Alternatively, it is
possible to use the Spektrum WS2000 Wireless Simulator Dongle as well. For the Wireless
Simulator Dongle, please follow the information located on Page 47 of this manual.

To exit MultiMode, select Exit MultiMode menu item under the Multiplayer main menu.
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Chapter

11

Recordings Menu

SAVE AND PLAY BACK REALFLIGHT MEMORIES.

he Recordings menu is used to start and stop recordings to assist you in your RC

ventures. The RealFlight simulator also allows you to record your flights for later

playback — complete with audio voiceovers. You can even share your flights with
friends and fellow pilots.

## RealFlight
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Start Recording R
Open Recording...

Record Microphone Input

Flight Modes X
® SAFE: Beginner
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Start Recording

Click on the Recording menu followed by the Start Recording menu item. RealFlight will start

recording your flight immediately. An on-screen message will confirm that the recording has
started.

## RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Start Recording R
Open Recording...

Record Microphone Input

Flight Modes X
® SAFE: Beginner

RealFlight will continue recording your flight until you select the Stop Recording menu item
or press ‘R’ again to stop recording.

Stop Recording

The Stop Recording menu item is not visible until the Start Recording menu item activates.
To stop the recording of your flight at any time, click the Recording menu title, followed by
the Stop Recording option. RealFlight will stop recording at this time. RealFlight
automatically saves all recordings for playback later. For information on how to delete a
recording, please see the Open Recording... section which follows.

When RealFlight stops recording, an on-screen message appears which indicates the default
name of the recording that has just been completed. For information on how to change the
name of a recording, please see the Open Recording... section which follows.
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Open Recording...

This menu item allows you to access the recording files. It also allows you to perform a
variety of modifications to the files such as renaming them or deleting them. To access the
recordings, click the Recording menu title followed by the Open Recording... menu item.
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To open a recording, click on the file name. Next, click on the Open button. Alternatively, you
may double-click on the file. Regardless of which method you use, this will start RealFlight’s
Playback Gadget. For more information on the Playback Gadget, please refer to the
information below.

If you wish to rename the recording, simply right click on the respective recording, select
rename from the drop-down menu and rename the file.

To delete a recording, right click on the recording file and select Delete from the pull-down
list.

Playback Gadget-

When you open a recording, RealFlight’s playback gadget appears on the screen. This gadget
allows you to control the playback of the recordings using simple mouse commands. It
features DVD-like controls that start, stop, and pause the playback. It is also possible to
modify the playback gadget.
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Playback - Donald E Williams_E-flite Apprentice STS 15m X

NOIn

If you do not wish to view the playback information, double-click the title bar of the display
box. This will hide the information. To view it once again, simply double-click the title bar
again.

To modify the size of the playback gadget display, position the cursor over the lower right
corner of the frame. Using the mouse, drag the frame according to your wishes. Dragging the
frame to the right or left increases or decreases the width of the gadget, respectively.

Clicking on the ‘X" in the viewport’s title tab removes it from the screen and exits the
playback.

Loop Play-

The arrows that form a circle cause the recording to loop (i.e., play continuously). The
continuous loop is activated when the arrows are illuminated. To stop the looping,
click on the loop button again.

Playback - Donald E Williams_E-flite Apprentice STS 15m X

@ ()
®

Look at Recording-

Click on the ‘eye’ to look at the respective Recording. This causes the camera to treat
the recording as its target object, rather than your aircraft. If you are looking at a
different aircraft than the recording and wish to watch the recording, click the ‘eye’
button.

Playback - Donald E Williams_E-flite Apprentice STS 15m X

NOlo
4
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Left/Right Arrows-

The left and right arrows skip back (left) or skip forward (right) in the recording.
Alternatively, you may click on the position indicator, hold the mouse button and
drag the indicator to the desired position.

Playback - Donald E Williams_E-flite Apprentice STS 15m X

NOIIE :

Playback/Pause-

If the recording is paused, the playback button will be the single arrow pointing to
the right. To resume playback of the recording, click this arrow.

Playback - Donald E Williams_E-flite Apprentice STS 15m X

N0k -

If the recording is playing, the playback button will switch to a pause button. To
pause playback, press this button. You may continue at any time by pressing the
playback button once again.

Playback - Donald E Williams_E-flite Apprentice STS 15m X

NOIcEs
L

Position of Recording-

The slider bar and position indicator are used to track the progress of the recording
playback.

It is also possible to use the position indicator to select the point at which you wish
the recording to begin playing. Using the mouse drag, position the slider bar to the
position desired.

RealFlight 9.5 RC Flight Simulator




Record Microphone Input

RealFlight also allows you to add your voice or other audio to the recordings. If selected, the
Record Microphone Input menu item activates and allows you to record audio input to
accompany your recording.
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Adding your voiceover to the recordings is a fantastic way to create personalized training
lessons. This feature presents you with the ability to create your own Virtual Flight
Instructions that you can share with other RealFlight owners around the world!
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Recordings MRU

If you have previously selected a recording, you will note that it appears on a list in the
Recordings menu title. Lists such as this are commonly referred to as Most Recently Used, or
MRU lists. The MRU list is limited to the eight most recently selected recordings. If you wish
to view one of these recordings simply click on the name of the recording and it will begin.
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Chapter

12

Training Menu

PRACTICE MAKES PERFECT. REALFLIGHT’S TRAINING AIDS MAKE
PRACTICING A LITTLE MORE ENJOYABLE.

ealFlight 9.5 offers a number of training aids. These training aids are designed for
modelers of all skill levels.
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Helicopter pilots will benefit from the Heli Hover Trainer, Heli Autorotation Trainer, and the
Heli Orientation Trainer. The Heli Hover Trainer and Heli Orientation Trainer offer modelers
the chance to practice their stick control and helicopter attitude recognition.

Airplane modelers will benefit from the Airplane Hover Trainer. Further, entry-level airplane
modelers will also benefit from the Flight Training module that has been incorporated in the
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RealFlight 9.5 Flight Simulator. As the name suggests, this module includes a number of
flight training segments designed to introduce modelers to RC flight and to overcome any
potential apprehensions or fears. Our instructor will teach you step-by-step, how to takeoff,
fly around and land safely using E-flite’s Apprentice STS airplane. New to RealFlight 9.5 is the
EDF training module focused on the E-Flite Habu STS 70mm EDF- the perfect way to hone
your skills before taking to the field with your first electric ducted fan airplane!

RealFlight also makes it easy to access some of the previous flight training segments as well.
The Classic segment includes a multitude of lessons for both helicopter and airplane pilots
covering the gamut of RC flight- from basic skills through advanced aerobatics; it’s all there
and ready to advance your skillset.

Flight Training

The Flight Training segment of the Training menu, as noted previously, is a great introduction
to RC for newcomers, as well as the ideal way for seasoned veterans to either advance their
skills, or fine-tune existing ones.

To start the training, select the Flight Training menu item from the Training menu. This will
lead you to the Flight Training menu selections.
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The Flight Training menu item contains several filter options. The filter option selected, as
well as any previously completed flight training lessons, may determine lesson availability.

If the New filter is selected, this will bring forth the flight training that has been added to the
RealFlight offering in RF 9 and RF 9.5. The Classic filter includes content that was previously
offered through past iterations of the RealFlight simulation.

Flight Training
- .“ R A

Classic

Beginner Mode |

Leam how to get airtbomne ir

SAFE Technology

Beginner Mode |l

Earn a cenfica

unlock

Beginner Mode lll

Eam a cenifica

unlock

New Flight Training

The New Flight Training filer contains a variety of flight lessons from our expert flight instructor
that will take newcomers to the hobby through all facets of entry-level flight. For example, the
first lesson offered teaches modelers how to properly taxi the aircraft in preparation for takeoff.
We then build upon the lessons sequentially with the final lesson putting it all together to
takeoff, fly around and then landing appropriately just as it would be done at the local flying
field.

If you have not completed any of the New Flight Training sessions, selecting this option will
initially allow access to the Beginner Mode | and SAFE Technology lessons. The goal of the Flight
Training module is to provide entry-level modelers with a solid foundation from which to grow
and expand their capabilities. Once these lessons have been completed, with an acceptable
score, additional lessons will become available to the modeler.
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To access a Flight Training lesson, mouse click on the desired lesson. Note: if a lesson is grayed
out with the padlock image in the iconic representation, then this particular lesson is not yet
available to you. Please complete the previous lessons to unlock accordingly.

Lessons
— g *

—_— Beginner Mode |

to get arbome Ir

After you’ve selected the desired lesson, you will note several areas of interest. For example,
the header of the lesson includes the overall goal for this module. For example, if Beginner
Mode | has been selected the overall goal is to ensure that the modeler is comfortable getting
airborne with SAFE in the Beginner Mode.

Further, the specific lesson at hand is described accordingly. In our example, lesson 1 is to
ensure that the modeler is able to taxi the aircraft appropriately to place themselves in proper
position for a takeoff.

Click Begin! to start the Lesson accordingly.
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If applicable, a Flight Modes graphical indication will appear on screen as well. This indicator
will exemplify the current flight mode of the Instructor’s aircraft. Should the Instructor alter the
flight mode within the lesson, the graphic will also change accordingly.

Further, an on-screen radio will indicate the Instructor’s stick movements as well as any switch
positions, etc. This visual representation will greatly assist in the understanding of any desired
inputs as well as the amount of input necessary to achieve a given response from the aircraft.

When the Lesson is finished, a Lesson Complete notification will appear in the upper right corner
of the screen. Click Finish to return to the main menu.

Progress for a given lesson is indicated as a percentage to the right of the progress indicator.
Furthermore, the number of lessons within a segment is included below this progression
indication. In our example, there are two lessons thus completing one of the two would
produce a progress indicator of 50%.

If another lesson is available in the selected module, click the arrow indication on the side of the
screen accordingly, to access.

To start the desired lesson, click the Begin! button at the bottom of the screen. This will lead to
the next dialog screen. If you’ve completed a lesson, the date of completion will be noted
accordingly. Mouse click the Begin! once again to start the training session.
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Playback Gadget Bar-

With the flight training lesson open, RealFlight’s playback gadget bar will appear at the top of
the screen. There are a number of controls and options included on this gadget bar; each will be
identified and explained below in a separate section for ease of reference.

Playback Gadget-

This gadget allows you to control the playback of the recordings using the mouse. For example,
clicking the arrow that is facing to the left will rewind the flight lesson and start from the
beginning. If you want to review a segment of the lesson, clicking the semi-circular arrow with
the 10 beneath this will rewind to the previous 10 seconds. Further, if you wish to pause a
lesson when it is playing, simply click the ‘Pause’ button.

The center portion of the playback gadget indicates the overall length of a given lesson as well
as the current recording position within this lesson.

Additionally, it is possible to use the position indicator on the recording’s slider bar to move the
recording to the desired starting point. To do so, use the mouse drag to position the slider bar
to the position desired then release.

Try It/Watch Gadget-

Represented by the transmitter icon and the words ‘Try it!” or ‘Watch’, this gadget determines
whether or not the user wishes to try the lesson themselves.

If the watch appears on screen, it is fairly self-explanatory, the modeler will simply be watching
(and listening) to the Instructor’s explanation of the lesson selected.

However, if the modeler mouse clicks on Try It!, his/her aircraft will appear on-screen near the
Instructor’s model. This will enable the modeler to mimic the flight control inputs, etc. so that
they may practice the maneuver for themselves. Of course, the Instructor’s aircraft is still active
as well so there will be a visual representation from which to reference.

Try It! enables you to fly mimicking the Instructor aircraft to ensure that you are able to take to
the field with confidence. We strongly suggest doing so several times, making sure that you're
able to completely replicate all control inputs accordingly.

Lessons-

Mouse clicking the Lessons icon will take you back to the lesson selection menu item of the
Flight Training screen once again; enabling you to continue forward with additional lessons or to
press the Quit button accordingly.
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Classic Flight Training-

As mentioned previously, the Classic Flight Training module includes a variety of lessons that
had been incorporated into previous RealFlight offerings from a variety of pilots. The
appearance may be a bit dated, however, the foundational training is still valid today.

Flight Training
< e . el A i

Classic

Airplane Aerobatics |

Airplane Aerobatics Il

Build your aerobat

Classic VFI

Helicopter Aerobatics |

Classic VFI

The menu items (e.g., Playback Gadget, etc.) are identical to those utilized in the New Flight
Training segments noted previously. For additional information pertaining to these items,
please reference the information above.

The lessons offered in the Classic Flight Training have been further grouped into relevant
categories. For example, the Airplane Aerobatics | session includes 14 individual lessons that
target some of the entry-level maneuvers commonly taught to pilots that have progressed
beyond a basic skillset. Similarly, the Airplane Aerobatics Il lessons will go beyond that taught in
the Airplane Aerobatics I.
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Heli Hover Trainer

The Heli Hover Trainer offers you a great way to learn how to precisely control a helicopter in
a hover. With the Heli Hover Trainer, you pick which channel, or channels you wish to control
and RealFlight will take care of the rest for you. You’ll also have options to determine the
model’s orientation, perimeter dimensions, and more.

To start the trainer, click Heli Hover Trainer... menu item from the Training menu. The
trainer will start automatically.

A welcome dialog will first appear to explain the goals of this trainer as well as offer a few
tips. If you do not wish to see this dialog screen again for each time you load this trainer,
simply click the Don’t show this message again checkbox at the bottom, then click Go.

Following the welcome dialog, the get ready dialog screen will appear. This screen will
explain what you are required to do for this trainer. There is also a checklist that you should
follow before you proceed. If an item in the checklist is properly adjusted, or correctly
positioned, the Ready light will illuminate. Otherwise, the Ready light will be dim, and the
function on the controller pictured to the left will blink indicating what needs to be done.
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The get ready dialog is a great way to prepare for the trainer. Once you have successfully run
through the trainer a few times and no longer wish to see this dialog, simply click the
checkbox labeled Don’t show this message again and then click Go.

You’ll notice a circle on the ground. This circle represents the training boundary or perimeter. If
your helicopter ventures beyond the boundary’s outer perimeter, it will break apart and the
session will begin once again. The smaller circle within the boundary’s perimeters represents the
true center of the boundary. You’ll also note an ‘X’ mark within the boundary; the ‘X’ represents
the current location of your helicopter. The goal is to control the helicopter in a stable hover,
keeping it as close to the center of the circle as possible.
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Trainer Menu-

The Trainer menu contains the following menu items:
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Crashes

Reset Aircraft-

If you crash or fly outside the circle, there are three ways to reset the aircraft:
1. Press the Reset button on the InterLink DX controller. This is probably the
fastest and simplest method.
2. Press the keyboard’s space bar.

3. Click the Reset Aircraft menu item.

Boundary-

The Boundary menu item allows you to change the size of the circle, or eliminate it
altogether. To change the size of the boundary, select the Boundary menu item from
the Trainer menu. A drop-down menu will appear with the following options.

e None - Eliminate the boundary circle.

e Small - Creates a small circle.
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e Medium — Creates a medium-sized circle; this is the default setting.

e Large —Creates a large circle.

Crashes-

After a crash, RealFlight may automatically reset your helicopter for you, if so
desired. This option is on by default. If you would prefer to turn this option off, select
the Crashes menu item, then select the Automatically Reset Aircraft. If a checkmark
appears next to this menu item, then this feature is activated. If the checkmark does
not appear, it is not active.

If Automatically Reset Aircraft is enabled, you may adjust how quickly the reset
happens. To adjust this delay, select the Crashes menu item followed by the Reset
Delay menu item. Four options will be available to you:

e None - No delay will be set. The aircraft will reset immediately.

e Short — The aircraft will reset approximately one second after it crashes.

e Medium —The aircraft will reset approximately three seconds after it crashes.

e Long—The aircraft will reset approximately six seconds after it crashes.

Exit-

If you wish to leave the Heli Hover Trainer and return to the simulator, select the Exit
menu item.
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Orientation Menu-

The Orientation menu allows you the option to select the position and attitude of the heli
when the session begins or the helicopter is reset.
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A checkmark will appear next to the currently selected orientation. The options available are:
e Random Upright — The heli will start in the upright position, but it will randomly face
either to the right, left, nose out, or nose in.

e Random Inverted — The heli will start in the inverted position, but it will randomly face
either to the right, left, nose out, or nose in.

e Nose Out —The heli will start upright, facing nose out. This option is the best selection for
beginning heli pilots.

e Nose In—The heli will start upright, facing nose in.

o Left—The heli will start upright, facing to the left.

e Right —The heli will start upright, facing to the right.

e Nose Out Inverted — The heli will start inverted, facing nose out.
e Nose In Inverted — The heli will start inverted, facing nose in.

e Left Inverted — The heli will start inverted, facing to the left.

e Right Inverted — The heli will start inverted, facing to the right.
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Control Menu-

The Control menu allows you to select which channel or channels you will control. All other
channels are controlled by RealFlight, allowing you to learn just the controls you wish and
adding more as you become more comfortable and confident in your skills.
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_;\'(f Throttle, Pitch, Roll, Yaw

A checkmark will appear in the menu next to the currently selected item. Your options are:

e Pitch Only —You control only the pitch of the heli. RealFlight will control the roll, yaw, and
throttle.

e Roll Only —You control only the roll of the heli. RealFlight will control the pitch, yaw, and
throttle.

e Yaw Only —You control only the yaw of the heli. RealFlight will control the roll, pitch, and
throttle.

e Throttle Only — You control only the throttle of the heli. RealFlight will control the roll,
yaw, and pitch.

e Throttle, Pitch — You control both the throttle and pitch of the heli. RealFlight will control
the roll, and yaw.

e Throttle, Roll — You control both the throttle and roll of the heli. RealFlight will control
the pitch, and yaw.

e Throttle, Yaw — You control both the throttle and yaw of the heli. RealFlight will control
the roll, and pitch.

e Throttle, Pitch, Roll, Yaw — You control all channels for the heli.
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Help-

If you wish to display the welcome and get ready dialog screens again, select Show Training
Dialogs from the Help menu.
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Heli Autorotation Trainer

Every helicopter pilot will tell you that one of the most important things to learn is how to
properly perform an autorotation in case your model should experience a motor/engine loss
of power. This Heli Autorotation Trainer offers you a great way to learn this maneuver.

Trainer Help

To start the trainer, click Heli Autorotation Trainer... menu item from the Training menu.
The trainer will start automatically.

A welcome dialog will first appear to explain the goals of this trainer and offer a few tips. If
you do not wish to see this dialog screen again each time you load this trainer, simply click
the Don’t show this message again checkbox at the bottom, then click Close.

Following the welcome dialog, the get ready dialog screen will appear. This screen will
explain what you are required to do for this trainer. There is also a checklist that you should
follow before you proceed. If an item in the checklist is set, the Ready light will illuminate.
Otherwise, the Ready light will be dim, and the function on the controller pictured to the left
will blink indicating what needs to be done.

The get ready dialog is a great way to prepare for the trainer. Once you have successfully run
through the trainer a few times and no longer wish to see this dialog, simply click the
checkbox labeled Don’t show this message again and then click Go.

You'll notice that the heli appears in the air with a line below it drawn towards the ground.
On the ground is a boundary circle in which you must land.
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Trainer Menu-

The trainer Menu contains the following menu items:
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Reset Aircraft-

If you crash, there are three ways to reset the aircraft:

1. Press the Reset button on the InterLink DX controller. This is probably the
fastest and simplest method.

2. Press the keyboard’s space bar.
3. Click the Reset Aircraft menu item.

Boundary-

The Boundary menu item allows you to change the size of the circle or eliminate it
altogether. To change the size or the boundary, select the Boundary menu item from
the Trainer menu. A drop-down menu will appear with the following options:

e None — Eliminates the boundary circle.

e Small—Creates a small circle.

e Medium — Creates a medium-sized circle.

e Large —Creates a large circle.
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Initial Altitude-

This sub-menu item allows you to adjust the altitude from which you will start the
autorotation. A low altitude will offer less time for you to make adjustments to your
landing, however, it is good to practice emergency autorotations at all altitudes.
There are three options available:

e Low—While a lower altitude offers less time for input, the inertia will have less
time to diminish as well.

e Medium — Allows for a mid-level autorotation.

e High —The helicopter will start at a higher altitude. Thus, the pilot will have to
compensate accordingly to ensure a safe autorotation landing.

Approach Position-

The Approach Position sub-menu allows you to adjust the initial location of the heli,
from right to left, with middle directly in front of the landing zone. You may also
choose Inverted from this sub-menu to practice maneuvering the heli back to an
upright position before landing during the autorotation.

Crashes-

After a crash, RealFlight may automatically reset your aircraft for you, if so desired.
This option is on by default. If you would prefer to turn this option off, select the
Crashes menu item, then select the Automatically Reset Aircraft. If a checkmark
appears next to this menu item then this feature is activated. If the checkmark does
not appear, it is not active.

If Automatically Reset Aircraft is enabled, you can adjust how quickly the reset
happens. To adjust this delay, select the Crashes menu item followed by the Reset
Delay menu item. Four options will be available to you:

e None — No delay will be set. The aircraft will reset instantaneously.

e Short —The aircraft will reset approximately one second after it crashes.

e Medium —The aircraft will reset approximately three seconds after it crashes.

e Long—The aircraft will reset approximately six seconds after it crashes.
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Exit-
If you wish to leave the Heli Hover Trainer and return to the simulator, select the Exit
menu item.

Help-

If you wish to display the welcome and get ready dialog screens again, select Show Training
Dialogs from the Help menu.
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Heli Orientation Trainer

As you become more proficient with hovering a helicopter, you can test your skills with the
Heli Orientation Trainer. The Heli Orientation Trainer challenges you to keep your helicopter
in the same location as the trainer helicopter. As you succeed in doing so the trainer
helicopter will move and the level of difficulty will increase.

To start the trainer, select the Heli Orientation Trainer menu item from the Training menu.

The Heli Orientation Trainer has a number of different levels, each with an increasing degree
of difficulty greater than the previous. To pass a level you must hover your helicopter in close
proximity to the trainer helicopter, mimicking the attitude, etc. of the trainer helicopter. As
you do so, the trainer helicopter will turn from blue to red and the progress bar at the top of
the screen will increase indicating that your task is nearly complete.

m| RealFlight

Heli Orientation
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In the upper right corner, a countdown timer is visible. This is the remaining amount of time
allotted for you to fill the progress bar and complete the task. If you fail to do so, both the
timer, and the progress bar will reset to zero. You must begin once again.

The number displayed in the upper left corner indicates the number of locations the trainer
helicopter will stop for the current level. It will also indicate how many of these locations you
have completed. For example, if it displays 1/3, you have successfully completed one spot
out of three for the current level.
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As you advance to the next level, you may be responsible for controlling more channels, the
allotted time might also decrease, and the trainer heli will stop in more locations. You might
also experience any combination of these circumstances as the difficulty increases.

Heli Orientation Menu-

The Heli Orientation menu is the only menu accessible while the trainer is running. Two
options are available in the Heli Orientation menu:

Heli Orientation

Select Level

Select Level-

A drop-down menu will display the levels available to you. For example, if you have

only progressed to Level 2, you will not be able to access Level 3 or higher in this
menu.

A checkmark will appear next to the level you are currently flying.
Exit-

To return to the simulator, select Exit to leave the Heli Orientation Trainer.
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Airplane Hover Trainer

The Airplane Hover Trainer offers you a great way to learn how to control an aerobatic
airplane in a torque roll. With the Airplane Hover Trainer, you pick which channel or channels
you wish to control. RealFlight automatically controls the rest.

To start the trainer, click the Airplane Hover Trainer... menu item from the Training menu.
The trainer will start automatically.

## RealFlight = O X

Trainer Orientation Control Help
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A welcome dialog will appear to explain the goals of this trainer and offer a few tips. If you do
not wish to see this dialog screen again each time you load this trainer, simply click the Don’t
show this message again checkbox at the bottom, then click Close.

Following the welcome dialog, the get ready dialog screen will appear. This screen will
explain what you are required to do for this trainer. There is also a checklist that you should
follow before you proceed. If an item in the checklist is properly adjusted, the Ready light will
illuminate. Otherwise, the Ready light will be dim, and the function on the controller pictured
to the left will blink indicating what needs to be done.

The get ready dialog is a great way to prepare for the trainer. Once you have successfully run
through the trainer a few times and no longer wish to see this dialog, simply click the
checkbox labeled Don’t show this message again and then click Go.
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Within the trainer, you'll notice a circle on the ground. This circle represents the training
boundary, or perimeter. If your airplane ventures beyond this boundary, it will break apart
and the session will begin once again. You'll also note an X’ mark within the boundary that
represents the current location of your airplane. The goal is to control the airplane in a stable
hover; keeping it as close to the center of the circle as possible.

Trainer Menu-

The Trainer menu contains the following menu items:

Trainer Orientation Control Help

Reset Aircraft Space Bar

Boundary >
Crashes >

Exit

Reset Aircraft-

If you crash or fly outside the circle, there are three ways to reset the aircraft:

1. Press the Reset button on the InterLink DX controller. This is probably the
fastest and simplest method.

2. Press the keyboard’s space bar.

3. Click the Reset Aircraft menu item.
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Boundary-

The Boundary menu item allows you to change the size of the circle, or eliminate it
altogether. To change the size or the boundary, select the Boundary menu item from
the Trainer menu. A drop-down menu will appear with the following options:

e None - Eliminates the boundary circle.

e Small—Creates a small circle.

e Medium — Creates a medium-sized circle.

e lLarge—Creates a large circle.

Crashes-

After a crash, RealFlight may automatically reset your aircraft for you, if so desired.
This option is on by default. If you would prefer to turn this option off, select the
Crashes menu item, then select the Automatically Reset Aircraft. If a checkmark
appears next to this menu item then this feature is activated. If the checkmark does
not appear, it is not active.

If Automatically Reset Aircraft is enabled, you can adjust how quickly the reset
happens. To adjust this delay, select the Crashes menu item followed by the Reset
Delay menu item. Four options will be available to you:

e None — No delay will be set. The aircraft will reset instantaneously.

e Short —The aircraft will reset approximately one second after it crashes.

e Medium —The aircraft will reset approximately three seconds after it crashes.

e Long—The aircraft will reset approximately six seconds after it crashes.

Exit-

If you wish to leave the Airplane Hover Trainer and return to the simulator, select the
Exit menu item.
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Orientation Menu-

The Orientation menu allows you the option to select the position and attitude of the
airplane when the session begins or the airplane is reset.

## RealFlight

Trainer = Orientation Control Help

A checkmark will appear next to the currently selected orientation. The options available are:

e Random —The airplane will start in a random position, with the top, bottom, left side or
right side facing you.

e Top—The airplane will start with the top of the aircraft facing you.

e Bottom —The airplane will start with the bottom of the aircraft facing you.

e Left —The airplane will start with the left side of the aircraft facing you.

e Right—The airplane will start with the right side of the aircraft facing you.
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Control Menu-

The Control menu allows you to select which channel or channels to control. The remaining
channels are controlled by RealFlight, allowing you to learn just the controls you wish and
adding more as you become more comfortable and confident.

## RealFlight = O X

Trainer Orientation Control Help
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Elevator Only

Aileron Only -
v Rudder Only
Throttle Only
Throttle, Elevator
Throttle, Aileron
Throttle, Rudder
' Throttle, Aileron, Elevator, Rudder

-

A checkmark will appear in the menu next to the currently selected item. Your options are:

e Elevator Only — Check this to control only the elevator of the aircraft. RealFlight will
control the throttle, ailerons, and rudder for you.

e Aileron Only — Check this to control only the ailerons of the aircraft. RealFlight will control
the throttle, elevator, and rudder for you.

e Rudder Only — Check this to control only the rudder of the aircraft. RealFlight will control
the throttle, ailerons, and elevator for you.

e Throttle Only — Check this to control only the throttle of the aircraft. RealFlight will
control the elevator, ailerons, and rudder for you.

e Throttle, Elevator — Check this to control the throttle and elevator of the aircraft.
RealFlight will control the ailerons and rudder for you.

e Throttle, Aileron — Check this to control the throttle and ailerons of the aircraft. RealFlight
will control the elevator and rudder for you.
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e Throttle, Rudder — Check this to control the throttle and rudder of the aircraft. RealFlight
will control the elevator and ailerons for you.

e Throttle, Aileron, Elevator, Rudder — Check this to control all four channels. You will not
receive any assistance from RealFlight.

Help-

If you wish to display the welcome and get ready dialog screens again, select Show Training
Dialogs from the Help menu.

m# RealFlight
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Lol —t Show Training Dialogs
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View Menu

ADJUST YOUR VANTAGE POINT, CHANGE YOUR LOCATION, ENABLE EFFECTS,
AND MORE.

his menu allows you to adjust the various view-related features and functions of the
simulation. The View menu adjusts what you are looking at and where you are looking
from.

## RealFlight

Simulation Aircraft Environment Challenges Gadgets Multiplayer Recordings Training View Help

Scenery
Effects

Camera Type

Camera Position
Look At
Zoom Type

Zoom In
Zoom QOut
Zoom Reset Backspace

Head Tracking

Flight Modes

® AS3X: Experienced
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Scenery

The Scenery menu item is used to determine whether to show or hide scenery objects in the
airport.

Simulation _ Aircraft  Emronment  Chabenges  Gadgets  Multiplayer Recordngs Trainng | View  Help

L3 scenery

5 - z
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Selecting this item brings forth a pull-down menu with a list of items you can show (make
visible within the simulation) or hide (remove from visibility). To show items, check them in
the drop-down menu. To hide items, click on them to remove their respective checkmark.

If the frame rate slows dramatically, try eliminating some of the items listed in the Scenery
sub-menu. This will improve the frame rate. To remove all items from the scene, click None.
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Effects

The Effects menu item is used to determine whether to show or hide simulator
enhancement objects in the airport.

Flight Modes ox

® AS3X: Experienced

Selecting this item brings forth a pull-down menu with a list of items you can show (make
visible within the simulation) or hide (remove from visibility). To show items, check them in
the drop-down menu. To hide items, click on them to remove their respective checkmark.

Pilot Nametags-

When multiple aircraft are flying, either from a multiplayer session, or when you are playing
a recording, the pilot’s name will follow the aircraft on screen. This indicator will appear on
the edge of the screen if the aircraft is out of view, giving you a general direction on where to
find that aircraft.

Unchecking this menu item will eliminate the Pilot Nametags from the screen.

Sky Grid-

As the name suggest, Sky Grid is a framework of lines that appear in the sky when activated.
Modelers practicing precision aerobatic maneuvers will appreciate these lines as they will
assist them in perfecting their routines.

To enable Sky Grid, click the View menu title, followed by the Effects sub-menu. Then, click
the Sky Grid menu item.
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Trails-

Trails, as the name implies, will create a trail or pathway through the sky depicting all facets
of flight for the aircraft. This feature is very useful for F3A pattern pilots and FAI heli pilots as
well as those modelers wanting to see how precise their maneuvers truly are.

Think you’re a precision pilot? You might be able to fool the judges at a contest, but you can’t
change reality in RealFlight. With RealFlight’s Trails feature, the pathway initiates from the
wingtips of an airplane model and from the main rotorblades of a helicopter and remains in
the sky for the duration of the flight, allowing modelers to thoroughly review their trail from
start to finish. If you stray even a fraction from straight-and-level, or your loops aren’t exactly
round, the evidence is onscreen.

You will also find this feature very useful when used in combination with the Sky Grid feature
mentioned above.

To enable Trails, click the View menu title, then the Effects sub-menu. Then, click the Trails
menu item.

Rotary Trails-

Rotary Trails function similarly to the Trails feature, except it highlights the path of the prop
of the airplane or main rotor of the heli; additionally, the rotary trails do not remain onscreen
throughout the flight.

To enable Rotary Trails, click the View menu title, followed by the Effects sub-menu. Then,
click the Rotary Trails menu item.

Wind Field Indicators-

Flying at sites designed for practicing thermal and slope soaring flight, Wind Field Indicators
will display where the updrafts are located and their direction. To practice real-world
scenarios, you may wish to turn off these indicators.

To enable Wind Field Indicators, click the View menu title, followed by the Effects sub-menu.
Then, click the Wind Field Indicators menu item.
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ﬂ Camera Type

The Camera Type menu item determines the Camera Type for the active viewport. Each
viewport is independently adjustable. Select from a Fixed Position, Nose or a Chase view. If
your aircraft is equipped with on-board cameras, they will be listed here as well.

Flight Modes ox
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To access the Camera Type adjustments, click on the View menu followed by the Camera
Type menu item. Select your preferred view from the pull-down list.

Please note: Some airports do not allow Camera Type adjustments.

Fixed Position-

In this mode, the camera remains in a fixed, stationary position. The position is determined
by the Camera Position setting.

Nose-

The Nose selection places the camera at the front of the aircraft looking forward.
To magnify the view or zoom in on the selected item, press the [+] (plus) key on the
keyboard. Each time you press the [+] (plus) key or select the Zoom In menu item, the zoom

level increases incrementally. Alternatively, you may select the Zoom In option from the
View menu.
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To decrease the magnification, or zoom away from the selected item, press the [-] (minus)
key on the keyboard. Each time you press the [-] (minus) key or select the Zoom Out menu
item, the zoom level decreases incrementally. Alternatively, you may select the Zoom Out
option from the View menu.

Chase-
The Chase mode positions the camera behind the aircraft. The camera will follow the aircraft

as it moves.

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the
keyboard. Each time you press the [+] (plus) key or select the Zoom In menu item, the zoom
level increases incrementally. Alternatively, you may select the Zoom In option from the
View menu.

To decrease the maghnification, or zoom away from the selected item, press the [-] (minus)
key on the keyboard. Each time you press the [-] (minus) key or select the Zoom Out menu
item, the zoom level decreases incrementally. Alternatively, you may select the Zoom Out

option from the View menu.

Onboard Cameras-

Depending on the aircraft, there may be additional cameras available on and around the
aircraft, looking at a variety of different directions and perspectives. For example, the P-51
Mustang is equipped with three onboard cameras that include:

e Cockpit — This camera is placed inside the P-51 cockpit, looking forward,
much like sitting in a real aircraft. This camera also includes some
“intelligence”, moving and rotating based on the current aircraft motion or
movement.

For example, during normal flight, the cockpit camera will try to predict and
look in the direction the aircraft is likely to fly. If you were to fly a knife edge
maneuver, the camera will look down towards the ground.

During combat events, this camera will attempt to look at the player you
have targeted.

e Rear—This camera angle is positioned slightly above the nose of the airplane, looking
rearward towards the cockpit and tail.

e Tail —Positioned at the top of the vertical stabilizer, this camera looks forward
towards the nose of the airplane.
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e Wing—Positioned at the tip of the port-side wing, looking back at the cockpit.

Onboard cameras can be added and modified much like other parts of the aircraft. Refer to page
134 in Edit Current Aircraft section for more information on how to edit RealFlight aircraft.

n Camera Position

This menu item determines where the camera will be situated when viewed from the
ground. Depending upon the airport selected, there may be one or more Pilot Spawn
locations to use as camera positions.

Gadgets Mutiplayer Recordings ¥mming | View Help
y o -,
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The RealFlight simulator automatically picks the default Pilot Spawn for the airport that you
have loaded.

To change the setting, click on the viewport to you wish to modify. This becomes the active
view in the simulation. To access the Camera Position adjustments, click on the View menu
followed by the Camera Position menu item. Select your preferred view from the drop-down
list.

You may also press the keyboard’s ‘X’ key to toggle through the available Camera Position
options. If the airport has two pilot spawn locations, for example, pressing the ‘X’ key will
toggle back and forth between these two locations.
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E Look At
This menu item changes what the camera looks at. Usually you will want the camera to
remain focused on your aircraft.

Flight Modes ox
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Click on the viewport that you wish to modify. This becomes the active view in the
simulation. To access the list of things to look at, click on the View menu followed by the
Look At menu item. Then select an item to look at. For example, if you are in a multiplayer or
MultiMode session, the other players in the session will be listed in the popup menu. Select a
player to look at his/her aircraft.
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7z [ Zoom Type

The Zoom Type menu item allows you to change the type of zoom used in the simulation.

[Semusbon AscraftEmaronment _ Challenge: Godgets  Maubiployer Recordings ¥oming View  Help |
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Click on the viewport that you wish to modify. This becomes the active view in the
simulation. To access the Zoom Type menu item, click on the View menu followed by the
Zoom Type menu item. Select the Zoom Type option that accomplishes your goal. You may
choose between Manual, Autozoom, and Keep Ground in View.

Autozoom-

This zoom type adjusts the zoom range based on the distance of the aircraft from the pilot.
The camera automatically zooms in as the aircraft gets further from the pilot and then
automatically zooms out as the aircraft gets closer to the pilot.

Keep Ground in View-

This zoom type attempts adjust the camera so that the aircraft and the ground are always in
view. This is the only zoom type that disallows zooming in and out.

Manual-

This enables the standard view with zoom capabilities. See the Zoom In and Zoom Out
sections below for more information.
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' Zoom In

Once you have selected the type of zoom that you desire, RealFlight allows you to customize
it further by zooming in.
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Click on the viewport that you wish to modify. This becomes the active view in the

simulation. To access the Zoom In menu item, click on the View menu followed by the Zoom
In menu item.
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Zoom Out

Once you have selected the type of zoom that you want you can customize it further by
zooming out. Zooming Out decreases the magnification.

Flight Modes ox
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Click on the viewport that you wish to modify. This becomes the active view in the
simulation. To access the Zoom Out menu item, click on the View menu followed by the
Zoom Out menu item.
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Zoom Reset
4—
This selection resets the zoom magnification level to its default value. This is useful if you are

zoomed way in or way out and want to return quickly to the default level of magnification.

Camess Type

Camera Position
Look At

Zoom Type

Zoom in

Zoom Out -
ZoomReset Backspuce.
Head Vacking
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Click on the viewport that you wish to modify. This becomes the active view in the
simulation. To access the Zoom Reset menu item, click on the View menu followed by the
Zoom Reset menu item.
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Head Tracking

RealFlight 9.5 is compatible with the TrackIR from NaturalPoint. With a TrackIR plugged into
your computer, you can control the camera with the movement of your head as if you are at
the field looking around.
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Zoom Type
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Zoom Out

Zoom Reset

Head Vacking
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For example, if you are flying at a high altitude and wish to line up with the runway, at a
flying field you would look down briefly. With the TrackIR, you would do the same at your
computer. With a small movement of your head, you can look down at the runway and back
up to your aircraft.

For more information about TrackIR, and where to purchase one, visit NaturalPoint’s website
at:

http://www.naturalpoint.com/trackir/
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Help Menu

WHEN ALL ELSE FAILS, ASK FOR HELP.

his menu provides you with miscellaneous assistance and guidance with a variety of
simulator-related issues.

To access the Help files, click on the Help menu title.

Realfignt Hep..
Facbo nerfoce Help..

Spektrum WS1000/WS2000 Dcngle Help...
Keybosrd Commens.

Welcome Screen..

Video Blaer..

Reset To Defauls..
Techrical Support..
iebsites

Licanse...
About.

Flight Mode: @x

* AS3X: Experienced
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RealFlight Help

This menu item accesses the RealFlight 9.5 manual which you are reading now.
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Spektrum WS1000/WS2000 Dcngle Help...
Keybosrd Comments.

Welcome Screen..

Video Blger..

Reset To Defauts..

TechnicalSupport..

Websites

License..

About
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To access the RealFlight Help file, click on the Help menu title.
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Radio Interface Help

We understand that setting up RealFlight to function correctly with your real transmitter can
be daunting the first time. To assist you with this particular task, we’ve provided a guide to
walk you through this setup.
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To access this guide, click the Radio Interface Help menu item.
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Spektrum WS1000/WS2000 Dongle Help

USB Spektrum Wireless Simulator Dongle-

The Spektrum WS1000/WS2000 Wireless Simulator USB Dongles are compatible with any of
the Spektrum transmitters that utilize the Spektrum DSMX or DSM2 protocols.

This interface unit allows modelers to wirelessly control the flight of their RealFlight models
from the same transmitter that will be used to fly their actual models. There are several
different modes of operation. For additional information on connecting the WS2000 and
programming the transmitter (if applicable) please refer to the WS2000 sections within this
manual.

Connecting your Spektrum Transmitter to the WS2000 Wireless
Dongle-

The WS2000 dongle allows the use of Spektrum DSMX and DSM2 compatible transmitters
with RealFlight.

1. Select a new default (unused) model in your Spektrum transmitter.

2. Press and hold the bind button on the side of the WS2000 Spektrum wireless simulator
dongle. This is the area with the Spektrum logo represented by the ‘bars’. With the bind
button depressed, insert the unit into a powered USB port. The wireless dongle should
enter a bind mode indicated by a rapidly blinking light. If using the WS1000 wireless dongle,
the bind button is located on the end of the dongle.

3. Follow the bind process/methodology for your transmitter, bind the wireless dongle to your
Spektrum transmitter.

A solidly glowing light on the wireless dongle indicates that it is now bound to the
Spektrum transmitter.

If you experience difficulty in binding to the wireless dongle, move the transmitter away
from the dongle while attempting to bind. We suggest a distance between 1-3 meters.

Implementing the WS2000 Wireless Dongle with RealFlight-

Make sure that the dongle is inserted in a powered USB port and that the Spektrum
transmitter is powered on and bound to the dongle as described above. For our example,
we will be utilizing the WS2000 which is the most recent wireless dongle offered.

1. From the Simulation menu, click the Select Controller... menu item. The following
window will appear:
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Select Controller

SPEKTRUM RECEIVER (Active)
ﬁ Profile
[IXS andVySZ000 Edit Calibrate

Refresh

2. Ifit not already selected, please select the Spektrum Receiver (WS2000) as the Active
controller methodology. The controller/device that is currently in use (or ‘Active’) is
indicated by the orange bar next to the name (as depicted in the image above). To
do so, simply click anywhere in the box that denotes the controller type.

3. If the Spektrum Receiver/controller does not appear in the list of options, click the
Refresh button. This will, as the name suggests, update the list of available
controllers and the Spektrum Receiver (WS2000) should now appear amongst these
options.

Select Controller

InterLink DX (Active)

Profile

Interlink D% ~ Calibrate

Refresh
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Select Controller

SPEKTRUM RECEIVER (Active)
Profile .
' XS and VV/S2Z000 Edit Calibrate

InterLink DX
Profile

Interlink X Calibrate

Refresh

4. Click OK to accept the selected controller and return to the simulation.

Your transmitter’s control inputs should function within the simulation at this point. Please
verify by inputting commands from your Spektrum transmitter and viewing the aircraft’s
movement onscreen.

From here, we strongly recommend calibrating the Spektrum radio within the simulation.
This will ensure that the models are trimmed properly and that the control input yields the
desired output. For example, you want to make sure that the aileron stick not only moves
the aileron but also that it moves it in the proper direction.

RealFlight also offers an incredible amount of flexibility and customization. This same level of
flexibility is afforded to the control methodology as well. For example, it is possible to assign
a different switch, knob, etc. to control a given function within the simulation to suit your
personal preference.

Please refer to the applicable section of this manual for information on the profile,
calibration, editing, etc. within the simulation.

It is possible that you may still need to edit the radio profile to work with the channel
mapping of your radio. Please see Select Controller... on page 56 for more information.
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n Keyboard Commands

RealFlight allows you to access menu and other commands from your computer’s keyboard.
A key that directly invokes a command is called a “quick key” or “hot key”.

For example, pressing the [+] (plus) key on the keyboard’s number pad incrementally zooms
your view towards the aircraft. This is exactly the same result that arises if you select Zoom In
from the RealFlight 9.5’s View menu item. Consequently, we say that the [+] (plus) is a hot
key for the Zoom In command.

To access the Keyboard Commands, click the Help menu title, followed by the Keyboard
Commands menu item.

# AS3X: Experienced
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The following overlay will appear:

Keyboard Commancls

Virtual Channels

nel 4

Gadget Commands
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Ctrl + Shift + C
Enter

View Commands

Feset Aircraft

The Keyboard Commands screen contains all of the information pertaining to the hot keys.
To view the entire list, drag the scroll bar on the right side of the Keyboard Commands screen
down. Alternatively, this list is also contained on the back cover of the Installation Guide
which accompanied this software [DVD version only].

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen.
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Welcome Screen

The Welcome Screen that appears when you first start RealFlight can be accessed at any
time from this menu item.

Tnveonment  Chabenges Gadgets Muliplayer  Recordngs Training View Help
3 y % L RealFight Hep..
Racbo ntetace Help..
Spekirum WS10H/WS2000 Dongie Help..
Keybond Commands..

Welcome Screen...
Video Pleyer...

Reset To Defwults...
Technical Support.
Websites

Ucanse...
About..

* AS3X: Experienced

The Welcome Screen gives you the ability to change aircraft, flying sites or scenarios. You
may also select a most recently flown aircraft, earn Challenge medals, or open the video
player window.

RealFlight 9.5 RC Flight Simulator




Video Player

RealFlight offers training videos to assist the first-time RC pilot as well as videos to highlight
some of the more popular features available. Selecting the Video Player menu item will
display the following screen.
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Keyboard Commends..

Wiecome Screen..
Video Player...
Reset To Defauls..
Technical Support..
ebsites

License...

About..
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Video Player.

Choose a Video

0

FEATURES

Guided Tour Aircraft and Collisions Combat Customization
Flying Sites
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FPV and Movable Gadgets Gliders InterLink Elite Night Flying Real Rendering
Camera and DOF

ITERLINK

RealFlight Reset Rewind Skygrid and Training Aids Water Takeoffs
Overview TruFlow and Landings
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Clicking a thumbnail will automatically start that video. To return to the video selection
screen, simply click the Choose Another Video button found at the lower right corner.

The Video Player is also accessible from the Welcome Screen.
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Reset to Defaults

This option will reset all of your RealFlight settings to their original values and then restart
the simulator.
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Keyboard Commands.
Wiekcome Screen.
video Player..

Reset To Defaks...
Technical Support..
ebsites

License...
About..
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It is perfectly safe. Custom content such as modified aircraft and airports, imported content
from the swap pages, and challenge scores will not be affected. Think of this as a way to
freshen your installation and make it like new without having to uninstall and reinstall. Itis a
good way to fix things if you’ve made a change you don’t like but can’t remember what you
did.
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Technical Support

Choose this to exit the simulator and open a separate Technical Support dialog. It will take a
minute to gather data before it appears; this is normal.

Resifignt Hep_.
Fadio interface Help.
Spelarum WS1000/WS2000 Dongle Help...

Keyboard Commands.

Wekcome Screen..
Video Plger..
Reset T Defauts...
Techrical Support..
websites

License...
About..
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For more information please see the Technical Support section in Appendix B.
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Websites

This menu item contains direct links to the RealFlight related websites. Please ensure that
you are connected to the internet before making your selection. The options include:

Spelarum WS1000/WS2000 Dongle Help...
Keyboard Commands.

Wiekcome Screen.

video Player..

Reset To Defauls..
Technical Support..
Websites

License...
About..

* AS3X: Experienced

Horizon Hobby, LLC-

Publishers of the RealFlight 9.5 RC Simulator. Visit their site for information pertaining to the
many other Horizon Hobby exclusive product offerings.

Knife Edge Software-

Developers of the RealFlight 9.5 RC Simulator. Visit the Knife Edge forums to share
experiences and technical support with other RealFlight owners. The Knife Edge forums also
play host to a wide variety of free, downloadable aircraft, trim schemes, flying sites and
more.

RealFlight-

Visit the RealFlight website for more information about the RealFlight family of products,
search the knowledge base for technical support, or for information on how to contact our
support staff if you have questions.

Swap Pages-

If you have created your own aircraft, flying site or recording and would like to share it with
the rest of the RealFlight community, you can do so at the RealFlight Swap Pages. Or, visit the
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swap pages to download hundreds of aircraft, flying sites, etc. to add to your RealFlight
hangar.

License

This menu item contains the End Users License Agreement (EULA) for the RealFlight RC Flight
Simulator. Please read it carefully.

[Semulstion_Awcraft_ Emironment _ Challenges Gadgets Mukiplayer Recordings ¥aming Vi
: $ ;- =

ResiFight Help...
Radia interface Help.

Spektrum WS1300/WS2000 Dengle Help..
Keybosrd Commands...

Wiekcome Screen..

Vides Player..

Reset To Defuuls..

Technical Support..

Wiebsites

License...

About..

® AS3X: Experienced

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen.
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About

The About... menu item contains miscellaneous information pertaining to your software
including your RealFlight serial number and the version number of the software that you are
currently operating.

[Semulsbon Awcraft _Emaronment _ Challenges _Gedgets  Muliployer Recordings ¥aming _View | Help

ol ;B

Also seen in the About screen are the credits and names of the people that have worked
together to bring you one of the world’s most realistic RC simulators, RealFlight 9.5.

Clicking on the ‘X’ in the title tab of the frame will remove the About window.
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15

Virtual Reality

PUT ON A VR HEADSET TO COMPLETELY IMMERSE YOURSELF INTO
REALFLIGHT.

ealFlight 9.5 is compatible with the Oculus Rift and the HTC Vive, two of the most
popular VR devices currently available. Using VR with RealFlight increases the realism
and completely submerges, and immerses, you into the environment.

You will need to purchase VR hardware to take advantage of this feature. For more
information about these devices, check out their websites at:

Oculus Rift: https://www.oculus.com/rift-s/
HTC Vive: https://www.vive.com

In order to use the Oculus Rift S with RealFlight, please make sure to allow Unknown
Sources. This option is found in the Settings in the Oculus software.

Once set up, simply put on the VR headset. RealFlight will detect the VR device and
automatically switch to VR mode. Taking off the headset will revert back to normal mode.
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VR enables you to fly from standing on the ground looking up at your aircraft, exactly like you
would at your local flying field. At any flying site on RealFlight, set the throttle to zero and
reset the aircraft. Now, put on the VR headset. By default, you should be looking at your
aircraft. Fly as normal, but move your head to keep the aircraft in your view. While flying, you
can look around, find the runway and keep an eye out for the pits, and then quickly look back
at the aircraft, exactly like you would in real life at your local RC field.

To add a jolt of excitement, change your camera view to sit in the cockpit of the aircraft,
allowing you to look around while flying. You must choose to fly at a 3D airport to take
advantage of this feature. PhotoField airports will not work. Put the VR headset on, then
press the C key to cycle through the different camera viewpoints. If the aircraft is set up for it,
one of the viewpoints will be from the cockpit of the aircraft. From this vantage point, take
the time to move your head around to look at everything, including outside the aircraft. You
can even move forward/backwards and side-to-side to adjust your position in the cockpit.
The options are nearly limitless.
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Appendix

A

InterLink DX Controller

Utilizing the InterLink DX controller to improve your flying experiences.

Prior to picking up the InterLink DX controller and simply thrashing around the sky, it’s
beneficial to completely understand all that the InterLink DX controller has to offer as a
controller and an interface as well.

InterLink DX Layout-

The InterLink DX unit offers two two-position switches, five three-position switches, a rotary
knob, and a push-button, two horizontal sliders and two gimbal sticks to control the aircraft
within the simulation. Our engineering staff have designed this controller, and the applicable
functionality to mimic the typical input offerings from actual Spektrum transmitter offerings.

Additionally, the staff have incorporated the Scroll Wheel/Select button as well as the Reset and
Cancel buttons to enhance the RealFlight experience.

Below you will find the identification/layout of the switches, gimbals, etc. In subsequent areas
of this Appendix, we will further explore the options, etc. that are offered by the newly
developed Spektrum InterLink DX controller- and from the RealFlight 9.5 RC Flight Simulator
accordingly.
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As you’ll see, this is much more than a simple joystick controller or gaming device, used properly
the Spektrum InterLink DX controller and the RealFlight 9.5 RC Flight simulator software will
prepare you for many, many years of flying and complete enjoyment of the hobby alike.

1 | Switch A (2 Position) 16 | Power LED

2 | Switch B (3 Position) 17 | Rudder Trim (Mode 1, 2) Aileron Trim (Mode 3, 4)
3 |l|Button 18 | Elevator Trim (Mode 1, 3) Throttle Trim (Mode 2, 4)
4 | Switch C (3 Position) 19 | Elevator Trim (Mode 2, 4) Throttle Trim (Mode 1, 3)
5 [ Switch D (3 Position) 20 | Rudder Trim (Mode 3, 4) Aileron Trim (Mode 1, 2)
6 |RKnob 21 [ Neck Strap Mount

7 | Switch F (3 Position) 22 | Gimbal Stick Tension Adjust (Up/Down)

8 | Switch H (2 Position) 23 | Gimbal Stick Tension Adjust (Left/Right)

9 | Switch G (3 Position) 24 | Throttle Tension Adjust

10 | Left Stick 25 | Throttle Ratchet Adjust

11 | Right Stick 26 | Right Rear Slider

12 | USB Cable 27 | Left Rear Slider

13 | Reset Button 28 [Mode Change Switch

14 | Cancel Button 29 |Trainer Port

15 | Scroll Wheel / Select Button 30 ([Handle
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Physical Transmitter Adjustments-

The InterLink DX Controller incorporates all of the physical transmitter adjustments located
around the gimbal face of each gimbal. This arrangement allows for quick and easy adjustments
without taking the back cover off of removing any plugs to access adjustment screws.

Available adjustments:

e Change the Throttle Ratchet
e Change the Throttle Tension
e Adjust stick tension

Ratcheted Throttle- Smooth Throttle Adjustment

Ratchet

1. Locate the Throttle Strap adjustment screws on both gimbals. The ratchet set screw
engages a serrated section on the gimbal for a ratcheted throttle, while the tension set
screw engages a strap for smooth tension on the gimbal.

2. To engage the throttle ratchet, turn the ratchet screw clockwise until the ratchet
engages.

3. Todisengage the throttle ratchet, turn the screw counter-clockwise until the gimbal
moves freely.

Smooth Tension

1. To engage the throttle tension, turn the Tension screw clockwise until the Tension
engages.
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2. Todisengage the throttle Tension, turn the screw counter-clockwise until the gimbal
moves freely.

Adjust Stick Tension

Tension

Turn the screws clockwise a small amount using a small Phillips screwdriver to tighten the stick
tension and counter-clockwise to loosen.

Note: Always perform a test of the stick tension while turning these screws to ensure that stick
tension is not too loose or too tight. Tightening a screw too much may damage a spring.
Loosening the screw too much may cause the spring to fall off possibly resulting in a short-circuit
in the transmitter.

Control Stick Length Adjustment

ﬁ*@m

[l ug

1. Using a 2mm Allen wrench, turn the setscrew in the stick counter-clockwise to loosen.

2. Make the stick shorter by turning it clockwise. To make the stick longer, turn the stick in
a counter-clockwise direction.

3. After the adjustment of the stick lengths are completed, tighten the setscrew
accordingly.
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Mode Change Slider

There is a unique slider located on the back of the InterLink DX controller that allows for simple
mode changes. This slider can also be used to change each mode into a ‘quadcopter mode.’
This mode snaps both sticks to the center position accordingly.

Mode Slider

“y 3 "N . f
Slider Door — ST TP
1S o
{ &S 7

Mode 2, 4 ;
Quadcopter

Safety Plug

The Safety plug is installed in the controller to ensure that the mode switch cannot be
accidentally moved when in the normal throttle mode (non-centered) positions.

To remove the plug:

1. Grasp the plug by the raised rib and pull straight out.
Tip: Use a small flat-bladed screwdriver to gently pry the plug out.
2. Once the mode has been changed, reinstall the safety plug.

Mode 2, 4 Mode 1, 3
Mode 2, 4 Mode 1, 3
Quadcopter Quadcopter

Simply open the protective slider door and move the slider to the desired position. All changes
happen automatically inside the transmitter.
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Connecting Other Transmitters to RealFlight 9.5 RC Flight Simulator

o

To connect other compatible transmitters to the InterLink DX controller, and to use them within
the simulation, it is necessary to use the optional interface adapter cords (purchase RFL1015).
Simply plug the appropriate cord into the port on the rear of the InterLink DX, as shown above.
Plug the remaining end of the interface adapter cord into the trainer port of the transmitter.
The InterLink DX is now enabled as a pass through/interface unit.

For additional information on using other transmitters with the RealFlight 9.5 RC Flight
Simulator, please refer to the Using Your Own RC Radio section of this on-disc manual.
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Appendix

Spektrum WS2000
Wireless Dongle

Utilizing the WS2000 Wireless Dongle and your Spektrum transmitter to
improve your flying experiences- end enhance the realism.

Connecting your Spektrum Transmitter to the WS2000 Wireless
Dongle-

The WS2000 dongle allows the use of Spektrum DSMX and DSM2 compatible transmitters
with RealFlight.

1. Select a new default (unused) model in your Spektrum transmitter.

2. Press and hold the bind button on the side
of the WS2000 Spektrum wireless simulator
dongle. This is the area with the Spektrum
logo represented by the ‘bars’. With the
bind button depressed, insert the unit into a
powered USB port. The wireless dongle
should enter a bind mode indicated by a
rapidly blinking light.

3. Following the bind process/methodology for your transmitter, bind the wireless dongle to
your Spektrum transmitter.

A solidly glowing light on the wireless dongle indicates that it is now bound to the
Spektrum transmitter.

If you experience difficulty in binding to the wireless dongle, move the transmitter away
from the dongle while attempting to bind. We suggest a distance between 1-3 meters.
Implementing the WS2000 Wireless Dongle with RealFlight-

Make sure that the WS2000 is inserted in a powered USB port and that the Spektrum
transmitter is powered on and bound to the WS2000 as described above.
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1. From the Simulation menu, click the Select Controller... menu item. The following
window will appear:

Select Controller

SPEKTRUM RECEIVER (Active)
Profile
' DXS and V52000 Edit Calibrate

Refresh

2. Ifit not already selected, please select the Spektrum Receiver (WS2000) as the Active
controller methodology. The controller/device that is currently in use (or ‘Active’) is
indicated by the orange bar next to the name (as depicted in the image above). To
do so, simply click anywhere in the box that denotes the controller type.

3. If the Spektrum Receiver/controller does not appear in the list of options, click the
Refresh button. This will, as the name suggests, update the list of available
controllers and the Spektrum Receiver (WS2000) should now appear amongst these
options.

Select Controller

InterLink DX (Active)
Profile

Interlink O Calibrate

Refresh
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Select Controller

SPEKTRUM RECEIVER (Active)
Profile .
I XS Wi Calibrate

InterLink DX
Profile

Interlink X Calibrate

Refresh

4. Click OK to accept the selected controller and return to the simulation.

Your transmitter’s control inputs should function within the simulation at this point. Please
verify by inputting commands from your Spektrum transmitter and viewing the aircraft’s
movement onscreen.

From here, we strongly recommend calibrating the Spektrum radio within the simulation.
This will ensure that the models are trimmed properly and that the control input yields the
desired output. For example, you want to make sure that the aileron stick not only moves
the aileron but also that it moves it in the proper direction. The calibration process passes
inputs from the transmitter to the programming within RealFlight and is VERY important.

RealFlight also offers an incredible amount of flexibility and customization. This same level of
flexibility is afforded to the control methodology as well. For example, it is possible to assign
a different switch, knob, etc. to control a given function within the simulation to suit your
personal preference.

Please refer to the applicable section of this manual for information on the profile,
calibration, editing, etc. within the simulation.

It is possible that you may still need to edit the radio profile to work with the channel
mapping of your radio. Please see Select Controller... on page 56 for more information.

Virtual Channels-

RealFlight is designed as a 15-channel radio system though many transmitters do not
offer 15-channel functionality and/or has channels mapped non-sequentially.
Additionally, it should be noted that the WS2000 Wireless Dongle mimics an 8-channel
receiver.
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As such, our developers have programmed RealFlight 9.5 so that some channels may
function with keyboard input.

Key Channel Type

Y 5 On/Off Switch

U 6 Knob

I 7 On/Off Switch

@ 8 3-Position Switch

The on/off switches are very simple, pressing the key one time toggles the switch from
one extreme to the other.

Channel 6, the knob, functions differently though. A brief tap of the ‘U’ key moves the
knob’s position from one extreme to the other. Holding the ‘U’ key mimics a smoothly
rotation of the knob.

Channel 8, a three-position switch, functions similarly to the knob in that tapping the ‘O’
key quickly toggles the switch between the low and high positions. Pressing and holding
the ‘O’ key places the switch in the middle position.

RealFlight’s Software Radio-

The RealFlight program incorporates a sophisticated computer radio simulation
programmed for each model; the ‘Software Radio’. While many users find this
convenient as it saves time and allows them to enjoy the simulation immediately
without programming their own transmitter; others prefer to utilize their Spektrum
transmitter to familiarize themselves with the programming and ‘feel’ of the transmitter
that they will be using at their local field.

Three ways to use your radio within RealFlight RC Simulator:

e Fully enable the software radio

e Utilize the rates and exponential programming within your transmitter- ideal for
users with advanced skills that wish to use triple rates, exponential curves within
their transmitter, etc.

e Create a custom model memory within the Spektrum transmitter for each model
flown in the simulation. In doing so, RealFlight’s Software Radio is disabled and
all input/programming is done within the Spektrum transmitter

Fully Enable the Software Radio-

As noted above, RealFlight will utilize its sophisticated Software Radio to mimic a
computer radio’s rates, exponentials, and mixing functions. The program will
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automatically load the correct Software Radio settings for each individual model every
time you switch aircraft.

Again, this is the easiest option- and is the default setting. It is imperative that the
Spektrum transmitter send unmodified channel data to the simulation. Perform a
complete data reset on a given model memory, or select an unused model memory
within the transmitter. Prior to clearing any data, make sure that the model memory is
available and is not used for any other models, etc.

Please ensure that the Enable Software Radio Mixes AND the Enable Software Radio
Dual Rates and Expo are both checked- contain an ‘X’ as follows:

X! Enable Software Radio Mixes

Xl Enable Software Radio Dual Rates and Expo

Again, when you bind your transmitter to the WS2000, ensure that the stick, switch and
knob inputs function as desired. To do so, please refer to the Select Controller... section
of this manual. We will cover Channel Mapping once again in a subsequent section.

Utilize the Rates and Exponential from the Spektrum Transmitter-

Using the rates and mixes on your transmitter will enable you to use the advanced radio
functionality of your transmitter.

The disadvantage in this methodology is that it’s not tuned for each of the models
individually. That is, all of the rates and exponential are identical for all models
throughout the simulation.

X| Enable Software Radio Mixes

Enable Software Radio Dual Rates and Expo

It is necessary to create a Radio Profile utilizing the Edit Profile screen. When you’ve
done so, we suggest you name it something obvious to note that the mixes are active in
the software. This will prevent any confusion, or difficulties, later when the profile is
used in the software.

Fully Utilize all functionality from Spektrum Transmitter: Software Radio Mixes
and Software Dual Rates and Exponential-

This is the most advanced methodology as ALL functions are controlled from the
Spektrum transmitter. That is, all flying and flight inputs are directly from the
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transmitter through the software- including any mixing as well as the dual rates and
exponential functions.

The advantage in this method is that it’s feasible to use one of the model memories
from your field models and mimic flight within the simulation. All functionality is passed
directly to the model from the transmitter.

The disadvantage is that it’s necessary to create every function within the transmitter
from the start- and you’ll need a separate model memory for each model within
RealFlight.

X! Enable Software Radio Mixes

X Enable Software Radio Dual Rates and Expo
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Appendix

C

Basics of Flying

UNDERSTANDING THE FUNDAMENTALS OF RADIO CONTROL FLYING.

efore taking control of a transmitter, it helps to understand the basics of flight, and

the functionality of the gimbals, sticks and switches to properly control the aircraft.

This chapter reviews the basics of flying an airplane or a helicopter to help get you
started down the right path.

Airplane Basics

Before you fly the plane, make sure all switches are in their off or low rates, positions. The
switches may be assigned to different items depending on how you have configured your
controller and which aircraft you are flying. If you are using your own transmitter to control
RealFlight, please consult your transmitter owner’s manual for more information.

The InterLink DX features digital trim tabs which are more precise and offer trim memory
within the simulation. Trim tabs are the small slider controls on the controller (two per
controller stick). They “trim” the aircraft so that it flies straight and level. For example, if an
airplane has a tendency to veer slightly downward, you may need to add a slight “up” nudge
to the elevator. You can do this by sliding the elevator trim, a click or two at a time, towards
the bottom of the controller.

Flight Control-

Flying faster or slower: When your aircraft is stable in the air, push the throttle stick up to
make the aircraft go faster. Pull the throttle stick back to slow down. The aircraft will climb
when the throttle is increased.

Elevator Up and Down: Push the elevator stick forward to make the aircraft go down. Pull
the elevator stick back to go up.

Aileron Right and Left: Move the aileron stick right to make the aircraft roll or ‘bank’ right.
Move the aileron stick left to bank left. Tip: Always picture yourself in the aircraft when
determining which way to bank the aircraft wings. When the aircraft is flying away from you,
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banking the aircraft to the right or left appears normal. When flying toward you, the aircraft will
appear to bank in the opposite direction to the control input given. This will become more
instinctual with experience.

Rudder Left and Right: Push the rudder stick left or right to yaw or point the nose of the
aircraft left or right. The rudder stick is also used to steer the aircraft left and right while taxing
on the ground. Tip: Similar to aileron control, picture yourself in the aircraft to determine which
direction to point the nose whether you are flying away from yourself or toward yourself.

| Transmitter command | Aircraft Response
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Crashing-
Takeoffs are optional, but landings are mandatory. For any type of aircraft or flying,

successfully landing an aircraft is a crucial skill to master.

The key to a perfect landing is undivided concentration. Pay close attention to the altitude,
orientation, and speed of the aircraft as it approaches the runway. Should you happen to
crash, use each crash as a learning experience to perfect your approach and the landing.
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RealFlight has tools to help you stay on top of things during approach and landing. See the
“Landings” section below for some ideas.

Out at the field a crash might result in one or more of the following:

Bruise your ego

e End flying for the day

e Cost you money

e Cost you time to rebuild

e Cause injury to yourself or a bystander

e Even win you a nice “best crash trophy!”

Of course, when you crash on the simulator, there is really no harm done. None, that is,
except the bad habits you may acquire. We suggest that you take the crashes seriously and
learn from each one. By doing so, you will be a better pilot out at the field.

Airplane Flight-

The RealFlight 9.5 RC Simulator very accurately simulates how RC aircraft really fly. This
allows you to practice RC flight without worrying about expensive crashes. Additionally,
RealFlight 9.5 is ideal for practicing new maneuvers and experimenting with various
parameter adjustments.

It is important to remember, however, that a simulator will only help you learn to fly if you
let it. Otherwise, it is just a game. Learning to fly RC aircraft requires a commitment. One
does not just grab the sticks and start dazzling the crowds. A methodical, patient approach
will help you get the most out of this simulator.

This section is not designed to teach you how to fly. However, it will help you enhance your
experience with the simulator and obtain the most from your experiences.

Takeoffs-

When you are taking off, start with the throttle in low position and slowly increase throttle
by pushing the throttle stick away from you towards the top of the transmitter until you are
at about half speed. Stay in the middle of the runway (you can steer the plane using the
rudder). When you have built up enough speed, gradually pull back on the elevator stick to
climb off the runway. If the plane is tracking well, apply the rest of the power more quickly,
climb out, and gain altitude.
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Be careful not to veer off the runway. In a real plane, chances are that you would crash (or
get stopped on the grass). Usually this means bent landing gear and a broken prop. If your
plane has retracts, they could even be torn out of the wing.

Landings-

It is very important to land on the runway, rather than veering off, or touching down before
you reach the runway. Either of the latter usually produces a moderately expensive crash. If
you “cartwheel” (wing tip hits the ground first), the wing can break, resulting in lengthy down
time while you repair your airplane.

Start by aligning your plane parallel with the runway. Fly the approach normally, using your
throttle to control the rate of descent. Try to land at the slowest speed possible. If your plane
has flaps, use them to kill speed (but be careful; with flaps down your plane will try to pitch
up and climb). If your plane has retractable landing gear, lower them. As you touch down,
remember to keep your nose up!

Tip: While practicing landings in RealFlight, use the NavGuides during your approach to keep
track of your speed, altitude, and distance above ground.

Aerobatics-

When you practice aerobatics, the three important steps are:

e Start the plane straight and level, in a controlled situation
e Perform the maneuver

e Return to a straight, controlled situation

Anyone can give it full throttle, jam the sticks in all directions and watch the plane tumble
and roll. However, this is not what you will do out in the field. Do this and you will not have
control of the airplane!

The key to properly performing the maneuver is in the setup. Doing so will allow you to
cleanly finish and your experience will be more rewarding as well as more realistic.

Concentrate on making the maneuvers “clean and crisp.” If you are doing a roll, try to
keep the plane on a straight line as you roll. If you are doing a loop, try to make a
perfectly round circle.

Throttle Management-

Avoid the temptation of giving the plane full throttle and keeping it there for hours at a time.
This teaches you bad habits and makes even a good flier look like a rookie out at the field.
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Many of the maneuvers require proper throttle management in order to make a maneuver
look good. Loops, stalls, torque rolls, touch-and-goes are just a few examples. Try doing
various maneuvers at differing speeds. Try performing a slow roll at medium throttle and
keeping a perfectly straight line. This difficult maneuver will earn you more praise at the field
than doing a full speed, full stick roll.

Rudder Management-

Most airplanes can (more or less) be effectively flown with just the elevator and ailerons.
Good pilots will tell you that the proper use of the rudder is just as important, however.
Many aerobatic maneuvers require excellent rudder usage.

Rudder control is especially important when landing in a crosswind. Pilots that cannot use
the rudder usually land in the tall grass (embarrassing!). Pilots that do use the rudder can
land on the numbers almost every time.

| Transmitter command | Aircraft Response
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Helicopter Basics

A model helicopter is a very complicated machine, which operates on the same aerodynamic
principles as its full-scale counterpart. These principles are quite complicated to explain and
understand. However, it is not necessary to understand all the underlying aerodynamics in
order to successfully fly a model helicopter (or a computer simulation).

The following will help you to better understand the basics of helicopter flight, and the
relationship between control stick movements and the actions of the machine. Refer to
these instructions often as you become more proficient.

Please note: The inputs below are shown using a Mode 2 transmitter.

Collective (Left Stick — Vertical Movement)-

The spinning main rotor blades, which act like rotating wings, lift the helicopter into the air.
Changing the pitch (angle of attack) and speed of the blades, using the “collective” and
throttle causes the helicopter to rise and descend vertically. Adjusting “collective” increases
and decreases the blade pitch. The “throttle” control increases and decreases engine RPM.
On a model helicopter, the collective and throttle controls are mixed electronically, and
controlled by the throttle stick on the transmitter or controller.

Collective
Left Side View Left Side View
1
4—*\ Descend §
A 4
o> :
Climb :
1
Throttle up Throttle down

Rudder (Left Stick — Horizontal Movement)-

To turn the nose of the helicopter left or right, change the tail rotor pitch (by using the
“rudder” control). Changes in collective stick movement will require changes in the amount
of rudder input to maintain the desired heading.
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Rudder

Nose Yaws Right

Nose Yaws Left
Rudder left Rudder right

Cyclic Stick (Right Stick)-

The cyclic stick replaces the “aileron” and “elevator” controls found on a fixed-wing aircraft.
“Cyclic” is the term given to the control of the main rotor that allows the helicopter to fly
forward, backward, left and right. Forward cyclic stick movement causes the helicopter to
pitch forward, left cyclic causes the helicopter to tilt sideways to the left, on so on. You move
the helicopter forward or sideways using a coordinated movement of both the cyclic and
collective control sticks. Moving the cyclic stick to the right, while simultaneously increasing
collective, will cause the helicopter to move sideways to the right. “Rudder” control is used
to maintain the heading.

Elevator

Left Side View Left Side View

Backward

Elevator forward Elevator back

Idle-Up-

A switch on the controller actuates a special function, known as “idle-up.” Idle-up offers an
alternate throttle and pitch curve, different from the curves used for hovering. Idle-up is
usually used for aerobatics, when the pilot wants engine power added when pitch is
subtracted. For example, inverted hovering requires positive throttle and negative pitch. As
such, pulling the collective stick back provides positive throttle AND negative pitch
simultaneously.

Throttle Hold-

Another special function is known as the “throttle hold”. When activated, this switch sets
your throttle to idle but allows the collective to function normally. This allows you to practice
autorotations without shutting the engine off.
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Gyro-

Any sudden change to the torque of the main rotor, such as a quick change in RPM or a wind
gust, can cause the helicopter to turn unintentionally to an unwanted direction. An electronic
device known as a gyroscope (gyro) is used to “monitor” and correct for this by giving
commands to the rudder control to help stabilize the machine.

Gyros come in a variety of types, each with different features. A normal gyro will not return
the helicopter to its former heading; it will simply dampen the unwanted sudden movement.
We recommend you start by using the heading hold gyro instead; it will maintain course and
keep the nose of the helicopter pointed in the desired direction regardless of outside forces.

Helicopter Flight

Hovering-

The machine hovers by adjusting the collective/throttle control to maintain altitude, the
rudder to maintain heading, and minute adjustments to the cyclic controls to maintain
location. Hovering is the most important aspect of helicopter flight to master, since every
other movement of the machine begins and ends with a hover.

Forward Flight-

The helicopter moves forward by changing cyclic (moving the cyclic control forward). This
causes the rotor head, and thus the helicopter to tilt forward, resulting in a forward thrust.
As the cyclic increases, the collective must also be increased to maintain the desired flight
path. As forward speed increases, the collective can be reduced slightly.

Backward Flight-

Backward flight is accomplished by moving the cyclic control aft, which causes the rotor
head, and thus the helicopter to tilt backward. As the cyclic is moved aft, the collective must
also be increased to maintain desired flight path. As backward speed increases, the collective
can be reduced slightly.

Sideways Flight-

Moving the cyclic control left will cause the rotor head, and thus the helicopter to tilt left.
Add collective and left rudder to cause the helicopter to “slide” sideways to the left. As speed
increases, it will require progressively more rudder to maintain heading.

To move right, simply follow the same procedure, but reverse the cyclic and rudder
movements (move cyclic right, apply right rudder).
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Turning-

From forward flight-

Moving the cyclic control left, while applying a small amount of aft cyclic and feeding
in left “rudder”, will cause the helicopter to make a coordinated turn to the left. Right
movement of the cyclic and rudder sticks will cause the heli to turn to the right.

From a hover-

Use the rudder to rotate the nose of the helicopter in the direction you want.

Learning to fly a model helicopter is more difficult and challenging than any other
genre of radio control modeling, but is also the most rewarding as you master the
techniques required for sustained hover and forward flight. Computer simulation of
model helicopter flight is an excellent tool for learning the basics and dramatically
reducing the learning curve when you move on to the actual model itself.
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Appendix

RealFlight 9.5 Launcher’

['DVD and Tower Hobbies Digital versions only]

THE REALFLIGHT 9.5 LAUNCHER IS THE GATEWAY TO SIMULATOR FUN!

his item allows you to run the simulation, register and update the software, and much,
much more.

To run RealFlight or to access the additional options, click the RealFlight 9.5 Launcher icon
located on your desktop.

#* RealFlight Launcher

Run RealFlight ” -

REALFLIGHT

RealFlight Manual
Technical Support

Restore Defaults

Uninstall RealFlight

RF Serial #:
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Run RealFlight

To start running RealFlight, double-click the RealFlight 9.5 Launcher located on your desktop.
Next, click the Run RealFlight button. The simulation will begin loading the terrain, airport
objects, textures, etc. Your simulation experience will begin as soon as the loading process
completes.

RealFlight Update-

If an update exists for your RealFlight 9.5 RC Simulator, an on-screen indication will appear just
beneath the Run RealFlight button. With your RealFlight computer connected to the internet,
simply double-click the on-screen indication and the simulator will automatically update the
necessary files accordingly.

RealFlight Manual-

Press the RealFlight Manual button to bring up the manual, this document that you are
reading now, for the RealFlight 9.5 RC Simulator.
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Technical Support-

[Steam version: Some of the following buttons are not present.]

Press the Technical Support button to bring up technical support information pertaining to
your system. If you encounter any difficulties with RealFlight, this information can help you
to resolve the situation on your own, or may assist Horizon Hobby’s Support Staff to

diagnose the problem for you.

This dialog is also accessible via the Technical Support Help menu item in RealFlight.

Technical Support X

Installed in: C:\Program Files [x86)\RealFlight9
Free Disk Space [C:\) 90801 mb free
Launcher Version: 1.00.006

LauncherHelper Version: 1.00.019

RealFlight version: 9.50.003

Technical Support
: Enter Tech Support Code

Contact Technical 5 upport

Online Updates [Public Server]
\Update to Specific Version

Launcher Yersion: 1.00.019

Serial Numbers

RealFlight 9:
HHE Add-On:

[] Include serial numbers in assembled system
information. ONLY do this if sending info to
RealFlight Technical Support. Keep vour serial
numbers privatel

Launch Programs
DX Diagnostics
MSlnfo

:Display Properties
Ewxplorer

\Device Manager

Assemble System Information

Yiew Web Technical Support

Clear Download Cache

System Information Panel-

The panel on the upper-left portion of the window displays a list of the RealFlight
information as it pertains to your system.
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Serial Numbers Panel-

The panel on the upper-right portion of the window displays a list of the
RealFlight serial numbers for the product that has been installed on your system.
Include Serial Numbers-

This checkbox determines whether or not the serial numbers for the RealFlight
items are included with the Assemble System Information when this information
is sent to the Horizon Hobby Technical Support Staff.

This information will, of course, remain private between Horizon Hobby and the
owner of the RealFlight software. We recommend enabling this as it can greatly
assist in the identification and remedy of any difficulties that might occur.

Launch Programs-

DX Diagnostics-

This brings up Microsoft’s DXDIAG utility. Using this utility can further help diagnose
your system.

Please note: If you send us information about your system to help us diagnose a
problem, please dv ot use DXDIAG to generate that information. Instead, use the
“Assemble System Information” option. The “Assemble System Information” output
file contains more information than the DXDIAG output.

MSiInfo-

This option will run MSInfo. This will give you even more information about your
system. This program is not always installed on a particular computer, but normally
comes with programs such as Microsoft Office®.

Display Properties-

This brings up the display properties for your monitor. You can use this page to
change the resolution of your desktop.

Explorer-

This button launches Windows Explorer. This Microsoft Windows utility can help you
locate, move and back up your files.

Device Manager-

This button launches the Device Manager. This Microsoft Windows utility will help
you determine driver dates, as well as installing and updating video and sound card
drivers.
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Technical Support-

As the title suggests, the items in this section are designed to assist with any difficulties
that might arise with the application of the RealFlight 9.5 software on your PC. The
buttons will efficiently and effectively gather necessary information and enable you to
contact our staff accordingly.

Enter Technical Support Code-

Choose this option to enter a technical support code. If you do encounter problems
running RealFlight, our Technical Support team may supply you with a code to input
here. Entering this code will help them diagnose or even resolve your difficulty.

Technical Support Code X

Flease enter the technical support code given o pou
by our support perzonnel.

Cancel

Contact Technical Support-

This gives you the email address rfsupport@horizonhobby.com to which you can
email your difficulties. If you do email us, please be sure to attach the Assemble
System Information output to your email.

You will receive an auto-reply message back confirming that Horizon Hobby’s
Support Staff received your email. If you do not receive the auto-reply message,
please double-check that you sent your email to the correct email address.
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Assemble System Information-

Choose this option to collect critical information about your system, and about your
RealFlight settings. You may find this information useful if you try to troubleshoot
problems on your own. Moreover, if needed you can cut and paste this information
into an email to Horizon Hobby’s Support Staff.

C:\Users\REALFL~1\AppData\Local\Temp\launcheroutput.txt

C:hUsers\REALFL™1 \AppD atasLocalhT emphlauncherbaszic. bt

[nztalled im: C:5Program Files (286145 ealFlightd
Free Dizk Space [C:h) 90792 mb free

Al sers\REALFL~1\AppD ata'Local\T emptdsdiag. txt

Time of thiz report; 74742020, 222758
tachine name: PODD-REALFLIGHT
M achine 1d: Unknown
Operating System: Windows 10 Home B4-bit [10.0, Build 18362 [18362.19h1 _releaze_swve
Language: Englizh [Regional Setting: Englizh)
System kanufacturer: System manufacturer
System Model: Systern Product Mame
BIOS: BIOS Date: 03/25416 17:33:33 Ver: 0500008 [type: BIOS)
Proceszsar IntellR] Core(T k] i7-6700K. CPU @ 4.00GHz (3 CPUs), ~4.0GHz
kemorny: 32763ME Rék
Avallable 05 Memory: 32630MEB RAM
FPage File: B7420B uzed, 28301ME available
Windows Dir: C:YWINDOWS
Direct+ Werzsion: Direct< 12
[ Setup Parameters: Mat found W

-, O

'ou can press the 'Copy to Clipboard' button and then paste _

the information into an email to technical support. Or a better Copy to Clipboard
wal iz ko attach the file launcheroutput bt to an email. See
the title bar [above, top) For the full path to this file. ok

View Web Technical Support-
Choosing this option will open a browser window, and take you to a web site that

contains the most up-to-date technical support information for RealFlight.

Online Updates (Public Server)-

Update to Specific Version-

After registering (you only need to register once), you may update to the latest
version of the software. This will download all necessary files and correctly install the
upgrade.
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Click this button to update to the latest version of RealFlight 9.5.

Please note: Your PC must be connected to the internet in order to check for
updates.

Registration Information-

The first time that you access the Update to Specific Version button, a
Registration Information screen will appear. This screen enables you to input
your data which will be used in the future to assist with any technical questions
that might arise.

Password-

RealFlight enables the user to create a password specifically for RealFlight. This
will prevent others from registering this serial number should you inadvertently
misplace your RealFlight DVD.

If you forget your password, contact the Horizon Hobby Software Support team. To
do so, email them at rfsupport@horizonhobby.com. They will confirm your identity,
and reset your password.

RealFlight Newsletter-

Periodically, Horizon Hobby may send out an electronic newsletter to
customers that are subscribed. The newsletter includes information about
new products, shows we are attending, tips and tricks and other useful items.
If you wish to receive this newsletter check the box labeled Yes, | want to
receive the RealFlight newsletter via email.

Hardware Information-

RealFlight 9.5 offers the option of automatically sending us information
pertaining to your system hardware and settings when you register. If you
leave the Send Hardware Information box checked when you register,
RealFlight 9.5 will send us this information.

This hardware information will assist us in diagnosing any problems you may
encounter later, should you need to contact Technical Support.
Consequently, we suggest that you leave this box checked when registering.

This feature is optional. If you uncheck the box, RealFlight 9.5 will not send us
any information about your system. Alternatively, you can view exactly what
information RealFlight will send us before you decide. To view the
information, click the Technical Support button on the main RealFlight 9.5

RealFlight 9.5 RC Flight Simulator




Launcher window. When the Technical Support page appears, click Assemble
System Information.

Clear Download Cache-

Occasionally, files may become corrupt during a download. If you are having
difficulties with the online updates, remove all cached files using this option. Next,
choose Update to Specific Version and then select the Completely Refresh option.

Restore Defaults-

Use this button to restore the RealFlight’s default settings. Doing so will NOT remove custom
aircraft, flying sites, etc. Rather, it is designed to simply restore the factory default values and
settings for the simulation.

This functionality is also accessible via the Reset to Defaults in RealFlight.

Uninstalling RealFlight-

Click the Uninstall RealFlight button to uninstall the software. The following dialog will

appear:
Uninstall RealFlight 9.5 X

Warningl! Thiz will permanently uninstall BealFlight. |F this iz nob what you want to do,
then click CANCEL.

IJninztall Program
[ ] Remave user content [Custom aircraft, airports, color schemes, recordings, etc.]

[ ]Remave RealFlight serial numbers

Leave Expanszion Pack zenal numbers intact recommended if you have ather
verzionz of RealFlight installed)

[ ] Remave all cached files from the online update

[ UNINSTALL | Cancel

The RealFlight 9.5 Launcher will remove all necessary RealFlight files.

Uninstall Program-

Choose this option to uninstall only the RealFlight 9.5 program itself.

Remove user content-

Choose this option to uninstall any user files such as customized airports, customized
aircraft, color schemes, etc. Be careful with this option! These files are unrecoverable
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after being uninstalled. You could lose a lot of your work by inadvertently uninstalling
these files.

Remove Serial Numbers-

Choose this option to remove the serial numbers from your system. This will remove
the RealFlight serial number as well as your online activation. Since RealFlight
Expansion Packs may also be installed on your computer for previous versions of
RealFlight, you may wish to leave those serial numbers untouched. To do so, click the
box Leave Expansion Pack serial numbers intact.

Remove All Cached Files From The Online Update-

Choose this to option to remove all cached download files from your system. If you
uninstall these files, future downloads may take a little longer.

RealFlight 9.5 RC Flight Simulator




Appendix

If You Experience
Difficulties

TIPS AND TRICKS FOR SOLVING THE MORE COMMON PROBLEMS.

he RealFlight 9.5 simulator is on the cutting edge of technology, and therefore

operates using advanced hardware. Consequently, there is always the remote

possibility you may experience a few slight difficulties. Should the need arise, we
provide extensive resources to help.

Besides providing arguably the best RC simulator, we sincerely feel that we provide the best,
most extensive product support of any RC simulator. Since cards, drivers, and operating
systems are always changing, we work hard to keep our support team up-to-date on the
latest information available to ensure that you have the most enjoyable experience possible.

This section begins with a summary of the various sources of RealFlight 9.5 information
including support and problem solving assistance. Then, we will show you some simple but
powerful steps that can resolve or prevent most RealFlight 9.5 difficulties. Finally, if these
steps fail to solve your difficulty, we will explain the most effective ways to acquire additional
assistance.

How to Get Help and Information

As a RealFlight user, you have access to an incredible amount of information about this
product. Much of this information can help you resolve difficulties, or correctly access and
use program features. Here is where you can find it:

e The manual. Most common RealFlight difficulties can be resolved by following the
instructions in later sections of this chapter; however there is also additional information
throughout other chapters that may be of assistance.

e Visit our product Knowledge Base at: https://realflight.com/support/kb/index.php. This is
a great resource and is an indexed, searchable collection of articles that describe
solutions to almost every known situation with RealFlight and all of our other software
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products. In fact, this is the same information database used by our product support
technicians.

e Visit the Knife Edge Software Message Boards at www.knifeedge.com/forums/. This is a
place where owners of RealFlight and other Knife Edge products post questions,
comments, and responses. Sometimes our product support technicians and product
developers from Knife Edge post replies and announcements as well. You may find a
thread that discusses the same difficulties that you are experiencing.

e Contact our Technical Support department by email at: rfsupport@horizonhobby.com.
Alternatively, our staff is also available via telephone or postal mail at:

RealFlight Technical Support
2904 Research Road
Champaign, IL 61822 USA
Voice phone: 877-504-0233

The product support teams are specially trained, and have many resources to help you
resolve problems with RealFlight 9.5.

Before You Do Anything Else

If you are experiencing difficulties with RealFlight 9.5, you should always try the steps below
first. These steps really do cure most problems our users experience. Even if you are not
having a problem, these same steps often assist in the operation of both RealFlight and your
computer.

e Update your video and sound card drivers (see instructions below).

e Update to the latest version of RealFlight 9.5.

e Ifthese steps do not work, proceed to the next section.

Update Your Drivers-

Before you do anything else, you should make sure you have updated your video and sound
drivers. A large number of difficulties encountered by RealFlight users can be cured by
updating drivers.
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A driver is a software program that controls your video or sound card. Each card
manufacturer provides drivers for its own cards. To work correctly, RealFlight relies on your
video and sound card drivers.

It is very important to use the latest available driver for your card. Card manufacturers
frequently release updated drivers to fix problems that occur when the driver is used with
programs such as RealFlight 9.5. The driver that came with your new computer, on your
Windows disc, or on the disc included with the new card you bought, may not be the latest
version.

If you do not know how to update drivers, you can find instructions in our Knowledge Base
article Q01-1038, How to Update Drivers, at
https://www.realflight.com/support/kb/article.php?p=RF8&q=01-1038. This page will take
you through the process step-by-step, and has links to driver download sites for most
manufacturers.

Update to the Latest Version of RealFlight 9.5-

As we regularly release program updates, the difficulty that you are seeing may already be
fixed in an update. Even if you just bought RealFlight, you should update to the latest version.
It's free and only requires a few minutes of your time.

If You Need Additional Assistance

You have updated drivers and updated RealFlight 9.5 and you are still having problems. What
next?

As a first step, we suggest checking our Knowledge Base at
https://www.realflight.com/support/kb/index.php. This is an easy to use, searchable
database of known problems and solutions for various iterations of RealFlight as well as
some of our previously released software such as RealRace. This is the same database that
our Product Support technicians use when helping customers. We constantly update the
knowledge base to address new problems as we discover them. In many cases, you will be
able to find an article that gives clear, concise instructions for resolving your difficulty.

You may also want to check the Knife Edge Message Boards at
www.knifeedge.com/forums/. This is a place where owners of RealFlight and other Knife
Edge products post questions, comments and responses about problems. You may find a
discussion thread about the problem you are experiencing.

You can also contact Technical Support at Horizon Hobby via email at:
rfsupport@horizonhobby.com.
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IMPORTANT. If you do contact Technical Support, you can help us enormously by providing
detailed information about your computer system. Since your problem may only occur on a
particular video or sound card, particular driver version, etc., we may need this information
to help us diagnose your problem. To compile your system information, use the RealFlight
9.5 Launcher. Click the Additional Options button. Next, click the Technical Support button,
followed by the Assemble System Information button. This will create a file called
“c:\launcheroutput.txt”, which contains your system information. Attach this file to an email
and send it to us at rfsupport@horizonhobby.com.

Examples of Common Problems and Solutions

If You Don’t See Your Problem in This Chapter-

This chapter contains a few examples of common difficulties and concerns that RealFlight
users have experienced.

Remember that we can never provide a complete list of difficulties and solutions in a
program manual. That's because RealFlight - and the computers, cards, and drivers it uses -
are constantly evolving. As such, we maintain a detailed Knowledge Base at
https://www.realflight.com/support/kb/index.php. By keeping our Knowledge Base online,
we can provide you with the latest information about resolving any difficulties that might
arise. If you don’t see your difficulty described in this chapter, please check the Knowledge
Base.

In this chapter, we've simply tried to pick a very short list of the most asked about issues.

My computer “freezes” when | run RealFlight-

Sometimes, you may also notice sound skipping or repeating, or a computer reboot while
flying. To resolve this type of problem, you must update the drivers for your video and sound
cards. This is very important. Card manufacturers regularly update their drivers to fix this
type of problem. Even the driver that came with your new computer may not be the most
recent.

Sometimes a card manufacturer will offer a choice between a “recommended” driver, and
n

another driver (often called “special purpose”, “alternate”, or “beta” driver). If RealFlight
“freezes” with the “recommended” driver, try using the alternate driver instead.

If you are sure that you are using the latest drivers, and have followed all the other steps in
the previous section (update RealFlight 9.5, test DirectX) and are still having difficulty with
your computer locking up while running RealFlight, please contact Horizon Hobby's technical
support staff.
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Improving RealFlight 9.5’s Performance-

During installation, RealFlight 9.5 analyzes your computer’s hardware specifications.
RealFlight then tries to optimize its configuration to best take advantage of that hardware,
and achieve the best possible performance.

However, if the performance is less than you desire, you can adjust some of RealFlight 9.5’s
settings to improve the simulation speed and frame rate:

e Ensure that the drivers for the video and sound cards are up-to-date.

e Turn off all other programs, especially virus checkers and network applications (such as
Instant Messengers) while running RealFlight 9.5. Use CTRL-ALT-DELETE and check the
Task Manager to verify that nothing else is running in the background.

e Reduce the texture, water, shadows and other graphics quality in RealFlight. This can
have a profound effect on cards that do not have a high texture memory. See the
Settings section starting on page 85 for more information.

e Eliminate the items shown in the simulation. To do so, access the View menu title then,
access the Scenery menu item. Click an item, type to remove it from the simulation. It
may be necessary to eliminate several items before performance meets your
expectations.

e Reduce the number of open Gadgets and Viewports. Click the ‘X’ on each Gadget or
Viewport that you wish to close.

Other Common Problems-

Here are some other things you may want to watch for:

e Check the DVD for scratches or blemishes. Even minor scratches or fingerprints can cause
random problems that appear to be program bugs. [DVD version only.]

o Verify that all other programs are closed prior to starting RealFlight 9.5. RealFlight works
best when it is the only program running.

o Ifall else fails, try rebooting your computer occasionally, Windows may become unstable
after prolonged and continuous use. A simple reboot may clear up any difficulty.
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Appendix

F

Transmitter Modes

hroughout world, pilots will fly using radios in different Modes. The Mode refers to the

transmitter’s gimbal stick assignments which determine the flight mode of your

controller. There are two main modes of control. Mode 1, mostly used in Europe, and
Mode 2 which is the predominant method of controlling aircraft.

Mode 1-

A controller which is designated as Mode 1 means that it contains the throttle and aileron on
the right stick. The left stick will, therefore, control the elevator and rudder.

LD E) CK GO

L

Elevator Rudder Throttle Aileron
Mode 2-

A controller which is designated as Mode 2 will have the left stick controlling the throttle and
the rudder. Conversely, the right stick will control the elevator and the ailerons.

n @

< B
-

8

L 2

Throttle Rudder Elevator Aileron
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Configure RealFlight-

Once you have made the changes to your InterLink DX controller, you will now need to
make some minor changes in RealFlight to match your controller’s configuration.

First, adjust the channel mapping by editing the InterLink DX Profile. See Select Controller
section on page 56 for more information about his process.

Last, make sure the on-screen Radio Gadget is also switched to Mode 1, found under the
Gadgets menu. See Radio Mode on page 222 for more details.
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Glossary

180-Degree Turn

RCTerm

360-Degree Turn

RCTerm

3D Acceleration

Computer Term

ATV
RCTerm

AccuModel

RealFlight Term

Active View
RealFlight Term

RealFlight 9.5 RC Flight Simulator

This basic flight practice starts with a takeoff, and
then demonstrates 180 degree turns on a flight
path parallel to the runway.

In this practice, you will learn to fly the aircraft in
a complete circle (360-degree turn). This
maneuver is a great way to learn control inputs
for turns while maintaining a consent radius and
altitude.

3D rendering requires a huge number of
calculations. Modern computers offload many of
these calculations to the video card, rather than
performing the calculations directly on your
computer's CPU. This speeds up the simulation
and allows for faster frame rates, thereby
increasing the realism of the simulation.

Amount of servo travel. For instance, 50% ATV
would mean the servo's maximum travel is 50%
of its physical limit.

RealFlight 9.5’s AccuModel aircraft editor offers
the most powerful, most flexible aircraft editor
ever released in an RC simulator.

The active view is the view that is affected by the
commands in the View menu. Only one view at a
time is active. You can make a view active by
clicking on it with the mouse. When you want to
control a view’s properties, you must first make it
the active view.




Advanced Flight Recorder
(AFR)

RealFlight Term

Adverse Yaw
RCTerm

Aileron
RCTerm

Airfoil

RCTerm
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This feature allows the pilot to not only view
prerecorded maneuvers, but also allows them to
record their own. During the playback of
maneuvers, the pilot has the ability to select from
a number of different options such as fast
forwarding, rewinding, looping, speeding up, and
slowing down the recordings. These recordings
may also be sent to others via the Internet. The
pilot can also activate an on-screen transmitter to
watch the stick inputs for each pre-recorded
maneuver.

The tendency of an airplane to yaw in the
opposite direction of the roll. For instance, when
right aileron is applied, the airplane yaws to the
left, thus opposing the turn. Adverse yaw is
common in trainer type airplanes having flat
bottom wings. It is most noticeable at slow
speeds and high angles of attack, such as during
takeoffs and when stretching a landing approach.
Caused by the unequal drag of the upward and
downward deflection of the ailerons, this
undesirable trait can be minimized by setting up
the ailerons with Differential Throw or by
coordinating the turns, using the aileron and
rudder controls simultaneously.

Hinged control surfaces located on the trailing
edge of the wing, one on each side, used to
provide control of the airplane about the roll axis.
The control direction is often confusing to first
time modelers. For a right roll or turn, the right
hand aileron moves upward and the left hand
aileron moves downward. The movements are
reversed for a left roll or turn.

A surface (such as a wing or propeller blade) with
a shape that produces a force perpendicular to its
motion called lift.




Airframe
RealFlight Term

Angle of Attack

RCTerm

Arm
RC Term

AS3X

RCTerm

Auto-Play

Computer Term

Autorotation
RCTerm

Autorotation Event
RealFlight Term
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A term used to describe the general components
of an aircraft when using RealFlight 9.5’s
AccuModel aircraft editor. For example, selecting
the airframe will call up the fuselage, wing(s), and
tail of an airplane.

The angle that the wing penetrates the air. As the
angle of attack increases so does lift and drag, up
to a point.

In this context, the arm is the distance from the
point of the application of a force to the axis of
rotation. If you press down on the tip of a wing,
for example, the arm is the distance from the
point where you are pressing to the root of the
wing.

Exclusive technology available from Horizon
Hobby. Spektrum’s AS3X (Artificial Stabilization-
3 aXis) smooths out the effects of wind and
turbulence. It also includes option-use SAFE
(Sensor Assisted Flight Envelope) Select
technology. For more information, please refer
to the SAFE Select definition.

A Windows feature that automatically detects
when a CD or DVD is inserted and runs the
specified program on that disc.

A maneuver in which the pilot attempts to bring
the helicopter in for a landing without power
from the engine. The momentum of the spinning
rotor blades is enough to slow the helicopter
prior to landing.

An event where players attempt to autorotate
onto a target (similar to Spot Landing). Each
player takes a turn. Players collect different point
amounts based on landing location. The
Autorotation Event works for helicopters only.
The Deadstick Event is for airplanes.




Avalanche
RCTerm

Bloom Effect
RealFlight Term

Camera Lag
RealFlight Term

Channel Mapping

RealFlight Term

Chat

RealFlight Term

Child/Children Item(s)

RealFlight Term

Chord

RCTerm
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The Avalanche is a loop with a snap roll at the top
of the loop. This snap roll must be centered at
the top of the loop.

The effect creates a feathering of light around
brighter objects, giving it a more realistic look.
This is more noticeable at brightly lit airports
around aircraft that are lighter in color.

This parameter determines how quickly or slowly
the camera (your view of the aircraft on the
screen) reacts to the aircraft’s movements.

This term describes the ability of RealFlight 9.5 to
alter the mapping or input of the servos to
accurately reflect the actual controls from an RC
controller.

This is a real-time communication between two
or more RealFlight 9.5 users which is conducted
via the PC. RealFlight 9.5’s multiplayer feature
enables a public chat if so desired.

In many of RealFlight 9.5’s selection windows,
items are displayed in a hierarchy format. An
item that belongs to a higher group, or parent, is
considered the child item.

The chord of a wing or surface is the width of the
surface. A wider chord offers increased lift.
However, a wider chord also generates more
drag when the aircraft rolls.
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CG is the abbreviation for the phrase Center Of
Gravity. This is the point at which the aircraft
balances fore to aft and side-to-side. The location
of this point is crucial to how the aircraft reacts in
the air. For airplanes, a tail-heavy plane will be
very snappy, but generally unstable and
susceptible to frequent stalls. Conversely, a nose-
heavy plane will tend to track better and be less
sensitive to control inputs, but will generally drop
its nose when the throttle is reduced to idle. This
makes the plane more difficult to land, since it
takes more effort to hold the nose up. A nose
heavy airplane will have to come in faster to land
safely.

A mechanism on a helicopter that changes the
pitch of the main blades, thereby allowing the
helicopter to ascend or descend accordingly. This
is the control that adjusts the pitch of the rotor
blades.

RealFlight 9.5 sports the most advanced collision
detection modeling ever used in an RC model
simulation. It blankets the entire aircraft,
ensuring accurate modeling of the aircraft when
it collides with objects and items within the
simulation.

When a helicopter hovers, the blades form a
slight "cone" when viewed from the side. The
Coning effect is caused by the balance between
lift and centrifugal forces on the blades.

The Console (found by pressing the ~ key on the
keyboard) allows for command line functions
used by advanced users. For example, type in
fruitcups and then press the Enter key.
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Generally defined as the portion of the airfoil that
moves. Examples include ailerons, elevators,
rudders, flaps, and spoilers.

A device used to control an aircraft in RealFlight.
RealFlight 9.5 oftentimes ships with the USB
Spektrum InterLink DX controller developed by
Horizon Hobby and Knife Edge Software. This
device can be used as a standalone controller, or
as an interface to use your own RC transmitter.

Model enters in level flight, pulls to complete
5/8s of a loop to the 45 degree down line,
completes % roll, pulls to complete 5/8s of a loop
to the 45 degree down line, complete % roll to
complete 3/8s of a loop to level flight.

For helicopters, this refers to the tilting forward
and back (pitch), or tilting sideways (roll) of the
helicopter. To do this, the angle of attack of the
main rotor blades is changed during rotation,
creating different amounts of lift at different
points in the cycle.

A term used to describe unpowered flight (glide)
when the engine ceases operation.

The depth of field (DOF) is the portion of the
screen that appears sharp, while all other objects
appear out of focus. In RealFlight, depth of field
can add more depth perception to your
computer monitor, which is flat.
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The V-shaped bend in a wing. Increasing the
dihedral usually enhances the aerodynamic
stability of an airplane, and helps the rudder to
control both the roll and yaw axis. This is why
some trainers and sailplanes require only three
channels of radio control (i.e., they have no
ailerons).

This is a method for using your own radio to
completely control the aircraft. This usually
means you have a separate radio program on
your radio for each aircraft that you want to fly in
RealFlight 9.5 with this method. All mixing and
radio functions are performed on your radio and
RealFlight simply passes the values directly to the
aircraft servos. This is in contrast to the Joystick
Emulation Interface.

A Microsoft DirectX technology used to render
the 3D image when you have a graphics
accelerator card. It works best on faster
computers.

A technology created by Microsoft that controls
graphics and sound operations.

A method of removing and/or simulating colors
that may not be available to the graphics
processing unit.

This is the downward angle of the engine in
relationship to the centerline of the airplane.
Down Thrust helps overcome the normal
climbing tendency of flat bottom wings.
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A software program that controls a card (e.g.,
video or sound card) in your computer. Card
manufacturers usually provide drivers as well.
Card manufacturers frequently update their
drivers to fix bugs or to make their cards
compatible with new software and hardware.
You can often find an updated driver for your
video or sound card by visiting the card
manufacturers web site and following links to
“Drivers,” “Support,” “Downloads”, or
“Upgrades.”

A NavGuide is a gadget that displays continuously
updated information about your aircraft. The Edit
NavGuides dialog is used to customize the
NavGuides gadgets.

The Elevator is a maneuver in which the aircraft is
made to stall completely with a large amount of
elevator throw. The aircraft will descend almost
vertically much like an elevator. To perform the
Elevator, make sure that you have sufficient
altitude, dive the aircraft vertically toward the
ground and pull full up on the elevator stick.

Hinged control surface located at the trailing
edge of the horizontal stabilizer, which provides
control of the airplane about the pitch axis and
causes the airplane to climb or dive. The correct
direction of control is to pull the transmitter
Elevator control stick back, toward the bottom of
the transmitter, to move the Elevator upward,
which causes the airplane to climb. Move the
Elevator in the other direction to dive.

This radio feature adjusts the length of servo
travel in one direction (a single channel will have
adjustments for two endpoints). For example, if
your aircraft rolls faster one way than the other,
endpoint adjustments can correct the problem.
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A feature commonly found on computer radios
that desensitizes the servo when the sticks are
close to the neutral position. The further the
stick’s position from center, the faster the control
response.

This is an excellent maneuver to learn
perspective and orientation of the aircraft from
all angles. Use the ailerons and elevator to turn
the aircraft left and right. Use the elevator to
ensure that the aircraft maintains a constant
altitude, forming an ‘8’ in the sky.

For Airplanes: hinged control surface located at
the trailing edge of the wing inboard of the
ailerons. The Flaps are lowered to produce more
aerodynamic lift from the wing, allowing a slower
takeoff and landing speed. Flaps are often found
on scale models, but usually not on basic trainers.

For Helicopters: Flapping is an up-and-down
motion of the main rotor blade's tip. With a
"dual-damped" head, both blades are able to
Flap independently. With "solid axle" heads,
moving one blade up causes the other to move
down.

This describes a type of rotor head in which the
two blades are not connected directly. Each
blade is independent of the other, usually
resulting in a helicopter with smoother
performance.

The point during the landing approach in which
the pilot increases the amount of up elevator to
smooth the touchdown of the airplane.
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FlexiField is the most advanced flying site editor
ever unveiled. It presents the modeler with the
ability to adjust the flying site in virtually any
manner desired. The user can add trees, selecting
the type, size, and color; add, move, size, and
orient buildings, walls and other scenery objects;
position and orient the runway; even choose the
amount and type of lighting at the flying site.

RealFlight 9.5 authentically recreates common
difficulties that may be experienced at your local
flying site. Practicing with flight failures enabled,
is a good way to practice for emergencies.

A gadget that lets you control playback of flight
recordings using mouse actions.

The ability to takeoff and land a radio controlled
aircraft from water.

These are the short blades on the end of the
flybar. Available in a variety of weights and
airfoils, these paddles assist the main blades in
producing lift, etc.

As the name suggests, a flybarless aircraft is a
helicopter that does not incorporate a flybar in
the rotorhead design. Rather the helicopter uses
an electronic stabilization device that
electronically replaces the flybar.

These maneuvers are very similar to a slow roll
with the exception of a hesitation at either % of
the roll or at 1/8 of the roll. It is important to
remember to use rudder and elevator to keep
the aircraft flying in a straight line.
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Frame Rate is the number of times per second
that RealFlight creates a different picture to
display on your monitor. Frame rate is
determined by the speed of your CPU and
graphics card, and how many RealFlight options
you turn on. This is not the same as refresh rate,
which is the number of times per second that
your monitor retraces an image on its screen.

Generally speaking, this is the main part of the
airplane that holds the wings and engine. The
fuselage is often thought of as the “body” of the
airplane. This term is also used to referto a
“body” that might be used on helicopters.

An on-screen display that shows you
continuously updated information about your
aircraft, or lets you control RealFlight features
using mouse clicks.

This term describes the overall wind conditions in
the simulation.

Entering at level flight, pull 45 degrees up;
perform % roll centered on the line. Then
perform a % loop back to a 45 degree up line.
Finish with another % roll centered on the up
line.

A device used to help maintain a constant RPM
(head speed), generally used in helicopters rather
than airplanes.

A collection of scenery objects or foliage objects
in your airport. Every object in the airfield must
belong to one Group. You can place all of your
airport's scenery objects in a single Group, or
create multiple Groups to place objects in
categories with related objects. For example, you
could have a Group for Trees and another group
for Buildings within a particular airport.
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A device, most commonly used in helicopters,
that aids in controlling the yawing action of the
helicopter by automatically adjusting the
deflection of the tail rotor blades.

A hardware-accelerated 3D video card driver.
“HAL” is an abbreviation for the phrase
“Hardware Abstraction Layer” that uses software
drivers to communicate between RealFlight’s
software and the hardware of the PC.

A Harrier is a slow forward progression of the
aircraft with the nose held high. Use the elevator
to stall the forward progress of the aircraft. Add
in more up elevator until the nose approaches 45
degrees. The throttle should be used to control
the forward progress of the aircraft, without
climbing.

In RealFlight 9.5, every multiplayer session
requires one player to serve as Host. The Host
starts the session, and then the other players
join. Other players can leave the session
whenever they want, but only the Host can
terminate the entire session.

The centralized mechanical device used to attach
the main rotor blades and paddles.

This aerobatic maneuver consists of two vertical
lines connected by a half circle flown across the
top.
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Whenever your computer is connected to the
internet, it has an IP address. This number is a
string of digits and periods, and looks something
like “123.45.6.78”. The IP address is like an
internet “zip code” that tells other computers
where to look for your computer. Depending on
your internet connection, your IP address may
always be the same, or may change each time
you connect to the internet.

The aircraft will enter a half loop from straight
and level flight followed immediately by a half
roll to straight and level flight.

With RealFlight 9.5 set to Interface Mode, you
are using the InterLink DX Controller as an
interface to your own RC radio. In Interface
Mode, your own radio controls RealFlight 9.5.
Conversely, in Joystick Mode the InterLink-X
Controller (used as a mockup of an RC
transmitter) controls the RealFlight 9.5 aircraft.

Horizon Hobby’s USB InterLink DX Controller is a
USB device commonly shipped with RealFlight
9.5 and available separately from Spektrum
(SPMRFTX1). The InterLink DX Controller can be
used as a standalone “mockup” RC controller or
as an interface for connecting your own RC
transmitter to control the action in RealFlight!

A device that connects to your computer to
provide control input for the simulated aircraft.
The InterLink DX controller that comes with
RealFlight 9.5 is considered a Joystick.
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A term used to describe using your own radio to
emulate the Interlink Joystick. This allows you to
use your own radio to fly any of the stock aircraft
in RealFlight 9.5. Actual radio functions such as
mixing and ATVs are performed in the RealFlight
software, not on your radio. This is in contrast to
the Direct Control Interface.

With RealFlight 9.5 set to this mode, RealFlight
9.5 is controlled by the InterLink DX controller
used as a mockup of an RC transmitter.

This maneuver requires the pilot to roll the
aircraft 90 degrees so that the wings are
perpendicular to the ground, with one wing
down and the other up then, holding this position
while maintaining the same altitude above
ground.

Local Area Network. This is usually a network
where the computers are connected with high
speed network cards.

The right-to-left or side-to-side balance of an
airplane.

The RealFlight 9.5 Launcher is useful for many
aspects of the RealFlight 9.5 program, including
loading the simulator, compiling system
information for technical support, or uninstalling
RealFlight.

[*DVD and Tower Hobbies Digital versions only.]

A helicopter term describing the hinge point
where the blade attaches to the hub. This allows
the blade to move forward and backward at
certain times during the blades rotation.

The very front edge of the wing or stabilizer. This
is the edge that hits the air first.
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An event (flying competition) in which pilots take
turns flying their aircraft under a Limbo bar. The
pilot that clears the lowest bar height wins.

RealFlight’s Multiplayer function lets you publicly
“post” your session, so that a RealFlight user,
anywhere in the world, can find out about your
session and join you (assuming you have not
reached the enrollment limit of your session).
The place where you post your session is called a
List Server. Use of the List Server is optional.

Rechargeable batteries frequently used in RC for
powering an aircraft’s electric motor. A lithium
polymer battery offers lower weight and
improved run times when compared to other
rechargeable batteries.

A switch on the radio that reduces the servo
movement to much smaller extremes, thus
making the model respond more slowly to a
given control input.

Milliamp Hour — The measurement of a battery’s
total capacity.

Two or more output channels can be coupled
together to move in a desired manner when
controlling input channels are activated.

Also known as Flight Mode or Stick Mode, this
refers to the transmitter's gimbal stick
assignments (locations) which determine the
flight mode of your controller. There are two
main modes of control, Mode 1- mostly used in
Europe and Mode 2 which is the predominant
method of controlling aircraft commonly used in
the United States.
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MRU refers to the list of documents which were
last accessed. For RealFlight, MRU’s appear for
airports, aircraft and recordings.

A RealFlight feature that uses RakNet™
technology to connect with other RealFlight users
over a network.

A network connection between RealFlight users,
which allows each user to fly in the same "virtual
world," and allows all participants to see and
interact with each other's aircraft.

A gadget that displays continuously updated
information about your aircraft and the virtual
world.

In 3D computer graphics, normal mapping is used
to add details to shading without using more
polygons.

In many of RealFlight 9.5’s selection windows,
items are displayed in a hierarchy format. An
item that has an additional item within it is
considered the parent item.

A technology that creates a flying field by using a
panoramic photograph as a background for a flat
terrain.

Contains miscellaneous information about the
modeler such as name, location, hours logged,
etc. Itis a great methodology to identify yourself
to others in multiplayer sessions.

The yawing action of a helicopter that looks much
like an ice skater spinningin a circle. One
Pirouette is equal to one 360-degree rotation.
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The airplane axis is controlled by the elevator.
Pitch is illustrated by holding the airplane at each
wingtip. Raising or lowering the nose is the pitch
movement. This is how the climb or dive is
controlled.

When you measure your aircraft for RealFlight,
some measurements require that you have a
reference line running straight up and down. To
make such a line, we tie a weight to the free end
of a string, and let the weight dangle. Because
the string is then “plumb” (oriented straight up
and down), it is called a Plumb String. A Plumb
String is particularly useful in measuring an
aircraft’s center of gravity.

These maneuvers are very similar to a roll with
the exception of a hesitation at either 1/4 or 1/8
of the roll.

A multiplayer session that is password protected
by the Host. The Host must communicate the
session password to each player who wishes to
join the private session.

Props are generally designated by two numbers
(forinstance, “10 x 6”). The first number is the
length (10" in the example) of the prop. The
second number is the pitch or angle of the
blades. In this example, the “6” represents the
distance the propeller will move forward in one
revolution in ideal situations.

A multiplayer session that is published on a List
Server and is not password protected.

The Quick Edit gadget offers the ability to quickly
modify basic parameters of an aircraft without
opening the Aircraft Editor.
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The Quick Load gadget allows you to quickly
search and load a new aircraft or flying site
through a simple search.

RealFlight 9.5 InterLink DX allows you to make
changes to the simulator with the controller
using the buttons at the bottom. Manipulating
these buttons through the on-screen QuickSelect
tabs offer the ability to change aircraft, flying
sites, and more.

Random Access Memory.

This is the name given to RealFlight 9.5’s rotating
preview box. This allows a rapid view of the
aircraft from all angles.

This is RealFlight’s exclusive physics modeling
technology. RealPhysics 3D authentically
replicates the actual physics of model aircraft by
performing hundreds of thousands of floating
point calculations each second while delivering
sizzling real time performance.

This is a term used to globally describe the
cutting edge three dimensional graphics,
authenticity, and realism of the simulator world
in which you are being immersed during flight.

The number of times per second that your
monitor retraces an image on its screen. This is
different from the Frame Rate.

When used in the context of screen Resolution,
this term describes the picture quality of the
screen. Lower Resolutions will produce an image
that is not as sharp as higher Resolutions.
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By pressing and holding the Reset button on the
InterLink DX controller, you have the ability to
rewind your flight to any point you wish and
continue on from there.

The airplane axis controlled by the ailerons. Roll is
illustrated by holding the airplane by the nose
and tail. Dropping either wingtip is the roll
movement. Roll is used to bank or turn the
airplane. In most airplanes, the ailerons control
roll however, when the main wing has dihedral,
the plane can be banked using the rudder only.
Consequently, many planes with wing dihedral
do not have ailerons, and the rudder controls
both roll and yaw. This is one reason most trainer
aircraft have a large amount of dihedral -- a plane
with large dihedral can be controlled using fewer
input channels.

This phrase describes how rapidly the volume of
a sound increases or decreases as the source
draws closer or moves farther away.

In many of RealFlight 9.5’s selection windows,
items are displayed in a hierarchy format. The
upper most item in this hierarchy is considered
the Root item.

Hinged control surface located at the trailing
edge of the vertical stabilizer, which provides
control of the airplane about the Yaw axis
(causing the airplane to Yaw left or right). Left
Rudder movement causes the airplane to Yaw
left, and right Rudder movement causes it to Yaw
right.
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SAFE technology is an advanced technology
designed and refined by Horizon Hobby to assist
modelers in their enjoyment of the hobby. SAFE
offers three modes to assist in the advancement
of flying skills:

Beginner Mode

Pitch and bank angle limits prevent over-
control that can result in a loss of orientation
and crashes. When the control sticks are
released the airplane returns to level flight on
its own. Best of all takeoffs are as simple as
giving full throttle and letting the airplane fly
off a smooth surface or by giving it a quick
hand launch, and landings are as easy as
lowering the throttle and letting it glide to a
landing on its own.

Intermediate Mode

More freedom in pitch and bank, but still
prevents over-control and does not return to
level flight on its own. This mode allows you to
make tighter turns in smaller areas and to
climb and descend faster as your skills
advance.

Experienced Mode

No pitch or bank angle limits so you have
complete control! You can even fly
inverted/upside down and perform aerobatic
maneuvers including loops, rolls, stall turns
and more.
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SAFE Select, another Horizon Hobby exclusive
technology, offers:

Pitch and Bank Angle Limits

These envelope limits keep the airplane from
rolling or pitching upside down. They also
prevent excessive climb or dive angles.

Automatic Self-Leveling

The airplane instantly returns to and holds
level flight when the sticks are released and in
the center position. It’s also helpful for keeping
the wings level during takeoffs and landings.

An electromechanical device that moves the
control surfaces or throttle of an airplane
according to commands from a receiver. This
device does the physical work of moving parts
around inside the aircraft.

See "Multiplayer Session."

RealFlight 9.5 authentically recreates common
difficulties that may be experienced at your local
flying site. Setup failures are problems where, in
ideal situations, should be detected before the
aircraft ever leaves the ground.

A grid work of lines that appear in the sky when
activated. Modelers practicing precision
aerobatic maneuvers will appreciate these lines
as they perfect their routines.

This term describes RealFlight 9.5's ability to
accurately mimic a computer transmitter
(complete with mixing, etc.) in the simulation.
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A card inside your computer that controls audio
(what you hear over your computer speakers).
Most sound cards plug into your computer’s
motherboard. You can upgrade your sound card
(or the software driver that controls it) without
getting a new computer.

A graphics rendering technique that makes
surfaces (e.g., MonoKote™) appear reflective, or
“shiny” in direct light (e.g., sunlight).

The Split S is another step in learning to combine
loops and rolls and is a great maneuver to
decrease your altitude. A half roll precedes a half
loop, making the maneuver a mirror image of the
Immelman. The Split S provides course reversal
and an easy increase in speed.

When an airplane’s angle of attack is too great to
generate lift (regardless of airspeed), the plane
will dive and rapidly lose altitude. This is known
as a stall. Every airfoil has an angle of attack at
which it generates maximum lift. The airfoil will
stall beyond this angle.

The mechanism in a helicopter rotor that turns
non-rotating control movements into rotating
control movements.

This phrase describes the wind flow and effects
for the thermals in RealFlight 9.5.

This is used to keep the throttle at a set position,
yet allows input to the collective of the
helicopter. Generally, this function is used to
practice autorotation.

Commonly used to describe the degree of
deflection of a control surface.
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This is when the airplane reaches its stall speed
and one wing drops.

The Torque Roll occurs when the nose of the
airplane is pointed vertically and the airplane
hovers in place. The aircraft will rotate left
around its roll axis.

Landing and taking off without a pause, often
confused with a good bounce.

The rearmost edge of the wing or stabilizer.

A model designed to be inherently stable and fly
at low speeds, to give first-time modelers time to
think and react as they learn to fly.

RealFlight 9.5 offers a variety of features to learn
new maneuvers. These consist of training aids
that take you through step-by-step basic flight
lessons, such as takeoffs and landings for
airplanes, and Hovering practice for helicopters.
Prerecorded lessons are also available from
professional pilots.

RealFlight 9.5’s TruFlo Wind Dynamics is the most
accurate wind model ever released in an RC
simulator. It combines five different wind models
to recreate the ever-changing wind fields found
at a real flying site.

This is the ability of RealFlight to induce
turbulent, rough air, as would be experienced at
the flying site.
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USB, or Universal Serial Bus, is a connection
protocol for computer peripheral devices (like
Great Planes’ USB InterLink-X Controller). USB
technology allows you to connect multiple
devices to your computer, and supports high data
transfer rates and is hot swappable. USB devices
have a special connector that only fits into a USB
port. Most modern personal computers have
USB ports, which are usually clearly labeled.
Some computers have one or more USB ports on
the front of the computer housing, although the
USB ports are usually on the back of the
computer.

An instrument designed to indicate the rate of
climb or descent of an aircraft.

A card inside your computer that produces the
images on your video monitor. Most modern 3D
video cards have accelerated 3D operations—
that is, they perform numerical calculations for
rendering a 3D scene, to free up your computer’s
CPU to perform other tasks. The video card plugs
into your computer’s motherboard. You can
upgrade your video card (or the software driver
that controls it) without replacing your computer.

A picture-in-picture display set within the
RealFlight 9.5 main display. The Viewport is
independently adjustable and serves as its own
unique “window on the world”.

An intentional twist in the wing, which causes the
wing tips to have a lower angle of attack than the
wing root. In other words, the trailing edge is
higher than the leading edge at the wing tips.
Washout helps to prevent tip stalls.
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The Waterfall is a maneuver where the plane
pivots 360 degrees in the pitch axis with as little
forward motion and altitude deviation as
possible. As the name suggests, this maneuver
resembles a waterfall during flight.

The amount of weight per square foot that has to
be overcome to provide lift. It is normally
expressed in ounces per square foot. This
specification can be easily calculated as follows:
first determine the area of the wing in square
inches then, simply divide by 144 to obtain
square feet. Divide the total weight (in ounces) of
the airplane by the wing area (in square feet).

This information is valuable when deciding on
which airplane to build next. Planes with high
wing loading must fly faster to stay in the air.
These are generally "performance" airplanes.
Conversely, a plane with lower wing loading does
not need as much air flowing around the wing to
keep it flying. Gliders and trainer airplanes fall
into this category because in this case, slow,
efficient flight is highly desirable.

The airplane axis controlled by the rudder. Yaw is
illustrated by hanging the airplane level by a wire
located at the center of gravity. Left or right
movement of the nose is the Yaw movement.




Index

About, 328

AccuModel, 8, 368

Advanced Flight Recorder, 9, 369

Aerobatics, 346

AFR. See Advanced Flight Recorder

Aircraft Editor, 41, 134
Add Component, 147
Aircraft Parts Tree, 144
Delete Component, 147
Parameter Window, 147
Preview Screen, 146
Show Wireframe, 142, 144

Aircraft Menu, 130

Aircraft MRU, 32, 158

Aircraft Selection, 30, 131, 132
Description, 132
Specifications, 132

Aircraft Variant, 81

Airframe, 370

Airplane Basics, 343

Airplane Flight, 345

Airplane Hover Trainer, 294

Airplane Physics. See Physics

Airport, 230

Airport Editing, 40

Airport MRU, 34, 189

Airport Selection, 33, 160

Airspeed, 206

RealFlight 9.5 RC Flight Simulator

Altitude, 207, 219
Audio, 87
Auto-Play, 370
Autorotation, 370
Autozoom, 308
Battery, 220
Binocular, 205, 209
Bloom, 106, 371
Boundary, 283, 296
Camera, 90
Camera Position, 306
Camera Type, 304
Capture Screenshot, 127
Channel Mapping, 371
Chase View, 305
Chat, 100, 263, 371
Child, 145, 166, 371
Clear Aircraft Position, 155
Clouds, 104
Cockpit View, 304
Collective, 348
Color Scheme, 80, 133
ColorSchemes, 152
Alpha Channels, 153
PowerReflectiveOff, 152
PowerReflectiveOn, 152
PowerSpecularOff, 152

PowerSpecularOn, 152




Reflectivity, 152

Specular, 152
Commands, 102, 103
Console, 92
Controller Menu, 190
Crashing, 333, 344
Cyclic Stick, 349
Deadstick, 373
DirectX, 374
Disconnect, 236
Display Properties, 355
Drivers, 17, 362, 375
Edit Airport, 162
Effects, 302
End Game List, 241
Errors, 99
Export, 80, 83, 84
Filter Servers, 232
Fixed Position, 304
FlexiField, 9, 40, 377
Flight Failures, 10, 67, 377
Float Fly, 7
Fly Camera, 167
Folder Listing Window, 172, 173
Foliage Density, 107
Forward Flight, 350
G Force, 220
G3X. See RealFlight Archive
Gadgets, 38, 269, 378
Gadgets Menu, 204
Game, 230

Game Gadgets, 251

RealFlight 9.5 RC Flight Simulator

Game Help, 250

Global Wind, 378
Graphics, 104, 207
Graphics Frame Rate, 221
Great Planes, 326

Ground Speed, 220
Grouping, 132, 161, 170, 378
Gyro, 350

Head Tracking, 312
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License

REGISTERED VERSION: RealFlight® RC Simulator
LIMITED USE SOFTWARE LICENSE AGREEMENT

This Limited Use Software License Agreement (the "Agreement") is a legal agreement
between you, the end-user, and Knife Edge Software ("KES"). By continuing the installation of
this game program, by loading or running the game, or by placing or copying the game
program onto your computer hard drive, you are agreeing to be bound by the terms of this
Agreement. If you do not agree to the terms of this Agreement, promptly return the game
program and the accompanying items (including all written materials), along with your
receipt to the place from where you obtained them for a full refund.

KES SOFTWARE LICENSE

1. Grant of License. KES grants to you the limited right to use one (1) copy of the enclosed
or foregoing game program (the "Software") on a single computer. You have no ownership
or proprietary rights in or to the Software or the written materials accompanying the
Software. For purposes of this section, "use" means loading the Software into RAM, as well
as installation on a hard disk or other storage device. The Software shall be either returned
to KES or destroyed when no longer used in accordance with this Agreement, or when the
right to use the Software is terminated. You agree that the Software will not be shipped,
transferred or exported into any country in violation of the U.S. Export Administration Act (or
any other law governing such matters) and that you will not utilize, in any other manner, the
Software in violation of any applicable law.

2. Commercial Use is Prohibited. Except as provided in paragraph 5. Herein below in
regard to the Software, under no circumstances shall you, the end-user, be permitted,
allowed or authorized to commercially exploit the Software, any data comprising the
Software. Neither you nor anyone at your direction shall do any of the following acts (any
such acts shall be deemed void and a breach of this Agreement) with regard to the Software,
or any portion thereof, such as a screen display or a screenshot:

a. Rent the Software;
b. Sell the Software;

c. Lease or lend the Software;
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d. Offer the Software on a pay-per-play basis;

e. Distribute, by electronic means or otherwise, the Software for money or any other
consideration; or

f. In any other manner and through any medium whatsoever commercially exploit the
Software or use the Software for any commercial purpose.

3. Additional Prohibited Uses. Neither you nor anyone at your direction shall take the
following action in regard to the Software, or any portion thereof, such as a screen display or
a screenshot:

a. Modify, disassemble, reverse engineer or decompile Software;

b. Translate the Software;

c. Reproduce the Software;

d. Publicly display the Software;

e. Prepare derivative works based upon the Software except Permitted Derivative Works); or
f. Distribute, by electronic means or otherwise, the Software.

4. Use of Other Material is Prohibited. Use, in any manner, of the trademarks, such as
RealFlight RC Simulator (tm) logo, or symbols, art work, images, screen displays or
screenshots, sound effects, music, and other such material contained within, generated by or
relating to the Software is prohibited.

5. To Receive Permission to Commercially Exploit. If you desire to commercially exploit
the Software, you may request a copy of and execute the Commercial Exploitation License
Agreement for RealFlight RC Simulator (the "License") and forward the original License to KES
Software at the address noted therein. Please note that KES may refuse your request and not
sign the License in KES's sole discretion.

6. Restrictions Apply to Third Parties. The prohibitions and restrictions described herein
apply to anyone in possession of the Software and/or Permitted Derivative Works.

7. Copyright. The Software and all copyrights related thereto (including all characters and
other images generated by the Software or depicted in the Software) is owned by KES and is
protected by United States copyright laws and international treaty provisions. You must treat
the Software like any other copyrighted material. You may not otherwise reproduce, copy or
disclose to others, in whole or in any part, the Software. You may not copy the written
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materials accompanying the Software. The same restrictions and prohibitions regarding your
use of the Software as provided in this Agreement apply to your use of the written materials
accompanying the Software. The written materials are owned by KES and are protected by
United States copyright laws and international treaties. You agree to use your best efforts to
see that any user of the Software licensed hereunder complies with this Agreement.

8. Limited Warranty. KES warrants that if properly installed and operated on a computer
for which it is designed, the Software will perform substantially in accordance with the
accompanying written materials for a period of ninety (90) days from the date of purchase of
the Software. KES's entire liability and your exclusive remedy shall be, at KES's option, either
(a) return of the price paid or (b) repair or replacement of the Software that does not meet
KES's Limited Warranty. To make a warranty claim, return the Software to Horizon Hobby,
LLC, 2904 Research Road, Champaign, IL 61822 USA accompanied by proof of purchase, your
name, your address, and a statement of defect. This Limited Warranty is void if failure of the
Software has resulted in whole or in part from accident, abuse, misapplication or violation of
this Agreement. Any replacement Software will be warranted for the remainder of the
original warranty period or thirty (30) days from your receipt of the replacement software,
whichever is longer. This warranty allocates risks of product failure between Licensee and
KES. KES's product pricing reflects this allocation of risk and the limitations of liability
contained in this warranty.

9. NO OTHER WARRANTIES. KES DISCLAIMS ALL OTHER WARRANTIES, BOTH EXPRESS
IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE AND THE
ACCOMPANYING WRITTEN MATERIALS. THIS LIMITED WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO
JURISDICTION. KES DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED, ERROR FREE OR MEET LICENSEE'S SPECIFIC REQUIREMENTS. THE
WARRANTY SET FORTH ABOVE IS IN LIEU OF ALL OTHER EXPRESS WARRANTIES WHETHER
ORAL OR WRITTEN. THE AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF KES ARE
NOT AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR ADDITIONAL
WARRANTIES ON BEHALF OF KES. ADDITIONAL STATEMENTS SUCH AS DEALER ADVERTISING
OR PRESENTATIONS, WHETHER ORAL OR WRITTEN, DO NOT CONSTITUTE WARRANTIES BY
KES AND SHOULD NOT BE RELIED UPON.

10. Exclusive Remedies. You agree that your exclusive remedy against KES, its affiliates,
contractors, suppliers, and agents for loss or damage caused by any defect or failure in the
Software regardless of the form of action, whether in contract, tort, including negligence,
strict liability or otherwise, shall be the return of the purchase price paid or replacement of
the Software. This Agreement shall be construed in accordance with and governed by the
laws of the State of Oregon. Copyright and other proprietary matters will be governed by
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United States laws and international treaties. IN ANY CASE, KES SHALL NOT BE LIABLE FOR
LOSS OF DATA, LOSS OF PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL,
INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM BREACH OF WARRANTY, BREACH
OF CONTRACT, NEGLIGENCE, OR OTHER LEGAL THEORY EVEN IF KES OR ITS AGENT HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER
PARTY. Some jurisdictions do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.

11. General Provisions. Neither this Agreement nor any part or portion hereof shall be
assigned, sublicensed or otherwise transferred by you. Should any provision of this
Agreement be held to be void, invalid, unenforceable or illegal by a court, the validity and
enforceability of the other provisions shall not be affected thereby. If any provision is
determined to be unenforceable, you agree to a modification of such provision to provide for
enforcement of the provision's intent, to the extent permitted by applicable law. Failure of a
party to enforce any provision of this Agreement shall not constitute or be construed as a
waiver of such provision or of the right to enforce such provision. If you fail to comply with
any terms of this Agreement, YOUR LICENSE IS AUTOMATICALLY TERMINATED.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND
THIS AGREEMENT, AND UNDERSTAND THAT BY CONTINUING THE INSTALLATION OF THE
SOFTWARE, BY LOADING OR RUNNING THE SOFTWARE, OR BY PLACING OR COPYING THE
SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS
AGREEMENT'S TERMS AND CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN
SEPARATE AGREEMENTS BETWEEN KES AND YOU, THIS AGREEMENT IS A COMPLETE AND
EXCLUSIVE STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES. THIS AGREEMENT
SUPERSEDES ALL PRIOR ORAL AGREEMENTS, PROPOSALS OR UNDERSTANDINGS, AND ANY
OTHER COMMUNICATIONS BETWEEN KES AND YOU RELATING TO THE SUBJECT MATTER OF
THIS AGREEMENT.
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